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About This Manual

1 ABOUT THIS MANUAL

1.1 Related Documentation

Indexer 2 Program User Guide
ASCII Interface Programmer’s Guide
Camming User Guide

Parameter Dictionary

Serial Encoder Guide

Copley Controls software and related information can be found at:
www.copleycontrols.com.

1.2 Copyrights

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Copley Controls.

CME, Copley Virtual Machine, CVM, Xenus, Accelnet, Stepnet, Accelus, and Junus are registered
trademarks of Copley Controls.

Windows 7, Windows 8, and Windows 10 are registered trademarks of the Microsoft Corporation.

1.3 Document Validity

We reserve the right to modify our products. The information in this document is subject to
change without notice and does not represent a commitment by Copley Controls. Copley Controls
assumes no responsibility for any errors that may appear in this document.

1.4 Product Warnings

Observe all relevant state, regional and local safety regulations when installing and using Copley
Controls amplifiers. For safety and to assure compliance with documented system data, only
Copley Controls should perform repairs to amplifiers.

Hazardous voltages.
Exercise caution when installing and adjusting Copley amplifiers.

Risk of electric shock.
DANGER

On some Copley Controls amplifiers, high-voltage circuits are
connected to mains power. Refer to hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-
enables the PWM output stage without operator intervention. In this
case, motion may re-start unexpectedly. Configure faults as latched
unless a specific situation calls for non-latched behavior. When using
non-latched faults, be sure to safeguard against unexpected motion.
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Latching an output does not eliminate the risk of unexpected
motion with non-latched faulits.

Associating a fault with a latched, custom-configured output does
not latch the fault itself. After the cause of a non-latched fault is
corrected, the amplifier re-enables without operator intervention. In
this case, motion may re-start unexpectedly.

For more information, See Error! Reference source not found..

When operating the amplifier as a CAN or EtherCAT node, the use of
CME or ASCII serial commands may affect operations in progress.
Using such commands to initiate motion may cause network
operations to suspend.

Operation may restart unexpectedly when the commanded motion is
stopped.

Use equipment as described.

Operate amplifiers within the specifications provided in the relevant
hardware manual or data sheet.

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT
DAMAGE, INJURY, OR DEATH.

1.5 Revision History

Revision | Date Applies to Comments
00 January 2014 | CME 2 Software version | Changes include updated screen
7.0 shots, information updates, and filter
data.
01 March 2019 CME Software version 8.0 | Incorporated new screenshots, added
Frequency Analysis section
02 April 2019 CME Software version 8.0 | Fixed minor issues
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Introduction

2 INTRODUCTION
2.1 Host Computer Requirements

2.1.1 Computer and Operating System
Minimal hardware requirements:
e CPU: 1GHz
e RAM: 1GB
Operating Systems Supported: Windows 7, Windows 8 and Windows 10.

2.1.2 Default File Locations

The default location for CME data files (ccx, ccm, etc.) is determined by the Operating System.
Windows 7, Windows 8 and Windows 10

C:\Users\Public\Public Documents\Copley Motion\CME2

2.1.3 Serial Communications
e Standard RS-232 serial port or a USB-to-RS-232 adapter.
e Serial communication cable. See data sheet for part numbers.

2.1.4 CAN Communications (With Copley CANopen Drives)
e CAN card. The following CAN card manufacturers are supported:
e Copley Controls CAN PCI card (CAN-PCI-02, CAN-PCIe-01, CAN-PCIe-02, CAN-USB-01,
CAN-PC104-02)
e Kvaser
e CANopen network cable (see data sheet for part number and wiring instructions).

2.1.5 EtherCAT Communications (With Copley EtherCAT Drives)
e Ethernet adapter dedicated to the EtherCAT network.
e EtherCAT network cable, (see data sheet for wiring instructions).

2.2 Overview

2.2.1 Setup and Tuning

Java based CME configuration software is powerful and intuitive. Comprehensive diagnostics,
auto-tuning and advanced oscilloscope tools simplify system commissioning. Auto-phasing
eliminates time consuming rewire-and-try for encoder/Halls/motor connections. CME
automatically compensates for crossed wires eliminating the most common cause of startup
headaches.

2.2.2 Indexing

Point-and-click to define up to 32 indexes or index sequences. Simply select the index/sequence
and command GO. Index sequences can include motion, parameter changes, dwell times and
I/0 control. Any parameter can be assigned to a register for efficient control by a PLC.

Custom functions can be provided for complex applications. Install the Java "bean" and fill in
the blanks. Copley also provides a flexible OEM programming environment. Copley Virtual
Machine assembler/debugger enables the development of fast, compact control program.

2.2.3 Cam Tables

Camming is an effective way to produce repetitive motion synchronized to an external device.
A pre-defined cam-table of slave positions is typically cycled through by a master encoder
connected to the drive. The drive performs linear interpolation between points to minimize cam-
table size.
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NOTE: The feature descriptions in this manual may not apply to all Copley Controls amplifiers
under all configurations. Significant differences between amplifier models are noted. See the
relevant hardware manual or data sheet for more information.

2.3 Servo Operating Modes and Control Loops

Copley Controls drives use up to three nested control loops - current, velocity, and position - to
control a motor in three associated operating modes. (Stepper drives operated in stepper mode,
function as traditional open position loop stepper drives).

2.3.1 Control Loops Model
In position mode, the amplifier uses all three loops. As shown in the typical system illustrated
below, the position loop drives the nested velocity loop, which drives the nested current loop.

Limits
Target Position Velocity Limited Current Limited PWM
Position | Gommand Command | Velocity Command Current Command
. " ' 1 [@ T ' .
Trajectory Position Vglo_cny |5 velocity T Cl_Jrr_ent Current Motor/
Generator Limiter ﬂ % Limiter

Loop . Loop . Loop Sensors
’—A:tual Position ’—;erived Velocity ’—;ctual Current

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop is
driven directly by external or internal current commands.

2.3.2 Basic Attributes of All Servo Control Loops

Loop Description

Attribute

Command | Every loop is given a value to which it will attempt to control. For example, the

input velocity loop receives a velocity command that is the desired motor speed.

Limits Limits are set on each loop to protect the motor and/or mechanical system.

Feedback The nature of servo control loops is that they receive feedback from the device
they are controlling. For example, the position loop uses the actual motor
position as feedback.

Gains These are constant values that are used in the mathematical equation of the
servo loop. The values of these gains can be adjusted during amplifier setup to
improve the loop performance. Adjusting these values is often referred to as
tuning the loop.

Output The loop generates a control signal. This signal can be used as the command
signal to another control loop or the input to a power amplifier.

For more information on using CME to set up and tune control loops, see Control Loops.

10
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Installation, Startup and Interface Tour

3
3.1

A

© o N

Note

INSTALLATION, STARTUP, AND INTERFACE TOUR
Download and Install CME Software

Go to www.copleycontrols.com.

Navigate to General Resources under Support.
Click on Software.

Navigate to CME Software Ver 8.0.

&

Click on download icon
Add the email address to register. The link to download the software will be sent to the
email address.

Click on the link and download the software.

Extract the contents of CME.zip.

Run Setup.exe and follow the instructions on the installer screens.

: It is recommended that all default installation values are accepted.

3.2 Special Notes for Windows 7, Windows 8 and Windows 10

3.2.1 Installer
When the installer starts, Windows will display a dialog asking for permission to make changes
to your computer. Click the button to allow the installer to continue, and CME will be installed.

3.2.2 Set up CME to run as administrator
On some versions of Windows 7 , Windows 8 and Windows 10, CME will have to be set up to run
as administrator to access the communications drivers (Serial, CANopen, EtherCAT).

11
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1. Right-click the CME icon Il on the desktop.

2. Choose Properties from the pop-up menu.

Open
Troubleshoot compatibility
3 Run with graphics processor »

Open file location
® Run as administrator
Restore previous versions
Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties
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4. Click the Advanced button on the Properties dialog.

€D CME Properties X
Security Details Previous Versions
General Shortcut Compatibility
ﬁ CME
&
Target type: Application

Target location: CME 2

Target:

S:\Program Files\Copley Motion\CME 2\CME2,exe"‘

Startin: ‘”C.\Program Files\Copley Motion\CME 2" ‘

Shortcut key: lNOne ‘

Run: Normal window Y

Comment: ‘ ‘

Change Icon... l Advanced... I

Open File Location

OK Cancel Apply

Note: The name of the application has been changed from CME2 to CME, but the

files will be downloaded to a "CME2" folder.

5. Select Run as Administrator.
then OK to close the Properties dialog.

Advanced Properties

Choose the advanced properties you want for this shortcut.

Run as administrator

This option allows you to run this shortcut as an
administrator, while protecting your computer from
unauthorized activity.

Run in separate memory space

(Lo ]

Cancel

12

Click OK to close the Advanced Properties dialog,
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3.3 Start CME
&
1. Double-click the CME shortcut icon lllll on the Windows desktop to start CME.

If communications were set up already, the CME Main Screen opens.

If communications were not set up, the Communications Wizard will be displayed as shown
below:

Communications Wizard X

Select Device:
@® Serial Ports
O CAN Network

O EtherCAT

Next > l ’ Cancel l

In this case, proceed to Communications Wizard.
@ CME V8.0 Beta 15 (XPL-230-18 unnamed) — O X

File  Amplifier Tools Help

HOCOED « ) E e

= |4 Copley Neighborhood CAN Network: ~ Address: 16  State: Pre-operational
E Virtual Amplifier
- —— B COM4: unnamed InpUEL OLitput
CVM Control Program
CAN Configuration — Ploop = Vloop =P ILoop — Motor
®) Axis A
L’ e Home Configure Regen Configure Faults
Axis B
Axis C Configure Filters
Axis D
‘Amp Under CAN Control F12 To Disable |

Example of a CME Main Screen after an amplifier has been selected.

3.4 Communications Wizard

3.4.1 Configure Serial Ports

1. Start the Communications Wizard.

If communications have never been set up, the Communications Wizard will be displayed
automatically when CME starts up.

If communications have already been set up, choose Tools>Communications Wizard.

Choose Serial Ports and click Next.

13 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Installation, Startup and Interface Tour

Communications Wizard X

Select Device:
@® serial Ports
O CAN Network

O EtherCAT

" Next > ‘ Cancel

2. Select Serial Ports.

Select one or more serial ports from the Available Ports list.
Click Add.

Communications Wizard

Select Ports

To add serial ports, select them from the Available Ports list, then press Add.

To remove serial ports, select them from the Selected Ports list, then press Remove.

Available Ports:

Selected Ports:
COM3 COM4
[anad >l
< Remove
< Back Next > Cancel

When all the desired ports have been added, click Next.
3. Configure serial ports.

Select a port from the Selected Ports list.
The Baud Rate will be displayed.
Repeat for each selected port.
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Communications Wizard X

Configure Serial Ports

Select one or more serial ports from the list, then select the baud rate.

Selected Ports:

Baud Rate: 115200

< Back Cancel

e Click Finish to save the settings.

3.4.2 Configure CANopen Network

1. Start the Communications Wizard.

If communications have never been set up, the Communications Wizard will be displayed
automatically when CME starts up.

If communications have already been set up, choose Tools>Communications Wizard.
Choose CAN Network and click Next.

Communications Wizard X

Select Device:

() Serial Ports

() EtherCAT

Next > Cancel

2. Configure CANopen Network
1. Select the CAN Card from the list.
2. Enter the channel number (0 for single channel CAN cards) in Channel.
3. Select the Bit Rate (1Mbit/s Drive default)
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16

Configure CAN Network

CAN Interface: Copley
Channel: 0

Bit Rate: iMbitfs
[] use LSS to Configure Node Ids

< Back Finish Cancel

4. Click Finish to save the settings.
Notes:

1. The CAN Card list only shows the CAN cards that are supported by CME and are
properly installed on the PC.

2. LSS can be used if all nodes are 0 and no switch is being used.

Q2 Layer Settings Services (L55) =
CANopen DS-305 LSS

Press start to find devices on the CAMopen netwark

Devices found:

Close
= X
Enter the node id for the device with a green blinking CAN LED, then press OK. 1|
OK
Q Layer Settings Services (LSS) X

CANopen DS-305 LSS

Press start to find devices on the CANopen network

Devices found: 1

Close
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3.4.3 Configure EtherCAT Network

1. Start the Communications Wizard.

If communications have never been set up, the Communications Wizard will be displayed
automatically when CME starts up.

If communications have already been set up, choose Tools>Communications Wizard.
Choose EtherCAT and click Next.

Communications Wizard X

Select Device:
() Serial Ports

(O CAN Network

Next > Cancel

Select the appropriate Network Adapter.

Communications Wizard X

Metwork Adapters:

iIntel(R) Ethernet Connection 1219-LM { v

< Back Finish Cancel

Click Finish to save the settings.

3.5 Connect to an Amplifier

Choose an amplifier by clicking on its name in the Copley Neighborhood. When there is only one
amplifier, CME will automatically connect on startup.
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Serial port
@ CME v8.0 Beta 15 (XPL-230

File  Amplifier Tools Help

£ O & B[

Copley Neighborhood
i EE Vfirtual Amplifier

9 - _ W COM4: unnamed

CAN network

File Amplifier Tools Help

@ CME V8.0 Beta 17 (XPL-230-18 XPL-230-18-HL)

SOOEM « B

= am.

18

= : Copley Neighborhood CAN Network:  Address:
- EEB Virtual Amplifier
H 1
R — B CAN1: XPL-230-18-HL Input / Cutput

[ 1
’ CVM Control Program |=—

|

EtherCAT network

File Amplifier Tools Help

@ CME V8.0 Beta 17 (XEL-230-40 PolyX_1_ZAxis)

SOCOEM « O

= 6w

=+ | Copley Neighborhood
i B Virtual Amplifier
B - _BECAT: PolyX_1_ZAxis
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3.6 Rename an Amplifier
1. Navigate to Node.

2. Choose Main Menu Amplifier>Rename to open the Rename Amplifier screen.

@ CME V8.0 Beta 15 (XPL-230-18 unnamed) e O X

File  Amplifier Tools Help

£ osew 0= mN-

= Control Panel etwork: Address: 16  State: Pre-operational
Auto Phase

nput / Output
Scope I
Frequency Analysis Control Program
Error Log | | |
Amplifier Properties Configuration = PLoop = Vloop = ILoop — Motor
Network Configuration T |
Rename
® Gain Scheduling
Home Configure Regen Configure Faults
Corrections Table I
Axis C Configure Filters
Axis D
lAmp Under CAN Control
Rename Amplifier X
Enter the new name:
Spindle|
OK Cancel

3. Enter the new name and click OK to close the screen. The Drive name is now in FLASH

and can be seen in the tree.

@ CME V8.0 Beta 15 (XPL-230-'

| File Amplifier Tools Helrp

HOCHEM -

Copley Neighborhood (

| [-—_ B COM4: Spindle I

19
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3.7 CME Interface Tour

CME features are called out in the diagram below. Screen details vary depending on amplifier

@ CME V8.0 Beta 15 (XPL-230-18 unnamed) e O X
o (B om-.
Copley ————— P = | CopleyNeighborhood CAN Network:  Address: 16  State: Pre-operational
Neighborhood Tree &= Vitual Amplier
[-—_RCOM4. unnamed Input / Output
| <«—— Functional
CVM Control Program D|agram
| N
CAN Configuration =% PlLoop = Vloop = ILoop — Motor
oLt e, oVOAE TR e
Axis Selection —» | | i il i
Axis ( Configure Filters
Axis D
Status Bar ———————Jp-Amp Under CAN Control | F12 To Disable |
3.7.1 Main Menu
File Menu
@ CME V8.0 Beta 15 (XPL-230-18 Spindle) —
fFile Amplifier Tools Help h
Save Drive Configuration (.ccd) ;_j m ﬂ ﬂ
Save Amplifier Data (.ccx) yrk:  Address: 1 State: Pre-operational
Restore > Drive Configuration (.ccd)
Exit Amplifier Data (.ccx)
CVM Co CVM Control Program (.ccp)
CVM Encoder Correction Table (.cce)
CANC Cam Tables (.cct) 2ol
Gain Scheduling Table (.ccg)
N
|
Option Type Description For More
Information
Save Drive Saves the entire contents of amplifier | Error! Not a valid r
Configuration .ccd to a single drive configuration file. This | esult for table.
includes all drive parameters, CVM
flash space (CVM programs, gain
scheduling, etc.)
Saves the parameters of the amplifier
Save Amplifier .CCX RAM to a file on disk.
Data
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For multi-axis drives only: saves one
axis to a file on disk. (Available only

Save As->Single | .ccx !
Axis for older drives)
Save As>V4.1 .CCX Saves amplifier data file in format
Format usable by CME 2 Version 4.1.
(Available only for older drives)
For multi-axis drives only: copies the
Copy Axis setting from one axis to another.
Restore->Drive Restores the entire contents of
Configuration .ced amplifier to a single drive
configuration file. This includes all
drive parameters, CVM programs and
gain schedules.
(MACRO amplifiers only) Saves
Save MACRO .ccd amplifier setup and tuning parameters
File in a format that can be read by Delta
Tau controllers.

Restore->Amplif Restores the parameters of the
ier Data .CCX amplifier file from disk to amplifier
RAM.

Restore->Single For multi axis drives only: restores
Axis .ccX contents of an amplifier file to only one

axis
Restore>CVM Restores a CVM program from a file to
Control .ccp the CVM Flash.
Program
Restore>CVM Restores a correction table from disk
Encoder .cce to the CVM flash.
Correction
Table
Restore>Cam Restores a Cam Table file (.cct).
Tables .cct
Restore->Gain Restores Gain Scheduling Table from a | Gain Scheduling
Scheduling .ccg file (.ccq).
Table
Exit Closes CME.
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Amplifier Menu

@ CME V8.0 Beta 15 (XPL-230-18 Spindle)

Filfl Amplifier | Tools Help )
Setup I ‘ .-_j ‘u__[ ﬁ ﬁ
=R Control Panel twork:  Address: 1 st
Duofbes ut / Output
Scope I
Frequency Analysis ontrol Program
Error Log I |
Amplifier Properties Nconfigurstion | = P Loop —
Network Configuration L
= Rename
@ Gain Scheduling - .
g Corrections Table 4
AXxi | Configure Filters
Option Description For more information
Setup Opens Setup screen SetupError! Reference

source not found.

Control Panel

Opens Control Panel

Control Panel

Configuration

Auto Phase Opens Auto Phase tool Motor Phasing

Scope Opens Scope Tool screen Scope

Frequency Opens Frequency Analysis | Frequency Analysis
Analysis tool

Error Log Opens Error Log screen Error Log

Amplifier Displays basic amplifier | Amplifier Properties
Properties properties

Network Opens the Network | Network Configuration

Configuration screen

Rename

Prompts for new amplifier
name

Rename an Amplifier

Gain Scheduling

Opens Gain

screen

Scheduling

Gain Scheduling

22
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@ CME V8.0 Beta 15 (XPL-230-18 Spindle)

File Amplifier nfools Help ]
Q @ C\J Communications Wizard 5
=) Copley N Communications Log _S
=8 vird
= s Download Firmware & FPGA Program
Manual Phase =
View Scope Files
9
CME Lock/Unlock
ASCIl Command Line —
Login
(@) Axis A x §
- 1/0 Line States on
Axi N, ; v
Configure Filters
Selection Description For More Information
. Starts sequence of
Communications — .
. prompts to set up Communications Wizard
Wizard A
communications
Communications Opens Communications N
Communications Log
Log Log
Download Starts prompts to

Firmware & FPGA
Program

download firmware from
disk to amplifier

Firmware Download

Manual Phase

Opens Manual Phase tool

Manual Phase

View Scope Files

Opens Trace Viewer
window

Scope Trace Files

CME Lock/Unlock

Opens screen for locking
and unlocking CME
functionality

Lock/Unlock CME

ASCII Command
Line

Opens screen to accept
ASCII format commands

Copley ASCII Interface

Login

Opens Login screen which
prompts to enter
credentials for a local
installation

I/0 Line States

Opens I/0 Line States
window, showing high/low
status of the amplifier’s
inputs and outputs
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Help Menu
& CME V8.0 Beta 15 (XPL-230-18 Spindl¢
T A
le Amplifier Toolfl | Help
§ @ C\) E CME User Guide | i
m : All Documents I T

- KB Virtual Am)

= Copley Controls Website
View Release Notes il
About -|—
A\ L =5 v
1
Selection Description

CME User Guide | Opens this manual

Opens the Doc folder in the CME installation folder

(typically c://Program Files/Copley Motion/CME2/Doc).

This folder contains all the related documents that were installed
with CME.

All Documents

’

Copley Controls | Opens default web browser with pages from Copley Controls
Website website

View Release

Opens latest CME release notes in a text viewer
Notes

About Displays CME version information

3.7.2 Tool Bar

Icon Name For More Information
Q Setup Error! Reference source not
found.For initial setup

® Control Panel Control Panel

& Auto Phase Motor Phasing

LA Scope Scope

Frequency Analysis Frequency Analysis

! Error Log Error Log

Amplifier Properties Amplifier Properties
Save to disk

Restore from disk

Save to flash Data Management Tools

Restore from flash

# % B D
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3.7.3 Functional Diagram
The functional diagram, shown below, provides button-click access to most of the screens
used to configure an amplifier. It also indicates the flow of control from input, across all
active control loops, to motor. Only those control loop buttons that are appropriate to
the amplifier and operational mode appear on the diagram.

Input / Output

CVM Control Program

CAN Configuration == P Loop =P Vloop =P IlLoop =P

Home

-~

Motor

Configure Regen

Configure Filters

Configure Faults

Button Description For More Information
Input/ Opens Input/ Output screen Digital Inputs and Outputs
Output
CVM Control Opens Copley Virtual Machine screen Copley Indexer Program User’s
Program Guide.
Opens screen for configuring the input
Input command Error! Not a valid resuit for t
Command Button text varies depending on the selected | able.
control loop input
Control Each opens a control loop configuration Control Loops
Loops screen
Motor Opens the Motor screen Motor
Home Configure and test homing Homing
FC{gngure Opens Regen Settings screen Regen Resistor Configuration
Configure ) . FaultError! Reference
Faults Opens Fault Configuration screen source not found.
Configure . . . .
Filters Opens Filter Configuration screen Filters
Encode'r (Stepper ampllflgr with encoder only) Opens Encoder Correction
Correction Encoder Correction screen

25

Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Installation, Startup and Interface Tour

Detent (Stepper amplifier only). Opens stepper Detent Compensation Gain
amplifier Advanced Tuning screen

Position (Stepper amplifier with encoder only) Opens | Position Limits (Stepper

Limits Position Limits screen Amplifier)

3.7.4 CAN Information and Status Bar

3.7.4.1 CAN Information
The Main screen displays the basic CAN information.
The example below shows CAN information:
CAM Metwork:  Address: 1 State: Pre-operational

The Address field shows the amplifier’s present CAN address. For more information, see Network
Configuration. When the Position Loop Input is set to CAN, the State field shows the state of the
amplifier's CANopen state machine (for more information, see Copley Control’s CANopen
Programmer’s Manual).

3.7.4.2 Status Bar

The status bar describes the amplifier control status as shown below. It also includes a reminder
that pressing the F12 function key while CME is running disables the amplifier.

I | ’ [

{ Amp Hardware Disabled F12 To Disable
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4 AMPLIFIER SETUP
4.1 Setup Procedure

4.1.1 Warnings and Notes

NOTE: To software disable the amplifier at any time while running CME, press function key F12.
Also, the amplifier’'s enable input can be used to disable the amplifier.

DANGER: Hazardous voltages.
Exercise caution when installing and adjusting.

Do not make connections to motor or drive with power

Risk of unexpected or uncontrolled motion with CME in
CAN mode.

CME can be used while the amplifier is under CAN or EtherCAT
control. However, some extreme changes made with CME
could cause unexpected or uncontrolled motion.

Failure to heed these warnings can cause equipment
damage, injury, or death.

Spinning motor with power off may damage amplifier.

Do not spin motors with power off. Voltages generated by a
motor can damage an amplifier.

Failure to heed this warning can cause equipment
WARNING damage.
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1. Prepare for setup.

Understand the procedure’s Warnings and Notes.

Verify that the amplifier power is OFF.

Verify wiring and connections.

Make sure motor is securely fastened with no load connected.

® 2o T oo

Apply power to the amplifier. For off-line amplifiers apply 24V only.
For DC amplifiers apply AUX HV only.

2. Start CME and enter Setup parameters.

L
a. Double-click the CME icon on the desktop to start CME.

If necessary, connect to an amplifier from the list in the Copley Neighborhood

tree.
&

b. If the Setup screen does not appear, click the Setup button

c. Choose:

In most cases, click Change Settings | Change Settings lto Change Setup
Settings. Then proceed to Step 3 of this Setup Procedure.
OR

To load a .ccx file, see Copy Drive Data.

To load a .ccd file, see Copy Drive Data.

2. Enter Motor parameters. See Motor Data.
3. Configure digital I/O. See Digital Inputs and Outputs.

4. Configure the command input. See Command Inputs.

a. Based on the command source settings in the Setup screen, one of the following
buttons will appear in the main screen.

Anslog Command | ’ PWM Command 1 l Digital Input ‘ ’ CAN Caonfiguration

b. Click the appropriate button to configure the amplifier's command input.

NOTE: If the amplifier is to run CVM programs or in Camming mode see the
relevant documents.

c. After setting command input parameters, Click Close.

5. Configure Homing. See Homing.

6. Configure an optional regen resistor. See Regen Resistor Configuration.
7. Configure faults. See Faults.
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8. Phase and jog the motor.

a.

b.

C.

10.

a.

Apply AC or HV power.

Phase © the motor. See Auto Phase.

Jog/move the motor to verify that the amplifier can drive the motor. See Jog Mode.

Tune the control loops. See Control Loops.
a. Tune Control Loop I (Current).
b. Tune Control Loop V (Velocity).
c. Tune Control Loop P (Position).

Set gains and limits for stepper mode (stepper only)

If tuning a stepper amplifier in stepper mode:

e Set Position Limits in Stepper Mode. See Position Limits (Stepper Amplifier)
e If using Encoder Correction, see Encoder Correction.
e Tune Detent Compensation Gain.

11. Test with load attached.

a. On the CME Main screen, click Save to Flash.
b. Remove amplifier power.

Attach load.
d. Reconnect amplifier power.

e. If necessary, re-tune velocity and position loops.

.....

g. On the CME Main screen, click Save to Disk 4 (for backup or duplication).

h. The amplifier tuning procedure is complete.

NOTE: To copy the results of this setup to other amplifiers, see Drive Configuration or Copy
Drive Data.
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5 SETUP
5.1 Overview

The Setup Wizard is used to set up the parameters that define the fundamental
characteristics of the system. This is where the motor, feedback and operating mode are
setup. The setup can be done three different ways: manually change settings, load
settings from a ccx file or load settings from a ccd file. Each of these methods are
explained in this section.

1. Click ¥ to open the Setup screen.

Setup X
Settings
Motor Family: Brushless
Motor Type: Rotary
Commutation: Sinusoidal
Hall Type: Digital
Hall Phase Correction: On
Use Halls for Velocity/Position: Off
Use Back EMF for Velocity: Off
Motor Feedback: Primary Incremental
Load Feedback: None
Multi-mode Port: Buffered Primary Feedback
Operating Mode: CAN

Load ccx File Load ccd File Cancel

2. Review settings.

3. Choose:

Click Change Settings | 72192 5€tgs | anually Change Setup Settings.
OR

If you have a .ccx file, see Copy Drive Data.

OR

If you have a .ccd file, see Copy Drive Data.

4. To accept the displayed settings, click Cancel %.
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5.2 Change Setup Settings

1. On the Setup screen, click Change Settings _ Change Settings_Jy manually change all Setup
settings. Use the Back and Next buttons to navigate between screens. Screen details
vary depending on amplifier model and mode selection.

2. Set Motor Options.

Setup X

Motor Options

Motor Family:

(®) Brushless () Brush

Motor Type:

(® Rotary () Linear

[] Yertical
[] Brake

< Back Next > Cancel

3. Click Next to go to Feedback Options.

Setup X

Feedback Options
Hall Type: Digital

[~] Hall Phase Correction

Input Source:
Motor Feedback:  Incremental ~ (@) Primary Secondary
Load Feedback: |None
< Back " Next > Cancel
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Setting Description

Hall Type Select Hall type: None, Digital, or Analog

Hall Phase | If selected, will enable error checking between hall sensors and encoder
Correction phase angle.

Motor Feedback Select type and source of motor feedback.

e None: No motor encoder.

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode port.
e Panasonic Incremental A Format

e SSI

e EnDat

e BiSS

Absolute A

e Tamagawa Absolute A

e Panasonic Absolute A Format

e Panasonic Incremental A Format

e Sanyo Denki Absolute A

e Analog: Analog encoder on primary feedback connector.
e Low Frequency Analog

e Resolver: Resolver (-R) version of a Copley Controls amplifier on
primary feedback connector.

Additional encoder types are supported by certain Copley Controls
amplifier models. See the amplifier data sheet for more information.

Load Feedback Select type and source of load feedback.
e None: No load feedback

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode Port.
¢ Analog: Analog encoder on primary feedback connector.

Load Feedback Select the type of load feedback:
Type « Rotary

e Linear
Use Load When this is checked, the position of the load encoder will be reported
Feedback in by the passive load position variable but will not be used to control the
Passive (Monitor) position of the axis.
Mode

Stepper Drives Only

Motor Encoder | Select the encoder type:
e None

e Primary incremental

e Absolute types

Run in Servo | (Requires encoder) Amplifier operates as a true, closed loop, servo amplifier
Mode controlling a stepper motor.

Enable (Requires encoder) Amplifier runs as a stepper drive; encoder feedback is
Encoder used to correct positional errors. See Encoder Correction
Correction
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4. Click Next to go to Motor Feedback.

Setup

Motor Feedback

1000 | lines =

(®) No Encoder Loss Detection
(_) Enable Encoder Loss Detection (Ignore Index)

() Enable Encoder and Index Loss Detection

4000 counts

< Back f;:ﬂ’;)}{; Cancel

Feedback Parameters, Rotary

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type

Parameters/Actions

Incremental

In the Motor Encoder lines or Position Encoder lines field, enter the number of
encoder lines (see encoder or motor data sheet). As indicated by the counts field,
the number of encoder counts per revolution is equal to 4 x the number of lines.
Enable Encoder Loss Detection and/or Index Loss detection if desired.

Motor Feedback

2048 | lines = 8192 counts

") No Encoder Loss Detection

@ Enable Encoder Loss Detection (Ignore Index}

(7) Enable Encoder and Index Loss Detection

33
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Analog In Fundamental Lines, enter the number of fundamental encoder lines (see
encoder or motor data sheet). As indicated by the Fundamental Counts field, the
number of fundamental encoder counts per revolution is equal to 4 x the number of
Fundamental Lines.

Motor Feedback

Fundamental Lines: 512

Fundamental Resolution: 2048

Interpolation:

Interpolated Counts: 8388608
Optionally modify the encoder resolution by changing the Interpolation value. The
interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental
Counts value and the Interpolation value.

Resolver Optionally modify the feedback resolution by changing the value in Counts Per
Rev. Default: 16384.

Resolver
16384|  counts per rev
Halls With amplifier set to Use Halls for Velocity/Position, optionally increase the
counts per rev ratio by incrementing the Halls Count Multiplier.
-Motor Halls - -
Hall Count Multiplier: | 1 v
Counts per Rev.: 24

Feedback Parameters, Linear

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type Parameters/Actions
Incremental Choose units and then enter the Encoder Resolution (see encoder or motor data
sheet). Enable Encoder Loss Detection and/or Index Loss detection if desired.
Motor Feedback
Resolution: 1 ) mm @ L ) nm
“) No Encoder Loss Detection
@ Enable Encoder Loss Detection (Ignore Index)
~) Enable Encoder and Index Loss Detection
Analog Enter the Fundamental Pitch (distance between encoder lines; see encoder or
motor data sheet). As indicated by the Fundamental Resolution field, Fundamental
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Pitch divided by four gives Fundamental Resolution. The interpolated resolution is
the dividend of Fundamental Resolution value/Interpolation value. Optionally
modify the Interpolated Resolution by changing the Interpolation value.

Motor Feedback

Fundamental Pitch: 20| )mm @ um () nm

Fundamental Resolution: 5 um

Interpolation:

Interpolated Resolution:  0.0048828125 um

Low Frequency
Analog

Normally used with ServoTube, Pole Pitch is the distance between poles in a pole
pair, as entered in the Magnetic Pole Pair Length field on the Motor tab. The
interpolated resolution is the dividend of Pole Pitch/Counts per pole value,
expressed in micrometers. Optionally modify the resolution by changing the
Counts/Pole value. Click Restore Default to restore default Counts/Pole.

Motor Feedback

Fundamental Pitch: 20 C)mm @ um (7)nm

Fundamental Resolution: 5 um

Interpolation:

Interpolated Resolution:  0.0048828125 um

5. Click Next to go to Load Feedback.

Load Feedback

Resolution: 0.4 um
(®) No Encoder Loss Detection
() Enable Encoder Loss Detection (Ignore Index)

() Enable Encoder and Index Loss Detection

Ratio

Motor Turns: 1

Load Turns: 1

35

< Back Cancel

Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019




Setup

6. Click Next to go to Brake/Stop tab.

Setup

Brake/Stop Motor Wiring Detection

'
Enable Input —lﬂi Brake/Stop delay time
H

Speed

1 Brake/Stop activation velocity

Brake Ouptput

|

'
Enable PN delays

Power Section o
'
H
1
Brake/Stop Delay Time:

Brake/Stop Activation Velocity:

PWM Delay Brake/Stop Response Time:

Brake/Stop response time

0| rpm

< Back Cancel

Many control systems employ a brake to hold the axis when the amplifier is disabled. On brake-
equipped systems, disabling the amplifier by a hardware or software command starts the

following sequence of events.

1. The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast
Stop Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time
count begins. This allows the amplifier to slow the motor before applying the brake.

2. When response time has passed, the amplifier’s output stages are disabled. This delay
ensures the brake has time to lock in before disabling the power section.

Systems that do not employ brakes may still come to a controlled stop. On such systems,
disabling the amplifier by a hardware or software command initiates the motor deceleration (at
Abort Deceleration rate in position mode or Fast Stop Ramp rate in velocity mode). After the
Brake/Stop Delay Time and any PWM delay response time, the drive will be disabled. This allows
the amplifier to bring the motor to a controlled stop before disabling the drive.

Note: This feature is not available when the amplifier is configured for current mode. In
this mode, the amplifier output turns off and the brake output activates immediately
when the disable command is received.

Parameter

Description

Brake/Stop Delay Time

Time taken to stop the system.
Range of accepted values: 0 to 10,000 mS

Brake/Stop Activation
Velocity

Typical values are low to protect the brake mechanism (a few rpm).
“0” disables velocity-based brake activation.

PWM Delay Brake/Stop
Response Time

Time delay taken for the brake to engage after brake output is activated.
Range of accepted values: 0 to 10,000 mS
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7. Click on Motor Wiring Detection tab.

Setup X

Brake/Stop Motor Wiring Detection

Enable input I

Brake Output
——

e e
Brake Hold Time on Enable

Motor Check Current

Brake Hold Time On Enable: 0| ms

Motor Check Current: 0 A

On some drives, the amplifier can check for a disconnected motor.

Upon enable, the amplifier

will apply current to the motor windings, while keeping the brake engaged for the brake hold

time.
the brake will not be released.
brake hold time expires.

If the current vector cannot be applied, then a motor disconnected fault will occur, and
If the motor is connected, the brake will be released after the

Parameter Description

Brake Hold Time on
Enable

The time during which the amplifier is enabled, but the brake is engaged
and the current is applied to the motor windings.

Motor Check Current

The amount of current to apply to the motor windings.

8. Click Next to go to Operating Mode Options.

Setup X

Operating Mode Options
Operating Mode:  Position v

Command Source: CAN

Digital Input Source
igh Speed TS

<Back [ Next> ||| Cancel
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Setting Description

Operating Choose the mode of operation: Current, Velocity, or Position.

Mode See Control Loops

Command Choose the command input source (see Error! Not a valid result for t
Source able.):

e Analog Command (Current & Velocity Modes): Analog voltage provides
command input.

e PWM command (Current and Velocity modes): Digital pulse-width

modulated signal provides command input. Command input is provided via
the chosen Input Source (below).

e Function Generator (Current, Velocity & Position modes): Internal function
generator provides command input.

e Software Programmed (Current, Velocity & Position modes): The amplifier
is controlled by software commands from either the Copley Virtual Machine
(CVM) or an external source. See Copley Indexer Program User’s Guide or
the Copley ASCII Interface Programmer’s Guide.

¢ Analog Command Position (Position mode):

e Analog Command, Profile Velocity (Position mode):

¢ Digital Input (Position mode): Command input is provided via the chosen
Input Source (below).

e CAN or CANopen Over EtherCAT (CoE) (Position mode): Command input

is provided over the CANopen or EtherCAT network. See the CANopen
Programmer’s Guide.

e Camming (Position mode): Runs in Camming Mode. See Copley Camming
User Guide.

e Slave (Current, Velocity & Position Modes). When set as a “slave”, it follows
the command source of the master. (Only available in Multi-axis drives.)

Digital Input | Choose the input source for PWM or Digital input commands:

Source « Single-ended Inputs: Command input is provided via two of the amplifier’s
programmable digital inputs.

e Multi-mode Port: Command input is provided via differential inputs on the
amplifier's multi-mode port.

¢ Differential Inputs: Command is provided via differential inputs.

e High Speed Inputs. Command is provided via two of the amplifier's high-
speed inputs.
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9. Set Miscellaneous Options.

Miscellaneous Options

Multi-mode Port: Buffered Primary Feedback

<gack | [ Fsh | Gancel

Setting Description

Commutation | Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal

Use back EMF | If selected, will use the motor’s measured back EMF to determine motor
for Velocity velocity. Recommended only for medium- to high-speed. Accuracy depends
on the accuracy of the programmed Back EMF value, and may be affected by
factors such as cable resistance.

Use Halls for | If selected, will use transitions of the Hall switches to determine motor
Velocity and | velocity and position. Recommended only for medium- to high-speed

Position applications (may run roughly at low speeds).
Multi-mode Selects the mode for the amplifier’'s multi-mode port:
Port = Buffered Primary Feedback- The multi-mode port functions as a

buffered digital encoder output based on the digital encoder input.

= Differential Input. The multi-mode port functions as a differential
command input.

= Emulated Motor Feedback- The multi-mode port functions as an
emulated digital encoder output based on the motor analog encoder
or motor resolver and absolute encoders.

10.When changes are complete, click Finish. The changes will be saved to Flash.
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6 MOTOR DATA
6.1 Motor Data Screen Overview

M
1. Click Motor M to open the Motor Data screen.

@
- f 2 Unlts
) Use Motor Plate Data Manufacturer: | Panasonic
_ - (®) Metric () English
(®) Use Specification Data Model: MSMFSAZLIUL ol
Number of Poles: 10 Torque Constant:
0.11| N'm/Apk ~
Mator Inertia:
0.026 | kg-em? . Back emf Constant:
12.5| \Vfkpm v
Peak Torque:
048] |Nm v Resistance: 441 ohms
Continuous Torque: EETE: A
0.16 Nm v
Velocity Limit: 13000 | rpm
T b
mEw F
Close

2. Choose Use Specification Data (See Use Specification Data).

(O) Use Motor Plate Data

(®) Use Specification Data
OR

Choose Use Motor Plate Data (See Use Motor Plate Data)

]
3. Load data from the file Error! Reference source not found.
OR
Enter settings manually.
4. Click to calculate initial gains and limits. (See Calculate).

On the Main screen, click L -Save to flash- to avoid losing the calculated data.
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6.2 Rotary Motor Parameters

Setting

Description

Manufacturer

Motor manufacturer’s name. Saved for reference in the motor data file.

Model Number

Motor model number. Saved for reference in the motor data file.

Units

Selects whether the parameters entered in this screen are in Metric or English
units.

Motor Inertia

The rotor inertia of the motor. Used for calculating initial velocity loop tuning
values.
Range: 0.00001 to 4,294 kg cm?. Default: 0.00001 kg-cm?

Number of Poles

(Brushless only.) The number of magnetic poles in the motor. Required for
correct commutation of the motor. If the number of poles is not known,

Verify the motor’s pole count using the Data accuracy test. Range: 2 to 200.
Default: 4.

Peak Torque

The peak torque that the motor can produce. Peak Torque divided by torque
constant = motor’s peak current limit. Range: 0.0001 to 2,100 Nm. Default:
0.0001 Nm.

Continuous Torque

The continuous torque that the motor can produce. Used with the torque
constant to calculate continuous current. Range: 0.0001 to 1,000 Nm. Default:
0.0001 Nm.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration
limits for the velocity loop. Range dependent on encoder resolution.

Torque Constant

Relates the motor's input current to torque produced. Sometimes abbreviated
as Kt.
Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used
for calculating the maximum velocity for a given amplifier bus voltage.
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.

Resistance Motor resistance line-to-line. Used for calculating the initial current loop tuning
values.
Range: 0.01 to 327 Q. Default: 0.01 Q.

Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning

values.
Range: see the hardware documentation.

Stepper Amplifiers

Only

Rated Torque

Motor’s rated operating torque. Min: .001. Max: 1000.

Rated Current

Motor’s rated continuous current. Min: 0.001. Max: 1000.

Basic Step Angle

Fundamental stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default
1.8.

Microsteps/Rev

Number of microsteps per revolution of the motor.
Min: 4. Max: 100,000,000. Default 4000.

Full Steps/Rev

This read-only value can be used after entering Basic Step Angle to cross-check
against motor data sheet.
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6.3 Linear Motor Parameters

Setting

Description

Manufacturer

Motor maker’s name. Saved in the motor data file. Choose from list or enter
manually.

Model Number

Motor model number. Saved in the motor data file. Choose from list or enter
manually.

Units Selects whether the parameters entered in this screen are in Metric or
English units.

Mass The mass of the motor. Used for calculating initial velocity loop tuning values.
Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg.

Peak Force The peak force that the motor can produce. Peak Force divided by Force

Constant = motor’s peak current limit. Range: 0.00001 to 2,000 N. Default:
0.00001 N.

Continuous Force

The continuous force that the motor can produce. Used with the force
constant to calculate continuous current. Range: 0.00001 to 1,000 N.
Default: 0.00001 N.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration
limits for the velocity loop. Range dependent on encoder resolution.

Force Constant

Relates the motor's input current to force produced. Sometimes abbreviated
as Kf.
Range: 0.00001 to 2,000 N/Amp. Default: 0.00001 N/Amp.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke.
Used for calculating maximum velocity for a given amplifier voltage. Range:
0.01 to 1,000 V/M/Sec. Default: 0.01 V/M/Sec.

Resistance Motor resistance line to line. Used for calculating the initial current loop
tuning values. Range: 0.01 to 327 Q Default: 0.01 Q

Inductance Motor inductance line to line. Used for calculating the initial current loop
tuning values. Range: see the hardware documentation.

Magnetic Pole Pair | The length of a pair of magnets which equals the distance moved in one

Length electrical cycle of the motor.

Stepper Amplifiers Only

Rated Force

Motor’s rated operating force. Min .001 N. Max 1000 N.

Rated Current

Motor’s rated continuous current. Min: 0.01 A. Max 1000 A.

Full Step Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm.
Microsteps/ Number of microsteps per full step. Min: 1. Max: 100,000,000.
Full Step
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6.4 Feedback Notes

6.4.1 Encoder and Resolver Support

Some Copley Controls amplifiers are offered in multiple versions to support different types of
encoder or resolver feedback. Some encoder versions support digital quadrature encoders, some
support analog sin/cos encoders, and others support both. Encoder versions normally require
Halls for the commutation of brushless motors. The resolver versions support standard, single
and multiple speed, transmit-type resolvers.

6.4.2 Dual Feedback

Some Copley Controls amplifiers can receive position feedback from sensors on the motor, the
load, or both, through the Primary Feedback channel, a Secondary Feedback channel (multi-
mode port) or both. (Some amplifiers can also operate in certain modes without encoders or
resolvers.)

A drive configured with a multi-mode port can:

e Provide a buffered digital encoder output based on the digital encoder input.

e Provide an emulated digital encoder output based on the analog encoder or resolver
input.

e Provide a second digital encoder input to be used in the dual encoder position mode. In
this mode, an encoder attached to the load provides position loop feedback, and the
motor encoder or resolver provides velocity loop feedback.

A dual-feedback setup is shown below. The amplifier receives feedback from an incremental
motor encoder through the Primary feedback channel. Position (load) encoder feedback comes
through the multi-mode port. The ratio of motor turns to position encoder turns is 1 to 10.

Setup X Setiip

Motor Feedback Load Feedback

1000 | lines = 4000 counts 1000 | lines = 4000 counts
®) No Encoder Loss Detection (® No Encoder Loss Detection
_) Enable Encoder Loss Detection (Ignore Index) (O Enable Encoder Loss Detection (Ignore Index)

") Enable Encoder and Index Loss Detection (O Enable Encoder and Index Loss Detection

Gear Ratio

Motor Turns: 1| Load Turns: 10

<Back Cancel

< Back Cancel
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6.5 Calculate

The Calculate function uses the motor data to calculate initial gains and limits. These can be
modified to fine-tune the amplifier. Follow the steps below:

1. Click to calculate and display settings.

Calculated Amplifier Settings X
Current Loop Cp Gain: 1 =
Current Loop Ci Gain: 0
Peak Current Limit 0.1 A
Continuous Current Limit 0.1 A
I2T Time Limit 1000 ms
Current Loop Offset 0 A
Current Ramp: 0 mA/s
Programmed Current: 0 A
I Loop Command Filter #1: Disabled
I Loop Command Filter #2: Disabled
Velocity Loop Vp Gain: 371
Velocity Loop Vi Gain: 82
Velocity Integral Drain: 0
Velocity Loop Velocity Limit: 0.08 rpm
Velocity Loop Accel., Decel., Fast Stop: 0.03 rps? v

Cancel

2. Verify the peak current limit, continuous current limit, and velocity loop velocity limit. If
one or more of these values seems inappropriate, click Cancel and check: Peak Torque
(or Force), Continuous Torque (or Force), Velocity Limit, and Torque (or Force) Constant.
Correct them if needed. See Rotary Motor Parameters or Error! Reference source not
found.Error! Reference source not found.Linear Motor ParametersError! Reference
source not found..

Error! Reference source not found.If the Motor values are correct but the peak current
limit, continuous current limit, or velocity loop velocity limit values are not optimal for
the application, change these limits during the tuning process.

3. Save the values into amplifier RAM by clicking OK.

NOTE: When loading motor data from a file, if the motor wiring configuration in the motor
file does not match the configuration currently stored in the amplifier, CME prompts for
verification on which configuration to use. Select the file configuration by clicking Yes.
The configuration will be tested as part of Motor Phasing.

4. On the Main screen, click L. to avoid losing the calculated data by saving to flash.
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6.6 Use Specification Data

Fill in the requested fields with information from the datasheet of the motor you are trying to
control.

@ Motor Data _ 0 %
- fi Units
O Use Motor Plate Data Manufacturer: |Infranor
@ Use Specification Data Model: FP00348000k100 @ Metic () English
Number of Poles: 4 Torque Constant:

1.2 |N'm/Apk
Motor Inertia:

100 | | kg cm? v Back emf Constant

108.8| | V/krpm v
Peak Torque:

4.8 N'm v Resistance: 0.01 | ohms

Continuous Torque:

Inductance: 0.01| mH
2.4 N'm v
Velocity Limit 6000 rpm
o | i
Feedback Close
Action Name Description
o Save motor data Saves motor/feedback/brake settings from PC to a file
with .ccmm name extension.
= Restore motor data Restores contents of a .ccm file to PC.
ﬁ Save motor data to flash | Saves motor/feedback/brake settings from PC to
g amplifier permanent flash memory.
Calculate Calculates initial tuning and limit values.
Feedback | Feedback View the Feedback settings
Button
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6.7 Use Motor Plate Data
1. Choose Use Motor Plate Data.

46

Q Motor Data

Ot

() Use Specdification Data

= O X
Rated Speed 0| rpm
Rated Current: 0| Apk
Rated Torque: 0.0001| N'm v (® Metric () English
Power: 0o w
Characterize and Tune
Feedback Close

2. Enter Rated Speed.
3. Enter Rated Current.
4. Enter Rated Torque or Power from the motor label.

Note: The Rated Torque will be defaulted to a minimum value. It should not be 0.
It will be calculated if motor Power is entered.

Parameter

Description

Rated Speed

Speed of the motor at which it produces its rated (maximum)
power, when the specified (rated) voltage is given at its rated
Load.

Rated Current

Maximum safe continuous current of the motor

Rated Torque

Maximum safe continuous torque of the motor

Power

Continuous safe motor power

5. Click Characterize and Tune and follow the instructions in Characterize and Tune.
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6.7.1 Characterize and Tune

@

Steps

Current Loop Auto Tune
Auto Phase

Velocity Loop Auto Tune

Position Loop Auto Tune
Tune and Characterize Complete

Start Stop Close
1. Click Start to start the Current Loop Auto tune.
@ X
0.4
Steps
0.3
Current Loop Auto Tune
Auto Phase ~ 02
Velocity Loop Auto Tune ETRE
Position Loop Auto Tune E —
Tune and Characterize Complete B8
0.1
0.2
03 T T T T T T T T T
00000 00005 00010 00015 00020 00025 00030 00035 00040 00045 0.0050
Time (seconds)
Tuning Current Loop
Measuring Gains
Start Close
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48

2. When the current loop auto tune is complete, it goes to Auto Phase.

Steps

Current Loop Auto Tune
Velocity Loop Auto Tune
Position Loop Auto Tune
Tune and Characterize Complete

Jog Motor to a Safe Location

Use the Jog buttons to move the motor to a location that it can
freely move back and forth a few electrical cycles.

Press next when done.

i <Jog | Jog >

Gear Ratio: 1| Next

Tuning Current Loop
Measuring Gains

Gains: Cp = 44, Ci = 41
Measuring Bandwidth
Bandwidth = 700

Current Loop Tuning Complete

Start

| Close

3. Press <Jog or Jog> depending on which direction you want the motor rotating.
4. Click Next and answer the question(s) that pop up.

Motor Position

If

X

I&X The motor is now in a safe position to be moved a few electrical cycles?

No-
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@ X
Steps
Commanded Motor Phase Angle

Current Loop Auto Tune =
Auto Phase 120 €0
Velocity Loop Auto Tune 150 20
Position Loop Auto Tune 150 ™~y °
Tune and Characterize Complete

210 330

240 o 300
Actual Motor Position: -3324  counts

Tuning Current Loop
Measuring Gains

Gains: Cp = 44; Ci =41
Measuring Bandwidth
Bandwidth = 700

Current Loop Tuning Complete

Starting Motor Wiring Test
Configuring initial settings

Microstepping
Start | | Stop | | Close
Positive Reference X

@ Observe motor motion to verify positive direction.

Motor Wiring X

@ Did the motor move in the direction
you consider positive?

l Yes H No HCanceIl
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@ X
Steps Commanded Motor Phase Angle & Hall States
Current Loop Auto Tune
Auto Phase ® ®
Velocity Loop Auto Tune 120 60
Position Loop Auto Tune
Tune and Characterize Complete ® 180 / 0o @
240 300
® ®

Starting Phase Count Test
Configuring initial settings
MicroStepping

Measuring counts per pole-4092
Counts per rev = 8192

Verifying motor poles = 4

Moving the motor 2 electrical cycles
Verifying 1.0 rev = -8195 counts
Phase Count Test Passed:

Motor Poles = 4

Starting Hall Wiring Test
Microstepping

sart | [ swp | Close |

5. When the auto phase is complete, it goes to Velocity Loop Auto Tune.

@ X
100
Steps
80
Current Loop Auto Tune
Auto Phase 'k
Velocity Loop Auto Tune &
Position Loop Auto Tune &40
Tune and Characterize Complete § el
o
-20 T T T T T T T T T T T T T
000 002 004 008 008 040 042 014 016 018 020 022 024 026 028
Time (seconds) |
FIOVING ThOE mMOTOoY €IECTYICal CYCTIES n
Verifying 1.0 rev = -8195 counts

Phase Count Test Passed:
Motor Poles = 4

Starting Hall Wiring Test
Microstepping
Test Complete. Motor has been properly phased

Tuning Velocity Loop

Setting up open loop test
Testing open loop Step response
Testing closed loop step response
Testing closed loop sStep response

s s | | Cose |
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@

Steps

Current Loop Auto Tune
Auto Phase

Velocity Loop Auto Tune
Position Loop Auto Tune

Tune and Characterize Complete

Velocity (pm)
8

-20 T T T T T T

000 002 004 006 008 010 0.12

Time (seconds) |

014 016 048 020 022 024 026 028

Tuning Velocity Loop

Setting up open loop test

Testing open loop Step response
Testing closed loop response
Testing closed loop response
Testing closed loop response
Testing closed loop step response
Testing closed loop sStep response
Measuring Velocity Loop Gains
Gains: Vp = 99 Vi = 22

Bandwidth = €0 Hz

step
step
step

Setting Position Loop Gains

Tune and Characterize is complete.

Note: You can start your tuning from any of the steps, provided all the other steps above
it have been completed at some point in the past.

@

Steps

Current Loop Auto Tune

Auto Phase
Velocity Loop Auto Tune

Position Loop Auto Tune
Tune and Characterize Complete
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7 DIGITAL INPUTS AND OUTPUTS
7.1 Digital Inputs

Input / Output
Click Input/Output [ i i ‘ on the Main screen. A typical screen is shown below.

Options vary with model and configuration.

@ Input/Output — X

6 Digital Inputs 7-14 Digital Outputs 1-3 Digital Outputs 4-6 Analog IO

Pull Up Pull Down Data Axis Debounce State CAN Node ID
® (O [IN1] | Amp Enable-LO Enables With Clear Faults v 0 Axis A 0/ms Hi
O] (O [IN2]  Not Configured v 0 Axis A 0lms Hi
® (O [IN3] Not Configured v 0 Axis A 0'ms Hi
O] (O [IN4] Not Configured v 0 Axis A 0lms Hi
® (O [IN5] Not Configured v 0| | AxisA 0/ms Hi
® (O [IN6] Not Configured v 0 Axis A 0'ms Hi
* Hold position when limit switch is active Restore Defaults Close
Parameter Description

Pull up +5V Pulls up the group of inputs up to internal +5 V.

Pull down Pulls the group of inputs down to internal signal ground.
Debounce Specifies how long an input must remain stable at a new state before the amplifier
Time recognizes the state. Increase to prevent multiple triggering caused by switch bounce

upon switch closures. Range: 0 to 10,000 mS.

Debounce does not affect inputs that have been configured as PWM, Pulse and
Direction, or Quadrature control inputs.

IN# Select the function for the input.

Axis This option is only available for multi axis drives.

*Hold position | Available in position mode only:

when limit When one or more inputs are configured as a limit switch (NEG Limit-HI Inhibits,

switch is NEG Limit-LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold

active position option prevents any motion while a limit switch is active. This option uses
the Abort Deceleration rate to stop the motor as described in Trajectory Limits.
CAUTION: If the amplifier is switched back to current or velocity mode with
this option selected, the limit switches will no longer function

Restore Restores all inputs and outputs to factory defaults.

Defaults
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7.1.1 Digital Input Functions
Depending on the mode of operation, some inputs may have a predefined function such as

enable or motor temperature sensor. Typically, IN1 is defined as an enable input.

Input Function

Description

LO Enables with reset

AMP Enable- A low input will enable the amplifier.

LO Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A high input will enable the amplifier.

HI Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A low input will enable the amplifier.

A low to High transition will reset the amplifier.

AMP Enable-
HI Enables with reset

A high input will enable the amplifier.
A high to low transition will reset the amplifier.

AMP Enable-LO Enables

A low input will enable the amplifier.

AMP Enable-HI Enables

A high input will enable the amplifier.

Not Configured

No function assigned to the input.

POS Limit-HI Inhibits*

A high input will inhibit motion in positive direction.

POS Limit-LO Inhibits*

A low input will inhibit motion in positive direction.

NEG Limit-HI Inhibits*

A high input will inhibit motion in negative direction.

NEG Limit-LO Inhibits*

A low input will inhibit motion in negative direction.

Reset on LO-HI Transition

A low to high transition of the input will reset the amplifier.

Reset on HI-LO Transition

A high to low transition of the input will reset the amplifier.

Motor Temp HI Disables

A high input will generate a Motor Over Temperature fault.

Motor Temp LO Disables

A low input will generate a Motor Over Temperature fault.

Home Switch Active HI

A high input indicates the home switch is activated.

Home Switch Active LO

A low input indicates the home switch is activated.

Motion Abort Active HI

A high input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier
remains enabled.

Motion Abort Active LO

A low input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier
remains enabled.

High Res Analog Divide Active HI

A high input causes the firmware to divide the level of the analog
input signal by 8.

High Res Analog Divide Active LO

A low input causes the firmware to divide the level of the analog
input signal by 8.

Simulated Absolute Encoder Burst
on LO-HI Transition

Disable simulated encoder output when low. Burst current
position on encoder output on rising edge.

Simulated Absolute Encoder Burst
on HI-LO Transition

Disable simulated encoder output when high. Burst current
position on encoder output on falling edge.

Clear Faults and Event Latch on
LO-HI Transition

Clear faults & event latch on rising edge.

Clear Faults and Event Latch on HI-
LO Transition

Clear faults & event latch on falling edge.
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Abort Move on LO-HI if >N Counts
From Dest in Reg

Abort move on rising edge if further then N counts from
destination position. Number of counts (N) is stored in an
index register identified by bits 8-11.

Abort Move on HI-LO if >N Counts
From Dest in Reg

Abort move on falling edge if further then N counts from
destination position. Number of counts (N) is stored in an
index register identified by bits 8-11.

Encoder Fault- Active HI

Encoder fault input, active high

Encoder Fault- Active LO

Encoder fault input, active low

Trajectory Update on LO-HI | On the low to high transition of this input, the trajectory generator
Transition will generate a previously configured trajectory.
Trajectory Update on HI-LO | On the high to low transition of this input, the trajectory generator
transition will generate a previously configured trajectory.

Count Rising Edges, Save To Reg

Count rising edges of input to indexer register (Register
number identified by bits 8-11).

Count Falling Edges, Save To Reg

Count falling edges of input to indexer register (Register
number identified by bits 8-11).

Amp Disable-HI with AC Removed

For a controlled stop, the AC power is cut, and the amplifier is
disabled with a high input.

Amp Disable-LO with AC Removed

For a controlled stop, the AC power is cut, and the amplifier is
disabled with a low input.

High Speed Position Capture on
LO-HI Transition

High Speed Position Capture on LO-HI Transition

High Speed Position Capture on
HI-LO Transition

High Speed Position Capture on HI-LO Transition

PWM Sync Input

PWM

synchronization
& Regen Settings

input.
|2

Regen Settings

Turn QM Voltage: aql v
Turn OFF Voltage: a6 | v
Resistance: o @
Continuous Power: o) w
Peak Power: o w
Time at Peak Power: 0 ms

Close

Synchronizing PWM Switching Frequency. (For high-speed inputs
only.)
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7.2 Digital Outputs

A typical Digital Outputs screen is shown below.

@ Input/Output - X
Digital Inputs 1-6 Digital Inputs 7-14 || i Digital Outputs 4-6 Analog 10
Axis State
[OUT1] Fault-Active High v Axis A Hi
[OUT2] Not Configured v Axis A Hi
[OUT3] Not Configured v Axis A Lo
) m
* Hold position when limit switch is active Restore Defaults Close

Note: Options vary with models and configurations.

7.2.1 Digital Output Functions

Output Function

Description

Not Configured

No function. Output remains Hi/Off.

Fault Active High

Output goes Hi/Off when one or more faults are detected.

Fault-Active Low

Output goes Lo/On when one or more faults are detected.

Brake-Active High

(Brake hold) Output goes Hi/Off to activate the brake.

Brake-Active Low

(Brake release) Output goes Lo/On to activate the brake.

PWM Sync Output

The PWM synchronization output.

Custom Event

See Custom Triggered Event Output

Custom Trajectory Status

See Custom Trajectory Status Triggered Output.

Custom Position Triggered Output

See Custom Position Triggered Output.

Program Control Active High

Output state controlled by CVM or external program.

Program Control Active Low

Output state controlled by CVM or external program

External Regen Active High

See Output Regen Settings

External Regen Active Low

See Output Regen Settings
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7.2.2 1ID Switch and Network LED SLI

@ Input/Output -

Digital Tnputs 1-12  Digital Tnputs 13-25 Digital Outputs 1-6 |

Axis State

[OUT7]  Not Configured v AXSA v
[OUT8]  Not Configured v Axis A ¥
[OUT9]  SLIMOSI (Master Output Slave Input) Axis A
[OUT10] Si1CiK (Clock)
[OUT11] 5L S5 (Slave Select) Axis A
[OUT12] Not Configured v |AxsA v

* Hold position when limit switch is active
[“] Use Switch and LED Interface (SLI) Restore Defaults

Close

Uncheck the box to disable Network ID switch and LED to get additional I/O (3 outputs, 1

input).

7.3 Custom Event Triggered Output

Digital outputs can be configured for one or more bits in the Event Status (faults,

warnings, and status).

1. Choose Custom Event for the output configuration, then click Configure Custom to

open the Event Triggered Output screen.

Axis State

[OUT1] [Custom Event v Axis A ~  Off

Configure Custom
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Event Triggered Output

[ Amplifier Fault

|:] Amp Over Temperature
[] Motor Phasing Error
[] Feedback Error

[] Motor Over Temp
["] Under Voltage

[] over Voltage

[] short Circuit

[] current Limited

[] voltage Limited

<

[] Latch Output

Clear

v
>

(O Output Active High @) Output Active Low

Cancel Help

2. Select one or more events from the list. Selections are OR’ed together, so that any event
will cause the output to go active. The Clear button clears all selections.

Choose Output Active High/Off or Output Active Low/On.
4. To latch the output, set the Latch Output option.

Latching an output does not eliminate the risk of unexpected motion
with non-latched faults.

DANGER

Associating a fault with a latched, custom-configured output does not latch
the fault itself. After the cause of a non-latched fault is corrected, the

amplifier re-enables without operator intervention. In this case, motion
may restart unexpectedly.

Failure to heed this warning can cause equipment damage, injury, or death.

5. Click OK to save changes to amplifier RAM and close the screen.

Event

Description

Amplifier Fault

A latched fault is active.

Amp Over Temperature

Motor Phasing Error

Feedback Error

Motor Over Temp

Under Voltage

Over Voltage

Short Circuit

For descriptions of these fault events, see Fault Descriptions.Error!
Reference source not found.

Current Limited

The current output is being limited by the I2T Algorithm or a latched
current fault has occurred.

Voltage Limited

Current loop is commanding the full bus voltage to control current.
Commonly occurs when the motor is running as fast as the available
bus voltage will allow.
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Positive Limit Switch

Axis has contacted positive limit switch.

Negative Limit Switch

Axis has contacted negative limit switch.

Amp Disabled by Hardware

Amplifier enable input(s) is not active.

Amp Disabled by Software

Amplifier is disabled by a software command.

Attempting to Stop Motor

The amplifier, while in velocity or position mode, has been disabled.

In velocity mode, amplifier is using the Fast Stop Ramp described in
Velocity Loop Limits. In position mode, the amplifier is using the Abort
Deceleration rate described in Trajectory Limits.

The output remains active until the amplifier is re-enabled.

Motor Brake Active

Motor brake activated.

PWM Outputs Disabled

The amplifier's PWM outputs are disabled.

Positive Software Limit

Actual position has exceeded the positive software limit setting.
See Homing.

Negative Software Limit

Actual position has exceeded the negative software limit setting.
See Homing

Following Error

Following error has reached programmed fault limit.
See Following Error Faults

Following Warning

Following error has reached programmed warning limit.
See Following Error Faults

Position has Wrapped

The position counters have exceeded the maximum range of
-23t — 231-1 and have wrapped. Normal amplifier operation is not
affected.

Velocity Limited

The velocity command (from analog input, PWM input, or position loop)
has exceeded the velocity limit. See Velocity Loop Limits.

Acceleration Limited

In velocity mode, motor has reached an acceleration or deceleration
limit that was set as described in Velocity Loop Limits.

Pos Outside of Tracking | The following error has exceeded the programmed value.

Window See Position and Velocity Tracking Windows

Home Switch Active Axis has contacted the home limit switch.

In Motion The motor is moving, or it has not yet settled after a move. The amplifier
is settled when it comes within the position tracking window and stays
there for the tracking time at the end of a move. Once this bit is set, it
remains set until a new move is started.

Vel Outside of Tracking | Difference between target and actual velocity has exceeded the window.

Window See Position and Velocity Tracking Windows.

Phase not Initialized

Amplifier is using Phase Initialization function and phase is not
initialized.

Command Input Fault

PWM or other command signal (e.g., EtherCAT master) not present. If
Allow 100% Output option is enabled by a setting Bit 3 of Digital Input
Command Configuration this fault will not detect a missing PWM
command.

7.3.1 Latched vs. Non-Latched Custom Event
An output that is configured for a custom event can be latched or non-latched.

If a non-latched output goes active, it will go inactive as soon as the last of the selected events
is cleared. If a latched output goes active, it remains active until at least one of the following
actions has been taken:

e Reset or power-cycle the amplifier.

e Cycle (disable and then enable) an input that is configured as Enable with Clear Faults or
Enable with Reset.

e Open the Control Panel and press Clear Faults or Reset.
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The latched/non-latched behavior of an output configured as a custom event is independent of
the drive’s latched/non-latched fault. Consider the following example:

OUT3 is configured as a custom event: under voltage and latched, but the Under Voltage
fault on the Configure Faults screen is set to non-latched. The table below shows the
difference in behavior between the output and the drive’s fault.

Condition Drive ouT3
Under voltage condition | Disables PWM outputs, and reports | Goes to active state
occurs under voltage faults

Under voltage condition
is corrected

Under voltage fault is not reported
and PWM outputs are enabled

Stays active

7.4 Custom Trajectory Status Triggered Output

Digital outputs can be configured for one or more events in the Trajectory Status.

1. Choose Custom Trajectory Status for an output and then click Configure Custom to
open the Trajectory Status Triggered Output screen.

[OUT 2] |Custom Trajectory Status

[ Configure Custom J

v Hi a

Trajectory Status Triggered Output X

[ ] Homing Error
[ ] Referenced (Homed)
[ ] Homing In Progress

[ ] Move Aborted

[ ] Camming Buffer Error

D Trajectory Generator Running

() Output Active High (@) Output Active Low

Cancel

2. Select one or more events from the list. Selections are OR’ed together, so that any event
will cause the output to go active.

Status Description
Homing Error Activate output if an error occurred in the last homing attempt
Referenced (Homed) Activate output if the most recent homing attempt was successful
Homing in Progress Activate output when a homing move is in progress
Move Aborted Activate output if move is aborted
Trajectory Generator Activate output while trajectory generator is generating a move
Running
Camming Buffer Error A camming buffer error has occurred
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3. Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4. Click OK to save changes to amplifier RAM and close the screen.

7.5 Custom Position Triggered Output

1. Choose Custom Position Triggered Output for an output and then click Configure
Custom to open the In Position Triggered Output screen.

[OUT 2]  Custom Position Triggered Output v Lo *
[ Configure Custom
Position Triggered Output X

Configuration
(®) In Position Window

() Trigger At Position
(") Trigger Positive Motion

(:) Trigger Negative Motion

(O Output Active High (®) Output Active Low

Upper Position: 0| counts

Lower Position: 0| counts
(® Use Actual Position () Use Limited Position

Cancel

2. Select one of the configurations described below and enter appropriate values for the
parameters.

Configuration Description and Parameters

In Position Window | Activates the output while the axis is in the window between the programmed
Upper and Lower positions.

Trigger at Position Activates the output for the programmed Time when the axis travels through
the programmed Position.

Trigger Positive Activates the output for the programmed Time when the axis travels in the
Motion positive direction through the programmed Position.
Trigger Negative Activates the output for the programmed Time when the axis travels in the
Motion negative direction through the programmed Position.

3. Choose Output Active High to have the output go high when active or Output Active Low to
have the output go low when active.

4. In stepper mode with no encoder, choose Use Limited Position. Otherwise choose Use
Actual Position.

5. Click OK to save changes to amplifier RAM and close the Custom Output Configuration screen.
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7.6 Output Regen settings
& Regen Settings [i_z-,l

Regen Settings

Turn OM Voltage: aql v

Turn OFF Yoltage: as | v
Resistance: o
Continuous Power: o) w

Peak Power: o w

Time at Peak Power: 0| ms

Cloze

7.7 Synchronizing PWM Switching Frequency

In some situations, such as when sampling small analog signals, it is desirable to synchronize
the PWM switching frequency among multiple amplifiers. In these cases, one amplifier serves as
a master for one or more slave amplifiers. The PWM sync output of the master sends a signal
that is received as a PWM sync input by each slave. To configure this, an output of the master
must be configured as PWM Sync Output and one input on each of the slaves must be configured
as PWM Sync Input.

[OUT 4] |PWM Sync Qutput -

[IN4] |PWM Sync Input =

7.8 Analog I/0

A typical Analog I/O screen is shown below.

Note: Only products with an analog output will have this option.
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@ Input/Output - X

Digital Inputs 1-6 Digital Inputs 7-14 Digital Outputs 1-3 Digital Outputs 4-6

- Analog Motor Temperature Sensor

Limit: 0 mV

Actual Voltage: = 4166 mV

Analog Output-

Mode: Manual v
Programmed Value: 0/ mVv
* Hold position when limit switch is active Restore Defaults Close

7.8.1 Analog Motor Temperature Sensor
Enter a voltage limit in mV. Fault will occur when voltage is above limit for positive values. For

fault set below limit enter the limits value as a negative value. Actual voltage is the sensor
reading in mV.

Analog Motor Temperature Sensor

Limit: 0 mv

Actual Voltage: mV

7.8.2 Analog Output

The Analog Output has three modes of operation - Manual, Actual Current and Actual Velocity.
When Manual is chosen, the output is set to the programmed value, +/- 5V, entered in mV.

Mode: Manual v

Programmed Value: 1 mV

When Actual Current is chosen, the output value is proportional to the actual motor current.
Mode:  Actual Current «

Analog Output Value: 1mVv
Actual Current: 0.01 A
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When Actual Velocity is chosen, the output value is proportional to the actual motor velocity.
Mode: |Actual Velocity «

Analog Output Value: mV
Actual Velodity: rpm

63 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Command Inputs

8 COMMAND INPUTS
8.1 Analog Command Settings

Analog Command

Click the Analog Command button on the Main screen.

@ Analog Command = X

Scaling: 20| A =10V
Dead Band: 0 mVv
[ ] Invert Command
Offset
Measure 0 mv
Offset: 0 mv
Close

Analog Description

Reference

Parameter

Scaling Current mode: output current produced by +10 Vdc of input.

Range: 0 to 10,000,000 A. Default: Peak Current value.
Velocity mode: output velocity produced by +10 Vdc of input.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.
Position mode: position change (counts or mm) produced by +10 Vdc of input.
Range: 0 to 1,000,000,000 counts.
Default: 1 Revolution of a rotary motor or 1 pole pair distance for a linear motor.
For more information, see Scaling
Dead Band Sets dead band. Range: -10,000 to 10,000 mV. Default: 0.
For more information, see Dead Band

Invert Command | Inverts polarity of amplifier output with respect to input signal.

Offset (Current and Velocity modes only.) Used to offset input voltage error in an open
loop system. Not recommended for use when the amplifier is part of a closed loop
system.

Range: -10,000 to 10,000 mV. Default: 0. For more information, see Offset
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8.1.1 Analog Command Notes

The amplifier can be driven by an analog voltage signal through the analog command input. The
amplifier converts the signal to a current, velocity, or position command as appropriate for
current, velocity, or position mode operation, respectively. The analog input signal is
conditioned by the scaling, dead band, and offset settings.

8.1.2 Scaling

The magnitude of the command generated by an input signal is proportional to the input signal
voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal command
range for any given input voltage signal range.

For example, in current mode, with default scaling, +10 Vdc of input generates a command
equal to the amplifier's peak current output; +5 Vdc equals half of that.

Scaling could also be useful if, for example, the signal source generates a signal range between
0 and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this case, scaling
allows the amplifier to equate +7.5 Vdc with the amplifier’s peak current (in current mode) or
maximum velocity (in velocity mode), increasing the resolution of control.

8.1.3 Dead Band

To protect against unintended response to low-level line noise or interference, the amplifier can
be programmed with a “"dead band” to condition the response to the input signal voltage. The
amplifier treats anything within the dead band ranges as zero and subtracts the dead band value
from all other values. For instance, with a dead band of 100 mV, the amplifier ignores signals
between -100 mV and +100 mV, and treats 101 mV as 1 mV, 200 mV as 100 mV, and so on.

200
100 Dead Band
e v Y
5
o
-100
-200
-200 -100 0 100 200

Input

8.1.4 Offset

To remove the effects of voltage offsets between the controller and the amplifier in open loop
systems, CME provides an Offset parameter and a Measure function. The Measure function takes
10 readings of the analog input voltage over a period of approximately 200 ms, averages the
readings, and then displays the results. The Offset parameter allows the user to enter a
corrective offset to be applied to the input voltage.

The offset can also set up the amplifier for bi-directional operation from a uni-polar input voltage.
An example of this would be a 0 to +10 Vdc velocity command that had to control 1000 rpm
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CCW to 1000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and Offset set to -
5V. After this, a 0 Vdc input command would be interpreted as -5 Vdc, which would produce
1000 rpm CCW rotation. A +10 Vdc command would be interpreted as +5 Vdc and produce 1000
rpom CW rotation.

8.1.5 Monitoring the Analog Command Voltage
The analog input voltage can be monitored in the Control Panel and in the Scope Tool. The
voltage displayed in both cases is after both offset and deadband have been applied.

8.1.6 Analog Command in Position Mode

The Analog Position command operates as a relative motion command. When the amplifier is
enabled the voltage on the analog input is read. Then any change in the command voltage will
move the axis a relative distance, equal to the change in voltage, from its position when enabled.
To use the analog position command as an absolute position command, the amplifier should be
homed every time it is enabled. The Homing sequence may be initiated by CAN, ASCII serial, or
CVM Indexer program commands.

8.2 PWM Input Settings

. PWM Command .
Click the PWM Command button on the Main screen.

& PWM Command = X
Scaling: O| A at 100% duty cycle
Input Type:

(® 50% Duty Cycle () 100% Duty Cycle

Options:
[ ] Invert PWM Input
[ ] Allow 100% Output

Invert Sign Input
Parameter Description
Scaling Current mode: output current at 100% duty cycle.

Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity at 100% duty cycle.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

PWM Input Type | One wire 50% or two wire 100% with direction.

Options Invert PWM input: Inverts the PWM logic.

Allow 100% output: Overrides the 100% command safety measure.
See Failsafe Protection from 0 or 100% Duty Cycle Commands

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional
input.
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8.2.1 50% Duty Cycle (One-Wire)
The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown
below, a 50% duty cycle produces zero output from the amplifier. Increasing the duty
cycle toward 100% commands a positive output and decreasing the duty cycle toward
zero commands a negative output.

—-s——  Decreasing Duty Cycle Increasing Duty Cycle

RN

50 % Duty Cycle

Amp”fier Output [o I I I

Max -

The command can be inverted so that increased duty cycle commands negative output
and vice versa.

8.2.2 100% Duty Cycle (Two-Wire)

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the
other input takes a DC level that controls the polarity of the output. A 0% duty cycle
creates a zero command, and a 100% duty cycle creates a maximum command level.
The command can be inverted so that increasing the duty cycle decreases the output
and vice versa.

100% 100%
Duty Cycle Duty Cycle

o NN

Direction Input

Amplifier Output

8.2.3 Failsafe Protection from 0 or 100% Duty Cycle Commands

In both formats, the amplifier can be programmed to interpret 0 or 100% duty cycle as
a zero command, providing a measure of safety in case of controller failure or cable
break.
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8.3 Digital Position Input Settings

Digital | t
Click the Digital Input button bbinticy on the Main Screen.

@ Digital Input — >
g p

Input Config

Increment Position on:
(® Rising Edge

) Pulse Up / Pulse Down () Falling Edge
7) Pulse Up / Pulse D O Falling Ed
() Quadrature

O pwM

Stepping Resolution
1 Input Pulses = 1| Output Counts

[ ]Invert Command

Close
Parameter Description
Control Input Pulse and Direction: One input takes a series of pulses as motion step
commands, and another input takes a high or low signal as a direction
command.

Pulse Up / Pulse Down: One input takes each pulse as a positive step
command, and another takes each pulse as a negative step command.
Quadrature: A/B quadrature commands from a master encoder (via two
inputs) provide velocity and direction commands.

PWM: The input takes a fixed frequency with variable pulse width.

Increment position | Rising Edge: Increment position on the rising edge of the input pulse.

on Falling Edge: Increment position on the falling edge of the input pulse.

Stepping Resolution Input Pulses: Number of Input Pulses required to produce output counts.
Range: 1 to 32,767. Default: 1.

Output Counts: Number of Output Counts per given number of input pulses.
Range: 1 to 32,767. Default: 1.

Invert Command When selected, inverts commanded direction.

8.3.1 Pulse Smoothing

In digital position mode, the amplifier’s trajectory generator can be used to create
trapezoidal profiles, with programmed acceleration, deceleration and velocity, from a
simple pulse train or burst of pulses. To bypass the trajectory generator while in digital
or analog position modes, set the maximum acceleration to zero. The only limits in
effect will now be the velocity loop velocity limit and the current limits. (Note that
leaving the maximum acceleration set to zero will prevent other position modes from
operating correctly.)
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8.3.2 Pulse and Direction

In pulse and direction format, one input takes a series of pulses as motion step
commands, and another input takes a high or low signal as a direction command, as
shown below.

Pulse Input J—|_|—|_|—|_| ML

Direction Input =~ — m—————— e = = = - - - - - - - - - -- -

Velocity /
Command =t m e mm mm - e . .. e —— - e e = e e e e = f

The amplifier can be set to increment position on the rising or falling edge of the signal.
Stepping resolution can be programmed for electronic gearing.

8.3.3 Count Up/Count Down

In the count up/count down format, one input takes each pulse as a positive step
command, and another takes each pulse as a negative step command, as shown below.

Up Input J_|_|_|_|_ﬂ

Velocity /
Command =l = = =@ 0 & & e e e . e - s e - == _/7

The amplifier can be set to increment position on the rising or falling edge of the signal.
Stepping resolution can be programmed for electronic gearing.

8.3.4 Quadrature

In quadrature format, A/B quadrature commands from a master encoder provide
velocity and direction commands, as shown below.

69 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Command Inputs

Alnput

B Input

Velocity /
Command @ =——d = = = m . e . - P—— e - = - == e == - _/___

The ratio can be programmed for electronic gearing.

8.4 Software Programmed Input Settings

These settings can be saved to flash to allow default conditions to be set and used when
the amplifier is powered up or reset.

8.4.1 Programmed Position

Programmed Position

Click the Programmed Position button on the Main screen.
@ Programmed Comma... = X
Move: Type:
(® Relative (® Trap
() Absolute (O S Curve
Distance: O| counts
Close
Setting Description
Move Relative or Absolute.
Type Trap or S-Curve.
Distance Move distance (relative) or location (absolute)

8.4.2 Programmed Velocity

Pr =d Veloci
Click the Programmed Velocity button | it on the Main screen.
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@ Programmed Command — X

Programmed Velocity:

0 rpm

Close

Potential for unexpected movement.

If the Programmed Velocity is set to values other than 0,
the motor will move after power-up or reset if the amplifier
is hardware enabled.

DANGER Failure to heed this warning can cause equipment
damage, injury, or death.
Setting Description
Programmed Move velocity. Units: rpm (rotary) or mm/s (linear).
Velocity

8.4.3 Programmed Current

Programmed Current

Click the Programmed Current button on the Main screen.

Q@ Programmed Command - X

Programmed Current:

Current Ramp:

3 A
5000 | mA/s

Close

Potential for unexpected movement.

If the Programmed Current is set to values other than O,
the motor will move after power-up or reset if the amplifier
is hardware enabled.

DANGER Failure to heed this warning can cause equipment
damage, injury, or death.
Setting Description
Programmed Current applied during the constant velocity portion of the move. Units: A.
Current
Current Ramp Acceleration/deceleration current. Units: mA/s.
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9 NETWORK CONFIGURATION
9.1 CANopen Network

A CANopen network can support up to 127 nodes. Each node must have a unique and valid
seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be used when the
amplifier is serving as a CME serial port multi-drop gateway.)

1. Verify that the CAN network has been cabled and terminated as per amplifier

documents.
. . . CAN Configuration . .

2. Click CAN Configuration to open the CAN Configuration screen. (If
CAN is not the Position Loop Input, choose Amplifier>Network Configuration
instead).

CAN Configuration X
Input Mapping
Bit Rate: 1Mbit/s v Number of Inputs: |0

Address Configuration

Use Switch Bit O: | None Switch
[] Use Inputs Bit 1: | None Switch
[y Bit 2: | None Switch
Bit 3: | Non Switch
Switch Value: 0 o AL
Input Lines Value: Bit 4: | None Switch
0 ned Value:
Programmed Value: Bit 5: I'None Switch
New Resulting Address: 0
Bit 6: | None Switch
Heartbeat Time: 0 ms
Node Guard Time: 0 ms Clear
Life Time Factor: 0

The amplifier must be reset for the new settings to take affect.

Save & Reset Save & Close Cancel Help

3. Choose a Bit Rate and choose any combination of address sources (Switch, Inputs,
and Programmed Value). The address is the sum of the values from these sources.

4. For each source selected, perform the additional steps described below.

Source Additional Steps

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 - Bit 3 of CAN
address.)

Use Inputs Enter Number of Inputs, then choose inputs to represent each CAN
address bit.

Use Programmed Enter the Programmed Value.

Value
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5. Click Save & Reset to save changes to amplifier flash, close the screen, and reset
the amplifier. Click Save & Close to save changes to amplifier flash without
resetting.
NOTE: Address and bit rate changes take effect only after power-up or reset.

9.2 MACRO Network

A Delta Tau PMAC card can hold up to four MACRO IC's, each of which is a master on a MACRO
ring. Each master IC can address 16 stations (nodes, slaves), enabling the addressing of up to
64 devices on a ring. Of these, 32 can be motion devices such as Xenus XML. A node address
is an 8-bit value with bits 7-4 addressing the master IC and bits 3-0 addressing the slave.
XML switch S1 is set to select the master IC to which the Xenus will be linked. The four possible
values for this setting are 0,1,2, and 3.
As a MACRO station or node the XML has eight available addresses as a motion control device.
These are 0,1,4,5,8,9,12, & 13.
1. Verify the S1 and S2 switch settings.
2. Select Amplifier-Network Configuration from the CME Main Screen to open the
MACRO Configuration screen as shown in the following example.

MACRO Configuration X

Master Address:

Slave Address:

Scaling Input Command: 0.01 A
Heart Beat Time Out: 0 ms
Home Status Bit:

() Use Motor Encoder Index
(®) Use Home Input

Auxiliary Data Registers
First: Digital Input v

Second: ' Analog Input v

[[] Enable Position Output Scaling
[] Active Network Required for Amp to Enable

[[] Enable MACRO Network Synchronization

Current Loop Freguency: 15 | kHz

Close

Parameter Description
Scaling Input Current mode: output current produced by +10 Vdc of input.
Command Range: 0 to 10,000,000 A. Default: Peak Current value.
Velocity mode: output velocity produced by +10 Vdc of input.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.
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Heart Beat Time Out | The frequency at which the drive will produce heartbeat messages. This
parameter may be set to zero to disable heartbeat production.

Home Status Bit Use Motor Encoder index: Return the primary encoder index state in
the home status bit of the MACRO status word.

Use Home Input: The state of any general purpose input configured as
a home input will be returned in the home status bit of the MACRO status

word.
Auxiliary Data Defines what type of additional data is transmitted in the Auxiliary data
Registers registers of every MACRO response message.

First Register: Digital input Value, Secondary Analog Input Value.
Second Register: Analog Input, Motor Encoder, Position Encoder.

Enable Position When selected, position data sent over the MACRO network is shifted up
Output Scaling 5 bits to be compatible with Delta-Tau controllers.

Enable MACRO

Network o Allows the drive’s PWM frequency to be adjusted to allow synchronous
Synchronization operation with the MACRO ring. Note that changing the PWM Frequency
Current Loop will affect the current loop tuning. Therefore, current loop tuning will need
Frequency to be checked.

Active Network If selected, drive will not enable if network is not active.

Required for Amp to

Enable

9.3 EtherCAT Network

An EtherCAT network enables high-speed control of multiple axes while maintaining tight
synchronization of clocks in the nodes. Data protocol is CANopen over EtherCAT (CoE) based on
DSP-402 for motion control devices.

Stations on EtherCAT are automatically addressed by their bus location. The first drive on the
network is station address -1. The second is -2, and so on.

As an alternate to the default addressing, switches S1 and S2 may be used to program a station
alias. The default address and station alias are always available. If the switch-based station alias
is used, it is the responsibility of the user to ensure that each drive has a unique station alias.
EtherCAT Address (Station Alias)

1. View the S1 and S2 switch settings on the drive.

2. Verify the S1 and S2 switch settings select Amplifier-Network Configuration from
the CME Main Screen to open the EtherCAT Settings screen as shown in the
following example.

@) EtherCAT Settings X

S1:
S2:
Resulting Device ID: 0
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10 FAULTS
10.1 Overview

10.1.1 Latched vs Non-latched Faults
When a fault is configured to be latched, the fault can only be cleared after the fault has
been corrected and at least one of the following actions has been taken:
e Power-cycle the amplifier

e Cycle (disable and then enable) an input that is configured as
Enable with Clear Faults or Enable with Reset

e Open the Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus

A non-latched fault will be cleared when the fault condition has been removed. This can
occur without operator intervention.

DANGER Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-
enables the PWM output stage without operator intervention. In this
case, motion may re-start unexpectedly. Configure faults as latched
unless a specific situation calls for non-latched behavior. When using
non-latched faults, be sure to safeguard against unexpected motion.
Failure to heed this warning can cause equipment damage,
injury, or death.

10.1.2 Example

The drive’s temperature reaches the fault level. The drive reports the fault and disables
the PWM output. Then, the drive temperature falls below the fault level.

Non-latched fault operation:

The fault is cleared and the amplifier's PWM outputs are enabled without operator
intervention.

Latched fault operation:
The fault remains active and the drive’s PWM outputs remain disabled until the faults are
cleared as described above.
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1. Click the Configure Faults button

Configure Faults

@ Fault Configuration X

Latched Faults

Short Circuit

Amp Over Temperature

Motor Over Temperature

[] Over Voltage

[] Under Voltage

Feedback Error

[] Motor Phasing Error

Following Error

[] Command Input Lost

[] Motor Wiring Disconnected

[]STO Active

Optional Faults

[ ] Over Current (latched)

Restore Defaults

Cancel

Help

2. Select the faults to latch. See Fault Descriptions.

Faults

on the Main screen.

3. Click OK to close screen and save changes to amplifier RAM.

L

4. On the Main screen, click Save to Flash "' to avoid losing the changes.

10.2 Fault Descriptions

Note: The list of faults may vary with amplifier model.

Fault Description

Fault Occurs When...

Fault is Corrected When...

*Amp Over

Temperature

Amplifier's internal temperature
exceeds specified temperature.

Amplifier's internal temperature
falls below specified temperature.

Motor Phasing Error

Encoder-based phase angle does not
agree with Hall switch states. This fault
can occur only with brushless motors
set up using sinusoidal commutation. It
does not occur with resolver feedback or
with Halls correction turned off.

Encoder-based phase angle
agrees with Hall switch states.
See Troubleshoot Manual Phase
w/ Encoder and Halls

*Feedback error

Over current condition detected on
output of the internal +5 Vdc supply
used to power the feedback.

Encoder power returns to
specified voltage range.
Feedback signals stay within

specified levels.
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Faults

Resolver or analog encoder not

connected or levels out of tolerance.

Differential signals from incremental
encoder not connected.

Differential signals connected.

*Motor Over Temp

Motor over-temperature switch changes
state to indicate an over-temperature
condition.

Temperature switch changes back
to normal operating state.

Under Voltage

Bus voltage falls below specified voltage
limit.

Bus voltage returns to specified
voltage range.

Over Voltage

Bus voltage exceeds specified voltage
limit.

Bus voltage returns to specified
voltage range.

*Following Error

User set following error threshold

exceeded.

See Following Error Fault Details

*Short Circuit Detected

Output to output, output to ground,
internal PWM bridge fault.

Short circuit has been removed.

Command Input Lost

PWM or other command signal not

present.

Command signal restored.

Over Current (Latched)

Output current I2T limit has been

Amplifier is reset and re-enabled.

exceeded.
Motor Wiring | The drive detects that it cannot push | The motor is reconnected.
Disconnected current through the motor windings
STO Active STO Activated for safe torque off STO is deactivated and fault is

cleared

*Latched by default.
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11 MOTOR PHASING
Auto Phase

The examples in this chapter show amplifier operating modes and motor feedback
configurations. Some screens and choices may vary from those described here.

11.1.1Auto Phase Example: Servo Amplifier

NOTE: The following steps show Auto Phase with a brushless rotary motor, digital Halls, and an
incremental quadrature encoder. Screens vary for other configurations.

1. Verify that the Enable Input is active and that HV or AC power is applied.

&)
2. Click Auto Phase - to open the Auto Phase wizard.

@} Auto Phase X

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: -4 counts

Release Brake Skip = Cancel

3. Move the motor in the direction to be considered positive
OR

If you cannot move the motor, click Skip (you will confirm motor direction later).

NOTE: If an output is configured as a brake you can temporarily release the brake by holding
down the Release Brake button. The brake will be reactivated when you release the button.
Warning if working with vertical axis releasing the Brake may cause system to drop!
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4. Click Next to go to the Motor Wiring Setup step:

@ Auto Phase X
Motor Wiring Setup Commanded Motor Phase Angle
2 2 20
The software will now micro step the motor. 120 60
Make sure the motor is free to move. 150 20
Press Start when ready.
180 0
Auto Phase Current: 0,12 A 210 330
240 200
&0
Increment Rate: 90 | elecdegfs
Motor Actual Position: 0 counts
Stop
Ready
< Back Next > Cancel

Activate the Enable Input.

Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping,
Test Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and microstepped
through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for confirmation of
correct motor direction.

If the step fails, see Troubleshooting the Auto Phase Problems.

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp and
Ci values may produce current loop oscillation, evidenced by an audible high frequency squeal
during auto phasing.

7. Click Next to go to the Phase Count Test step.
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@ Auto Phase X
Phase Count Test Commanded Motor Phase Angle
The software will now micro step the motorin 56 90 b
the negative direction. Make sure the motoris 2=l a0
free to move. Press Start when ready. /
180 ]
Auto Phase Current: 2.79 |A 210 220
240 . 200
Increment Rate: 90 elec deg/s 2
Move Distance: 4 elec Cydes Actual Motor Position: 0 counts
Ready
Stop
rC tion Setti =]
oofigation Setings | < Back Skip > Cancel
counts per rev 8000 }
|
Poles 8;

8. Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

Phase Counts X

[ T ! Observe motor motion and verify that it

& moves 1 turn(s) before any gearing.

9. When you are ready to observe motion, click OK.

When motion is complete the prompt will be displayed:

Phase Counts X

Did motor move 1 turn(s)?

No

If motor did not turn 1 full turn, click No and see Phase count test.
If motor turned 1 full turn, click Yes.

10. For a resolver (-R) version of a Copley Controls amplifier, skip to Step 12.
For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen.
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@

Hall Wiring Setup

The software will now micro step the motor.

Make sure the motor is free to move.

Press Start when ready.

Auto Phase Current: 279| A

Increment Rate: 90 | elecdegfs
Start Stop

Hall Offset: 0 deg

Ready

‘.3 Auto Phase

Feedback Phase Angle Setup

< Back

The software will now micro step the motor.

Make sure the motor is free to move.
Press Start when ready.

Auto Phase Current: 29 A

Stop
Feedback Offset 0 deg
Feedback Angle 314 deg
Motor Actual Position: 1742 counts

Commanded Motor Phase Angle
&Hall State

120 60
Wi w0 [l

240 300

rHall States -

u v w

Lo Lo Hi

Finish Cancel

11. Click Start to begin the Halls wiring setup. The message area displays the messages:
Microstepping. Test Complete. Motor has been properly phased.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move. As
the motor moves the Hall lines are decoded for proper commutation.

If the step fails, see Halls wiring setup.

12. For a resolver (-R) version of a Copley Controls amplifier, click Next to open the
Resolver Phase Angle Setup screen.

X

Feedback angle in red. Commanded
motor phase angle in black.

120 60
180 0
240 300
Ready
< Back Finish Cancel

13. Click Start to start the resolver phase angle setup. The message area displays status
messages.

14. Click Finish to close the screen and save values to flash memory
OR to close the screen without saving changes, click Cancel.

15. If the Auto Phase algorithm does not produce desired results, try adjusting the Auto
Phase Current and Increment Rate values, using the guidelines in
Tips for Auto Phase Current and Increment Rate.

16. If desired results are not obtained, or to confirm results, proceed to Manual Phase.
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11.1.2 Auto Phase Example: Stepper Amplifier, No Encoder
1. Verify that the Enable Input is active and that HV power is applied.

2. Click Auto Phase @ to open the Auto Phase Motor Direction Setup screen.

Q Auto Phase

Motor Direction Setup

Make sure the motor is free to move. Move motor and observe direction.
Motor direction can be changed by clicking Invert Motor output check box.

Velodty 0| rpm Ready
Acceleration 0 | rps?
Deceleration 0 rps2
Move NEG
[] Invert Motor Output oK Cancel

3. Hold down Move POS to move the motor in the direction considered positive and
observe the direction of movement.
If the motor does not move see Troubleshooting the Auto Phase Problems.

4.

If the motor moved opposite the direction that you wish to program as positive, click
Invert Motor Output.

5. Click OK to save the direction setting.

11.1.3 Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode

1. Verify that the Enable Input is active and that HV power is applied.

2. Click Auto Phase O to open the Auto Phase Motor Direction Setup screen.
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Q Auto Phase

Motor Direction Setup

Motor Actual Position:

Release Brake

Move the motor in the direction that you want
to be positive. Press Next when done.

0 counts

Skip >

Cancel

3. Move the motor in the direction you wish to be considered positive.

4. Activate the Enable Input.

5. Click Next to open the Auto Phase Motor Wiring Setup screen.

Q Auto Phase
Motor Wiring Setup
The software will now micro step the motor.

Make sure the motor is free to move.
Press Start when ready.

Auto Phase Current: 0.12| A

Increment Rate: 90 | elec degfs

Stop

X

Commanded Motor Phase Angle

Motor Actual Position: 0 counts

Ready

< Back Next > Cancel

6. Click Start to begin motor wiring setup with default values.
After successful motor wiring setup, the message “Test Complete” appears.

7. Click Finish to close the screen and save values to flash memory.

11.1.4 Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode

83

1. Verify that the Enable Input is active and that HV power is applied.
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2. Click Auto Phase O to open the Auto Phase Motor Direction Setup screen.

@ Auto Phase X

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press Next when done.

Motor Actual Position: -4 counts

Release Brake Skip = Cancel

3. Move the motor in the direction you wish to be considered positive.

4. Activate the Enable Input.
5. Click Next to open the Auto Phase Motor Wiring Setup screen.

@ Auto Phase X
Motor Wiring Setup Commanded Motor Phase Angle
The software will now micro step the motor. 120 P e

Make sure the motor is free to move. 150 20
Press Start when ready.
o

Auto Phase Current: 0,12 A 210 330
240 200
270

Increment Rate: 90 | elec deg/s

Motor Actual Position: 0 counts

Stop
Ready
< Back Next > Cancel

6. Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping,
Test Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails, see Troubleshooting the Auto Phase Problems

NOTE: If incorrect values were entered for inductance and resistance, the
calculated Cp and Ci values may produce current loop oscillation, evidenced by an
audible high frequency squeal during auto phasing.Click Next to open the Auto
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Phase Count Test screen.

@ Auto Phase

The software will now micro step the motorin
the negative direction. Make sure the motor is

free to move. Press Start when ready. 1

180

Auto Phase Current: 279 A 210
Increment Rate: i 90 elec deg/s
Move Distance: 4 elec Cydes Actual Motor Position:

Ready
Stop

C tion Settings ——
onfiguration Settings =

counts per rev 8000

Poles 8

120

Phase Count Test Commanded Motor Phase Angle

9060
/30
0
330

Skip >

0 counts

8. Click Start to begin the Phase Count Test. Observe status messages. See the

prompt:

Phase Counts X

Observe motor motion and verify that it

moves 1 turn(s) before any gearing.

9. When you are ready to observe motion, click OK. See the prompt:

Phase Counts

Did motor move 1 turn(s)?

X
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10.Click Next to open the Auto Phase Motor Phase Initialize screen:

@3 Auto Phase X

Motor Phase Initialize

The amplifier will perform phase intialization. Make sure the
motor is free to move. Press Initialize Phase when ready.

< Back Finish Cancel

11. Click Initialize Phase to start phase initialization. If successful, this message
appears: “Test Complete. Phasing has been initialized.”

@ Auto Phase X

Motor Phase Initialize

The amplifier will perform phase intialization. Make sure the
motor is free to move. Press Initialize Phase when ready.

Initialize Phase

Test Complete
Phasing has been Initialized

< Back Cancel

12. Click Finish to close the screen and save values to flash memory.

11.2 Tips for Auto Phase Current and Increment Rate
o If friction is high, more current may be required to move the load.
e High static friction may require more current to overcome stiction.
e Transition from static friction to dynamic friction, and back, may produce jerky motion.
e A faster increment rate will operate in the dynamic friction range.
e A slower rate will operate in the static friction range.

o If the friction is low, as in the case of air bearings, low frequency oscillations may occur;
thus, less current and slower rates may be required. If oscillations persist, then friction
may need to be temporarily added.

11.3 Troubleshooting the Auto Phase Problems

11.3.1 Motor direction setup
If motor direction setup step failed:
e Check Encoder or resolver power and signals.
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e Verify that the encoder is differential. (Contact factory if encoder is single-ended.)
e Check shielding for proper grounding.

11.3.2 Motor wiring setup

If motor wiring setup step failed:

Verify that amplifier is disabled.

Check for mechanical jamming.

Check for smooth motion with no mechanical jerking.

Check for good connections to the motor power wires.

Disconnect motor power wires and measure for proper motor resistance.

11.3.3 Phase count test
If phase count test failed:
e Verify that in the Motor/Feedback screen the following parameters have been set
correctly:

¢ Number of Poles for rotary motors. Verify the motor’s pole count with the Data accuracy
test.

e Magnetic Pole Pair Length for linear motors.
e Encoder Lines or Fundamental Lines for rotary encoders.
e Encoder Resolution for linear encoders.

11.3.4 Halls wiring setup

If Halls wiring setup step failed:
e Check Halls power and signals.
e Check for smooth motion with no mechanical jerking.
e Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see Manual Phase.

11.4 Manual Phase

1. Remove load from the motor.
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2. On the Main screen, choose Tools>Manual Phase to open the window:

Manual Phase

- Configuration
rHalls

Invert Input:
u

Hall Wiring:

Ov

Hall Offset: 0

Ow

VUw

deg

1 Monitor

~Motor Feedback -
Invert Input

rMotor
Invert Output

Control

Increment Rate:

Current:

(O Enable

90|
112

(@) Disable

Restore Defaults

elec deg/s

X

No Faults

Hall States -

u A w
Lo Lo Hi
Motor Phase Angle: Odeg
Motor Feedback: 0 counts

Actual Current:  U: 0.23A v:

Motor Phase Angle
& Hall State

| BEN]

-0.18 A

120 60
0 [l
240 300

w: 0.04A

Set Zero Position

Move Motor

oK Cancel

3. Verify the Current setting before enabling the drive.

(" Disable

4. To control the current vector rotation, command the motor forward or reverse.
Move Motor

[Rev H Fwd |

NOTE: Some motors have bearings stiction, so helping the motor with mechanical force is
acceptable. Motors with no friction may need friction added to steady motion.

5. If the motor cannot keep up with the rate of vector rotation, then reduce the

Increment Rate or increase the Current.

6. Verify that pressing forward button moves motor forward.
If the motor moves in the wrong direction, toggle the Motor Invert Output setting.
7. Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.
8. If the motor has no Halls, skip to Phase Initialization for Motor without Halls.
9. Monitor the vector rotation through one electrical cycle for proper Hall transitions:
= Verify that the red indicator rotates in the same direction as the motor phase angle,
and that the transition occurs when the needle is between indicators (+30 degrees, as
shown below).
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= If the needle and Hall states do not track properly, use the Hall Wiring list box and/or
Invert Input options (shown below) to swap the amplifier’s Hall wire configuration.

rHalls—

Invert Input:

Clu v [Fw
Hall Wiring:  [UVW._ ~/

Hall Offset:

-Motor Feedba —

» If the red indicator transition leads or lags behind the centered needle by more than 30
degrees, then try adjusting the Hall Offset in +/- 30 degree increments:

Hall Offset: 0| deg

10. Phasing of a motor with encoder and Halls is complete. Click OK.

11.4.1 Phase Initialization for Motor without Halls (Algorithmic Phase Initialization
Mode)

The Phase Initialization is designed to phase a motor with no Halls.

Halls are strongly recommended for safe, redundant system.

Copley strongly recommends the use of Halls or a commutating
encoder for commutation to provide a safe, redundant system. If the
application requires otherwise, the customer accepts responsibility

DANGER  ¢or verifying system performance and reliability.

Failure to heed these warnings can cause equipment damage,
injury, or death.

The Phase Initialization function uses as little motion as possible (less than 1/3 of one electrical
cycle) to determine phasing. Phase Initialization drives the motor in open loop current mode,
using microstepping of a current vector.

1. Ensure that the motor is free to move (for instance, make sure the brake is OFF).

2. Ensure that no external force, such as gravity, will cause the motor to move. If it is
not practical to eliminate such forces, it may be necessary to use the Forced Phase
feature later in this procedure.

3. To phase a motor with an encoder and no Halls, click Initialize Phase | intaizephase |
Observe the status messages under Monitor.

4. If the message “Phase Initialized” appears, the phasing of a motor with encoder and
no Halls is complete. Click OK to close the Manual Phase window.
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Phase Initialize
Time: 400 | mS
Current: 0 A
(Current set to 0 uses IPeak)
Forced Phase

[7] Increment Phase 90 deg

If the phasing function fails (for instance, message
“Phase Initialized” is not displayed, or if a phasing fault
is indicated) adjust the phase initialization settings
described below and try Step 4 (Initialize Phase) again.

[7] Use Offset Initialize Phase ’

Setting Description

Time Used first as a delay, allowing amplifier to ramp up current to drive a small
move. Then used as a settling time. If the value is too low, the settling
may not occur in time, possibly resulting in jerky motion. Default: 400 ms.

Current Use to overcome stiction when rotating current vector. If the current is too

large, motion may not settle; a low value may not provide enough current
to drive a move.

Forced Phase

When selected, Forced Phase causes the Phase Initialization function to
apply Phase Init Current to alternate pairs of motor wires using the Phase
Init Time. Forced Phasing has been used to overcome various phasing
problems, including situations where gravity introduces unwanted motion.
Forced Phasing tends to produce more jerk and apparent motion.

Increment Phase
90 deg

If set, the amplifier will increase the starting phase angle by 90 degrees
after every failed initialization attempt.

Use Offset

If set, the amplifier uses the Hall Offset value as the initialization starting
angle.

11.4.2 Manual Phase Example: Motor with Resolver

1. Make sure that no load is connected to the motor.

2. On the Main screen, choose Tools>Manual Phase to open the window:

90
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Manual Phase X

Configuration rMonitor
No Faults
rResolver
Motor Phase Angle Black

Feedback Angle in Red
Offset | 90 deg

Resolver 120 60

rMotor Feedback —————— 0
SifFacae Angle | 170 deg 180 o
[ Invert Input
240 300

Motor Phase Angle: = 260deg

~Motor

[ invert Output Position: -4327 counts
Actual Current:  U: 0A v 0.01A w: -0.01A
Control
Increment Rate: 0| elec degfs Set Zero Position
Current: 0:58 A Move Motor
(O Enable (@) Disable Re Fwd
Restore Defaults oK Cancel

Verify the Current setting before enabling the drive

' Disable

To control the current vector rotation, command the motor forward or reverse.
Move Motor

[ Rev H Fwd |

NOTE: Some motors have bearings stiction, so helping the motor with mechanical
force is acceptable. Motors with no friction may need friction added to steady
motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the
Increment Rate or increase the Current.

Verify that pressing forward button moves motor forward. If it does not, toggle the
Motor Invert Output box setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle
the Motor Feedback Invert Input box setting.

Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce
alignment of Motor Phase Angle with Resolver Angle as shown here.
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Motor Phase Angle Black
Feedback Angle in Red

120 60
180 fone—

290 300

Note: Motor manufacturers typically align the resolver in 30 degree increments,
typically by applying current through a pair of motor power wires.

11.5 Troubleshoot Manual Phase w/ Encoder and Halls

To perform trapezoidal commutation after power-up or reset, the amplifier must receive good
Hall signals. After the first Hall transition is detected, then sinusoidal commutation can be
performed. In sinusoidal commutation, the amplifier uses the encoder for commutation while
monitoring the Halls to verify proper phase. If the error between the encoder count and Hall
transition is too large, then the Hall phase correction will not be performed and a phase fault
will be triggered.

Test for phase fault problems in the order shown below.

11.5.1 Data accuracy test
1. Verify the motor’s pole count:
e Apply a current vector at zero Increment Rate to lock motor in position.
e Turn the motor shaft and count the number of distinct locking positions.
e Calculate the number of poles: Poles = number of locking positions * 2
2. Verify the encoder line count OR a linear motor's magnetic pair length and the encoder
resolution.

11.5.2 Encoder wiring test
If the Halls produce good trapezoidal commutation but a phase fault is persistent in sinusoidal
commutation mode, the encoder is highly suspect:

e Verify the differential encoder signals.

e Verify proper twisted shielded cable with good grounding.

e Disable the amplifier and move the motor manually to test for phase fault.

e If phase fault only occurs under command of current, make sure the motor power cable

is not bundled with the encoder cable.

11.5.3 Hall signals test

If the Halls signals are suspected to be faulty:
¢ Make sure Halls change states as the motor moves through one electrical cycle.
e Some Hall signals are noisy and require filtering. Check with motor manufacturer.
e Some Halls are not properly calibrated to the motor manufacturer’s specification.

11.5.4 Hall transition test

If the location of the Hall transition is not within +/-30 degrees:
e Adjust Hall offset in smaller increments.
e Verify Hall alignment.
¢ Make sure motion is smooth.
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12 CONTROL LOOPS

12.1 Current Loop Setup and Tuning

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

IL
Click I Loop ﬂ to open the Current Loop screen:

93

@ Current Loop

Commanded

Current

Input
Fiiters

Cument |

Uimiter |

]

+

—

Commanded

N Voltage
Cp+Ci \

T Actual Current

Peak Current Limit: 1.24 A Cp: 1|
I2T Time Limit: 1000 | ms Gi: 0
Continuous Current Limit: 1.24 A Drive Output

(®) Maximize Smoothness
Current Loop Offset: 0 A

(O Maximize Speed
Current Ramp: 0 [mA/S [[] Enable Bus Clamping

Auto Tune Bandwidth
Close
Parameter Description

Peak Current Limit

Used to limit the peak phase current to the motor. Max value depends
upon the amplifier model; Min value > continuous limit.

12T Time Limit

Sets I?T Time Limit in ms. See 12T Limit Algorithm.

Continuous Current Limit

Used to limit the Phase Current. Max Value is < Peak Current and
depends upon the amplifier model. Min value: 0

Current Loop Offset

Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Error! Reference source not found.

Cp

Current loop proportional gain. Range 0 - 32,767.

Ci

Current loop integral gain. Range 0 - 32,767.

Current Ramp (mA/s)

Used only when in current mode. Default value is 0 which disables the
ramp rate limit.

Drive Output

Maximize Smoothness: Amplifier uses circular vector limiting to
produce smooth operation even into the voltage limits.
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Maximize Speed: Allows for slightly more of the bus voltage to be used
when in the voltage limit. This may produce a small disturbance at top
speed.

Enable Bus Clamping Checking the option disables space vector modulation and may reduce
120 Hz AC line ripple when holding position near zero current. If
unchecked may allow for higher speeds.

Auto Tune See Current Loop Auto Tune.Error! Reference source not found.

Bandwidth Measure bandwidth using the Cp and Ci values now in the amplifier.

12.1.1 Current Loop Manual Tune

NOTE:
= During tuning, observe any warnings or faults that appear in the status bar of
the scope.
= Some users prefer the Auto Tune feature. See Current Loop Auto Tune.

B
1. Click the Scope Tool ;

Apply To: | Current -
2. Choose Current from the Function Generator Apply To: drop
list.
v/| AutoSetu
3. On the Settings tab, make sure Auto Setup P is selected. Auto Setup
automatically sets the following parameters:
Function Generator Tab
Parameter Description
Function Square Wave.
Amplitude 10% of continuous current value.
Frequency 100 Hz.
Settings Tab
Channel 1 Commanded current (green).
Channel 2 Actual current (white).
Amplitude: 0.47] A
4. Verify that the Amplitude value o U is not excessive for the motor.
5. Click Start |52t |,
6. On the Gains tab, adjust current loop proportional gain (Cp) and the current loop

integral gain (CI) to obtain a desired wave form.

= Set current loop integral gain (Ci) to zero.
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7.

= Raise or lower Cp to obtain desired step response. (Typically, little or no
overshoot with a 100 Hz, low-current square wave.) If the Cp value is too
large, ringing may occur. If the Cp value is too low, bandwidth decreases.

Current
~N
Cp: | 4000 |
Gi: 00| A
v

Adjust current loop integral gain (Ci) until desired settling time is obtained.

Note: The image below shows a good example of a good current loop tuning, in which
the wave forms for commanded and the actual current are very similar, without any
ringing or overshoot.

05

Trace Status: Reading trace data from amplifier

0.4
0.3 1
0.2
@ 0.1
E 0.0

urr

©.0.14
-0.2 1

05

ol \ J \ e

HEE R

0.000

10.

T T T T T T T T T T T T

0.002 0.004 0.006 0.008 0.010 0.012 0.014 0.016 0.018 0.020 0.022 0.0249 0.026

Time (seconds)

Press Stop I&LI to stop the function generator.

u,[zu‘
On the Main screen, click Save to Flash 'Mto avoid losing the changes.

IL
On the main screen, select ﬂ and click on Bandwidth to measure the

bandwidth. Verify that the bandwidth measured is sufficient for the application.
Typical bandwidth value is 1.2kHz £ 200 Hz.

12.1.2 Current Loop Auto Tune

The current loop Auto Tune algorithm applies a square-wave command to the current loop
and adjusts current loop proportional gain (Cp) and current loop integral gain (Ci) until a
desirable waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

95

_ e
1. Click I Loop o to open the Current Loop screen:
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96

2. Verify that the amplifier is hardware enabled.

@ Current Loop

Commanded .
Cument 4

Ball-

Curent
Limiter

Peak Current Limit: 124 A
13T Time Limit: 1000 | ms
Continuous Current Limit: 124 /A
Current Loop Offset: oA

|

Commanded

+/ Voltage
—bl Cp+Ci

Actual Current

urrent Ramp: 0|mASS

Cp: 1
Ci: o
Drive Output
(@ Maximize Smoothness
(O Maximize Speed
[] Enable Bus Clamping

Auto Tune Bandwidth

Close.

) Auto Ti
3. Click Auto Tune to open the screen and start the Current Loop Auto

Tune.

Q Auto Tune

Cp: 10

Auto Tune Current:

1A

Status: Auto Tune in progress.

Close

4. To Change the Auto Tune Current, click Stop. Enter the new current in the Auto
Tune Current field, and then click Start.

5.

Observe the Auto Tune process and results.

A typical example is given below:
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Set Cp and Ci to zero and adjust Cp and Ci for optimal values.

@ Auto Tune X

25
2.0
1.5 [

z 104 /

< 051

g .04

00 /

“059

1041
154
20 T T T

00000 00005  0.0010

0.0020 0.0025 0.0030 0.0035 0.0040 0.0045
Time (seconds)

0.0015 0.0050

Auto Tune Current:
Status: Auto Tune in progress.

Cp: 2538 Ci Start Close

Use a frequency sweep to determine the small signal, current loop bandwidth.

@ Auto Tune X
125
1.00
0.75

_ 050+

< 0251

oW U YN U Yy
-1.00 !
-1.25 T T T T T T T T T T T T

0000 0005 0010 0015 0020 0025 0030 0035 0040 0045 0050 0055 0060 0.0865
Time (seconds)

Auto Tune Current: 1
Status: Measuring Bandwidth

Cp: 2135 G 212 Start Close

A set of Cp and Ci alternatives, and the bandwidth measured using the high Cp and Ci values
are displayed.

@ Auto Tune Results

X

Auto Tune Measured Values:

Cp: 1532
Ci: 325
Bandwidth: 1400 Hz

Cancel

6. Click OK to keep the new Cp and Ci values in RAM that auto tune measured. Click
Cancel to restore the original Cp and Ci values.
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12.1.3 Notes on the Current Mode and Current Loop

Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage accepts
a current command, applies limits, and passes a limited current command to the summing
junction. The summing junction takes the commanded current, subtracts the actual current
(represented by the feedback signal), and produces an error signal. This error signal is then
processed using the integral and proportional gains to produce a command. This command is
then applied to the amplifier’s power stage.

Current Loop PWM

—FI' Current Integral Gain (Ci) |—* + | Command
L - + :
Current Command—| Current Limiter |Limited Current ;dz)_" Current Proportional Gain (Cp) }_,@__-> _,
+

Current Offset ——1 f\_ el

—

Limits: Feedback (Actual Current)
® Peak Current

e Continuous Current

e Peak Current Limit Time

Current Loop Inputs
e The amplifier's analog or PWM inputs.
e A CANopen network via the amplifier’s CAN interface.
e A Copley Virtual Motion (CVM) control program.
e The amplifier’s internal function generator.
In velocity or position modes, the current command is generated by the velocity loop.

12.1.4 Offset

The current loop offset is intended for use in applications where there is a constant force applied
to, or required of, the servomotor and the system must control this force. Typical applications
would be a vertical axis holding against gravity, or web tensioning. This offset value is summed
with the current command before the limiting stage.

12.1.5 Limits
The current command is limited based on the following parameters:

Limiter Description

Peak Current | Maximum current that can be generated by the amplifier for a short duration of
Limit time. This value cannot exceed the peak current rating of the amplifier.
Continuous Maximum current that can be constantly generated by the amplifier.

Current Limit

I2T Time Limit Maximum amount of time that the peak current can be applied to the motor before

it must be reduced to the continuous limit or generate a fault.
For more details, see I2T Time Limit Algorithm.

Note: Although the current limits set by the user may exceed the amplifier's
internal limits, the amplifier operates using both sets of limits in parallel, and
therefore will not exceed its own internal limits regardless of the values

programmed.

Ramp Rate of change in current command. Used to limit jog moves initiated from the
Control Panel Jog function in current mode, and in advanced Indexer Program
functions.
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12.1.6 Current Loop Gains

Gain Description

Cp - Current loop | The current error (the difference between the actual and the limited

proportional commanded current) is multiplied by this value. The primary effect of this gain
is to increase bandwidth (or decrease the step-response time) as the gain is
increased.

Ci - Current loop | The integral of the current error is multiplied by this value. Integral gain

integral reduces the current error to zero over time. It controls the DC accuracy of the
loop, or the flatness of the top of a square wave signal. The error integral is
the accumulated sum of the current error value over time.

12.1.7 Current Loop Output

The output of the current loop is a command that sets the duty cycle of the PWM output

stage of the amplifier.

12.2 Velocity Loop Setup and Tuning

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be

calculated with Calculate.

VL
Click the V Loop button ﬂ on the Main screen (contents vary with model and

configuration):

Q Velocity Loop

Commanded

Velocity »

Velocity & Accel. Input
Limiter Filter

\ 2

Veff

C
| —p» Gains |y, Output _Cumeni o
Shift | Fitters

Actual Velocity

Vel. Limit: 1500 | rpm Vp: 7339|

Vi 1631

Decel, Limit:

Fast Stop Ramp: 500 | rps2 ViDrain: 0

[[] Disable Gains

Tracki
st Vcff: 0

Window: 300 | rpm

Time: 100 ms

[[] Low Gains Shift

Close

Parameter Description

Velocity Limit

value. Min value: 0.

Top speed limit. Max value may depend upon the back EMF & the Encoder
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Acceleration Limit

Maximum acceleration rate. Max value may depend upon load, inertia, &
peak current. Min value: 1. (Does not apply in position mode.)

Deceleration Limit

Maximum deceleration rate. Max value may depend upon load, inertia, &
peak current. Min value: 1. (Does not apply in position mode.)

Tracking Window

Tracking Time

See Position and Velocity Tracking Windows

Vp

Velocity loop proportional gain. Range: 0 to 32,767.

Vi

Velocity loop integral gain. Range: 0 to 32,767.

Fast Stop Ramp

Deceleration rate used by the velocity loop when the amplifier is hardware
disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit
value.

Low Gains Shift

Increases the resolution of the units used to express Vp and Vi, providing
more precise tuning. For more information, see Velocity Gains Shift.

Hi Gains Shift

Decreases the resolution of the units used to express Vp and Vi, providing
more precise tuning. For more information, see Velocity Gains Shift.

Vi Drain (integral
bleed)

Vi drain modifies the effect of velocity loop integral gain. The higher the
Vi Drain value, the faster the integral sum is lowered. Range: 0 to 32,000.
Default: 0.

Vcff

Velocity loop command feed forward. The input command to the velocity
loop (after limiting) is scaled by this value and added to the output of the
velocity loop.
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Manually Tune the Velocity Loop

NOTE: During tuning, observe any warnings that appear to the left of the trace.

1. Click the Scope Tool ‘!
. Apply To: iv .
2. Choose Velocity ' from the Function Generator Apply To:
drop list.
AutoSetu
3. On the Settings tab, make sure Auto Setup HOEP s selected.
Auto Setup automatically sets the following parameters:
Function Generator Tab
Function Square Wave
Amplitude 10% of maximum velocity value
Frequency 5 Hz
Settings Tab
Channel 1 Limited velocity (green)
Channel 2 Actual Motor Velocity (white)
4. Verify that the amplitude value Ll 200 e is not excessive for the
motor.
Click Start LSt |
On the Gains tab, adjust velocity loop proportional gain (Vp):
. Set velocity loop integral gain (Vi) to zero.
. Raise or lower proportional gain (Vp) to obtain desired step response.

(Typically, little or no overshoot on a 5 Hz small, slow-speed square wave.)

Velodty
Vp: 74 :
Vi 30 :

7. Adjust velocity loop integral gain (Vi) until desired settling time is obtained.

Note: The image below shows a good example of a good velocity loop tuning, in
which the wave forms for commanded and the actual velocity are very similar.
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Trace Status: Reading trace data from amplifier

Welocity (rpm)

0.45 0.50

0.00 0.05 0.10 0.15 0.20 0.25 0.30 0.35 0.40
Time (seconds)

8. Click Stop lﬂl to stop the function generator.

u

9. On the Main screen, click Save to Flash L. to avoid losing the changes.

12.3 Notes on the Velocity Mode and Velocity Loop

12.3.1 Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies limits, and
passes a limited velocity command to the input filter. The filter then passes a velocity command
to the summing junction. The summing junction subtracts the actual velocity, represented by
the feedback signal, and produces an error signal. (The velocity loop feedback signal is always
from the motor feedback device even when an additional encoder is attached to the load.) The
error signal is then processed using the integral and proportional gains to produce a current
command. Programmable digital filters are provided on both the input and output command

signals.

Velocity Loop

Velocity Integral Gain (Vi
Velocity Limited - i o | +
P . + }
Command ™| Velocity Limiter | gy, | Velocity ] Z —| Velocity Proportional Gain (Vp) > | Filter »grremnd

,—P _/_\_

Limits: |

e Velocity

o Acceleration* Feedback (Derived Velocity)

» Deceleration*

e Emergency Stop Deceleration*
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

12.3.2 Inputs
In velocity mode, the velocity command comes from one of the following:
e The amplifier's analog or PWM inputs.
e A CANopen network via the amplifier's CAN interface.
e A Copley Virtual Motion (CVM) control program.
e The amplifier’'s internal function generator.
In position mode, the velocity command is generated by the position loop.

12.3.3 Velocity Loop Limits
The velocity command is limited based on the following set of parameters designed to protect

the motor and/or the mechanical system.
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Limiter Description

Velocity Limit Sets the maximum velocity command input to the velocity loop.

Acceleration Limits the maximum acceleration rate of the commanded velocity input to the
Limit velocity loop.

This limit is used in velocity mode only. In position mode, the trajectory generator
handles acceleration limiting.

Deceleration Limits the maximum deceleration rate of the commanded velocity input to the
Limit velocity loop.

This limit is used in velocity mode only. In position mode, the trajectory generator
handles deceleration limiting.

Fast Stop Ramp Specifies the deceleration rate used by the velocity loop when the amplifier is
hardware disabled. (Fast stop ramp is not used when amplifier is software
disabled.) If the brake output is active, the fast stop ramp is used to decelerate
the motor before applying the brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the
trajectory generator handles controlled stopping of the motor. There is one
exception: if a non-latched following error occurs in position mode, then the
amplifier drops into velocity mode and the Fast Stop Ramp is used.

12.3.4 Diagram: Effects of Limits on Velocity Command
The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity

Vel Limit- — — 4 -

1 1 — "
Accel Limit = = [==— Decel Limit =
12.3.5 Velocity Loop Gains
The velocity loop uses these gains:
Gain Description
Vp - The velocity error (the difference between the actual and the limited
Velocity commanded velocity) is multiplied by this gain. The primary effect of this
loop gain is to increase bandwidth (or decrease the step-response time) as the
proportional | gain is increased.
Vi - The integral of the velocity error is multiplied by this value. Integral gain
Velocity reduces the velocity error to zero over time. It controls the DC accuracy of
loop integral | the loop, or the flatness of the top of a square wave signal. The error
integral is the accumulated sum of the velocity error value over time.
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12.3.6 Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp
and Vi, providing more precise tuning. If the non-scaled value of Vp or Vi is 64 or less,
the Low Gains Shift option is available to increase the gains adjustment resolution.
(Such low values are likely to be called for when tuning a linear motor with an encoder
resolution finer than a micrometer.) If the non-scaled value of Vp or Vi is 24001 or
higher, the High Gains Shift option is available to decrease the gains adjustment
resolution.

12.3.7 Velocity Loop Filters
See Standard Filter Types.

12.3.8 Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current
loop.

12.3.9 Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output
of the trajectory generator and the actual position. Velocity error is the difference
between commanded and actual velocity.

When the position or velocity error exceeds the programmed tracking window value, a
status word bit is set. The bit is not reset until the error remains within the tracking
window for the programmed tracking time.

12.3.10 Velocity Tracking Illustration
The following diagram illustrates the use of tracking window and time settings in
velocity mode.

Actual Velocity
Limited Velocity \

+ Tracking Window
J/ | Tracking |
=~ Time T
/ | ‘
/
/ | |
| |
Tracking Window
Output
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12.4 Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration feed
forward (Aff) values can be calculated with Calculate.

P
Click the P Loop button [ﬂ on the Main screen.

2} Pasition Loop EI =1 IEI
Profile Acceleration
- Aff
Profile \Velocity
LY
+‘ Commanded
F N E Velocity
L P Gains
"-\_ Multiplier
A
Pp
Limited Position ~ +
) PiDrain — ™ P
S
Pd
I} Actual Position
Pp: 1000 Pi: a Aff: 0 Gains Multiplier: 1
Pi Drain: 0 vif: | 16334
100% Vff = 16384
Pd: o
[] Enable PID
Following Error Tracking Position Wrap
Fault: 4000 | counts Window: 1000 | counts
Warning: 2000 | counts Time: 10| ms
[~ Disable Fault
Close
Parameter Description
Aff Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits
VFf Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
Trajectory Limits
Pp Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits

Gains Multiplier | Position loop output is multiplied by this value before going to the velocity
loop. In dual encoder systems, the multiplier’s initial value is calculated based
on the ratio of motor encoder turns to position encoder turns.

Following Error | The level (in encoder counts) at which the following error produces a fault,
Fault which stops the servo loop. We recommend raising the fault level before
tuning the loop.

See Following Error Faults
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Following Error

The level (in counts) at which the following error produces a warning (without

Warning stopping the loop). See Following Error Warnings

Disable Fault Stops following error from faulting. See Following Error Faults

Tracking Width of tracking window in counts. See Position and Velocity Tracking
Window Windows

Tracking Time

Position must remain in the tracking window for this amount of time to be
considered tracking. See Position and Velocity Tracking Windows

Pi Position loop integral gain
Pd Position loop derivative gain
Pi Drain Position loop integral drain
Enable PID Enables the PID parameters

Click the Position Wrap button M,

Position Wrap X
Motor Position Wrap: 0|| counts
1 revolution of the motor is 8000 counts.

Load Position Wrap: 0 | counts

Load positioning not configured.

oK Cancel Help

Change/verify the position wrap parameters as needed. Set both values to zero to
disable position wrapping. Note that the changes do not take effect until OK is pressed.
For more information about this feature, see Position Wrap.

Parameter

Description

Motor Position
Wrap

Position at which the actual motor position count returns to zero. In a single
feedback system, it also applies to the actual load position.

Load Position
Wrap

Position at which the actual load position count returns to zero in dual
feedback systems. If the position encoder is set to passive mode, this value
applies to the passive encoder position.
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Click on the Trajectory Values tab.

@ Position Loop

Comman ded Position

Trajectory Values  Position Loop Values

{ Velocity

Profile Velocity

»
P

Max Velocity: 1250]| rpm

Clear Limits

Set Default Limits

Profile Acceleration
»
o

Limited Position

417 rps?

&
Limiter

Max Accel.:
Max Decel.: 417 | rps?

Abort Decel.: 417 | rps?

Close

12.4.1 Parameter

12.4.2 Description

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF
and the Max feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load
inertia and peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit
value.

Max Decel Maximum trajectory deceleration. Max value may depend upon the load
inertia and peak current. Min:0 (disables limit). Default: 0.5 x velocity
loop Accel. Limit value.

Abort Decel Deceleration rate used by the trajectory generator when motion is
aborted. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Jerk Rate of change of acceleration. The value of jerk set during the calculate

procedure produces an S-Curve whose maximum slope is equal to the
trajectory profile slope. This value will produce a maximum acceleration
that is not more than the initial default value of acceleration. Small values
will produce less jerking but will take longer to complete move. Large
values will produce more jerking and a more trapezoidal profile but will
complete the move faster.

Note that setting limits to zero disables the trajectory generator so that the command input is
not limited by the generator. Velocity is only limited by the Velocity Limit set in the Velocity

Loop.
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Manually Tune the Position Loop
NOTE: During tuning, observe warnings that appear to the left of the trace.

| L3
1. Click the Scope Tool =—.

ator”{ Profile
2. Select the Profile tab =

3. On the Settings tab, make sure Auto Setup V] Auto Setup

automatically sets the following parameters:

is selected. Auto Setup

Profile Tab

Move Relative

Type Trap

Distance 2000 counts

Reverse and Not selected

repeat

Settings Tab

Channel 1 Profile velocity (green)
Channel 2 Following error (white)

4. If the Auto Setup default profile distance is not appropriate, enter an

. . Distance: 2000 counts
appropriate short distance .

5. Click Start ls‘ta;'tl The Profile Generator executes a short move.
NOTES:

* The profile may not reach constant velocity during a short move.

= If a following error occurs, open the Control Panel and click Clear Faults.

6. Set up a trapezoidal profile by setting the trajectory limits and distance.

See table

| Function Generator | Profile |

| Settings | Gains| Trajectory Limits | position Params | Velocity Params | Measurement
Maximum Velocity: 1500 | rpm Move: . Type:
@ Relative @ Trap
Maximum Acceleration: 500 | rps? ") Absolute ) S Curve
Maximum Deceleration: 500 rps?
Distance: 2000 counts

and
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Trajectory Limits Tab

Maximum Velocity

Maximum

Acceleration Set values typical of those expected to be used in the application.

Maximum

Deceleration

Profile Tab

Distance Set the move distance to produce a complete trajectory profile. Be
sure that this distance does not exceed mechanical limits of the
system.

Move Relative

Type Trap

7. Adjust position proportional gain (Pp) to minimize following error:

¢ On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward (Aff) to
zero.

e On the Profile tab, click Start. On the Gains tab, adjust position loop proportional gain
(Pp) until best result is obtained.

e Click Start after each adjustment to test on a new profile move.

Position

Pp: 5000]
Aff: of §£
vff: | 16384

NOTE:
1. Too much position loop proportional gain (Pp) might cause oscillation.
2. If a following error occurs, open the Control Panel and click Clear Faults.

8. Adjust velocity feed forward (Vff):

» Velocity feed forward (Vff) reduces following error in the constant velocity portion of
the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides best
results.

= Click in the Vff field and adjust the value.

» Click Start after each adjustment to test on a new profile move.

9. Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile acceleration and
deceleration.

= Click in the Aff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.
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NOTE:

1) If, after tuning the position loop, the motor makes a low frequency audible noise while
enabled but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce the
noise. If the gain values are set too low, the response to instantaneous rates of change
might be reduced (i.e., slow correction to disturbances or transients).

2) If the amplifier is set up to run in position mode under analog input command, and the
analog command signal produces too much noise at the motor after tuning, the Analog
Command Filter or the Velocity Loop Command Filter may be used to reduce the noise
further.

10. Tune to multiple sets of profiles representing typical moves that might be executed in the
application. Starting with Step 6, repeat the process as needed.

Note: The image below shows a good example of a good position loop tuning.

Trace Status: Ready

3500 400
3000 - 300
2500 F200 2

5

22000 100 2

o L=

z 500 o g

&1 g

o ~

T o

< 1000 4 +-100 2

#
500 -200™~"
0 -300
-500 T T T T T T T T T -400
0.00 0.05 0.10 0.15 0.20 025 0.30 0.35 0.40 0.45 0.50

Time (seconds)

12.4.1 Test S-Curve Profile

If the amplifier will perform S-Curve profile moves, use this procedure to tune the level of
jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce jerk to provide a
smooth profile.) Run an S-Curve profile and adjust velocity, acceleration, deceleration, and
jerk levels until the desired profile is obtained. For instance:

Trace Status: Ready

4000 250
3500 200
3000 150

iy
2500 F100 =

P 2

E 2000 r50 2

5 1500 0 g

£ 3

3 1000 r50 g

500 F-100 &
0 -150
-500 --200
-1000 T T T T T T T T T -250
0.00 0.05 0.10 0.15 0.20 0.25 0.30 035 0.40 0.45 0.50

Time (seconds)
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1.  On the Profile tab, click the S-Curve button.

:)ri; Proﬁilei‘

Type:

...................

2. Set up an S Curve profile by adjusting the following parameters to represent a typical
move under normal operation.

Trajectory Limits Tab

Maximum Velocity Maximum speed of the profile.
Maximum Maximum acceleration/deceleration of the profile. The
Acceleration/ deceleration is set to be the same as acceleration.

Deceleration

Maximum Jerk The value of jerk set during the calculate procedure produces
an S-Curve whose maximum slope is equal to the trajectory
profile slope. This value will produce a maximum acceleration
that is not more than the initial default value of acceleration.
Small values will produce less jerking but will take longer to
complete move. Large values will produce more jerking and a
more trapezoidal profile but will complete the move faster.

Profile Tab

Distance Increase the move distance to produce a complete trajectory
profile. Use an acceptable value the does not exceed
mechanical limits of the system.

Move Relative

Type S-Curve

3. Click Start.

4, Try multiple sets of profiles representing typical moves that might be executed in
the application. Starting with Step 2, repeat the process as needed.
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12.5 Notes on the Position Mode and Position Loop

12.5.1 Position Loop Diagram
The amplifier receives position commands from the digital or analog command inputs, over
the CAN interface or serial bus, or from the CVM Control Program. When using digital or
analog inputs, the amplifier's internal trajectory generator calculates a trapezoidal motion
profile based on trajectory limit parameters. When using the CAN bus, serial bus, or CVM
Control Program, a trapezoidal or S-curve profile can be programmed. The trajectory
generator updates the calculated profile in real time as position commands are received.
The output of the generator is an instantaneous position command (limited position). In
addition, values for the instantaneous profile velocity and acceleration are generated. These
signals, along with the actual position feedback, are processed by the position loop to
generate a velocity command.
To bypass the trajectory generator while in digital or analog position modes, set the maximum
acceleration to zero. The only limits in effect will now be the velocity loop velocity limit and
the current limits. (Note that leaving the maximum acceleration set to zero will prevent other
position modes from operating correctly.)

The following diagram summarizes the position loop.

Profile Velocity Position Loop
»|  Velocity Feed Forward (vff) |
Target Trajectory Profile Acceleration Gai i
- ain
Position Generator »| Acceleration Feed Forw ard (Aff) Multiplier > \églﬁrigwd
. i, "
,—> _/_\_ Limited Position @—>| Position Proportional Gain (Pp) |
o A -

Limits:
e Max velocity <
* Max accel Feedback_o/c~ from motor encoder or resolver
* Max decel Od---mrmmmmmae s from optional position encoder (on load)
e Abort decel

12.5.2 Trajectory Limits
In position mode, the trajectory generator applies these limits to generate the profile.

Limiter Description

Maximum Velocity Limits the maximum speed of the profile.

Maximum Limits the maximum acceleration rate of the profile.

Acceleration

Maximum Limits the maximum deceleration rate of the profile.

Deceleration

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when

motion is aborted.

12.5.3 Position Loop Inputs From the Trajectory Generator
The position loop receives the following inputs from the trajectory generator.

Input Description

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the
velocity feed forward value.

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used
to calculate the acceleration feed forward value.

Limited Position The instantaneous commanded position of the profile. Used with the
actual position feedback to generate a position error.
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12.5.4 Position Loop Gains
The following gains are used by the position loop to calculate the velocity command:

Gain Description

Pp - The loop calculates the position error as the difference between the

Position loop actual and limited position values. This error in turn is multiplied by

proportional the proportional gain value. The primary effect of this gain is to reduce
the following error.

VFf - The value of the profile velocity is multiplied by this value. The primary

Velocity feed forward | effect of this gain is to decrease following error during constant
velocity.

Aff - Acceleration The value of the profile acceleration is multiplied by this value. The

feed forward primary effect of this gain is to decrease following error during

acceleration and deceleration.

Gain Multiplier The output of the position loop is multiplied by this value before being
passed to the velocity loop.

12.5.5 Position Loop Feedback
Some Copley Controls amplifiers feature dual-sensor position loop feedback, configured as
follows:
e Single sensor. Position loop feedback comes from the encoder or resolver on the motor.
e Dual sensor. Position loop feedback comes from the encoder attached to the load.
(Note that in either case, velocity loop feedback comes from the motor encoder or resolver.

12.5.6 Position Loop Output
The output of the position loop is a velocity command used as the input to the velocity loop.

12.5.7 Position Wrap

The position wrap feature causes the position reported by the amplifier to “wrap” back to zero
at a user-defined value instead of continually increasing. Once set, the reported position will be
between 0 and n-1 where n is the user entered wrap value. This feature is most useful for rotary
loads that continually turn in one direction and only the position within a revolution is of interest
to the user.

Relative moves with the wrap value set will move the relative distance called for. Example; if
the wrap value is set to 1000 and a relative move of 2500 is commanded, the axis will turn 2 2
revolutions.

Absolute moves will move the shortest distance to arrive at the programmed position. This could
be in the positive or negative direction. Moves programmed to a point greater than the wrap
value will cause an error.

12.5.8 Following Error Faults

When the position error reaches the programmed fault threshold, the amplifier immediately
faults. (The following error fault can be disabled at the configure faults tab on the main screen.)

12.5.9 Following Error Warnings

When the position error reaches the programmed warning threshold, the amplifier immediately
sets the following error warning bit in the status word. This bit can be read over the CAN network.
It can also be used to activate a digital output.
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12.5.10 Position and Velocity Tracking Windows

When the position error exceeds the programmed tracking window value, a status word bit is
set. The bit is not reset until the position error remains within the tracking window for the
programmed tracking time.

A similar method is used to handle velocity errors.

12.5.11 Following Error Fault Details

12.5.11.1 Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. When position error reaches the programmed
Following Error Fault level, the amplifier faults (unless the following error fault is disabled.) As
with a warning, a status bit is set. In addition, the fault is recorded in the error log. See Error
Log.

Additional responses and considerations depend on whether the fault is non-latched or latched,
as described below.

12.5.11.2 Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into velocity mode and
applies the Fast Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM
output stage remains enabled, and the amplifier holds the velocity at zero, using the velocity
loop.

12.5.11.3 Resuming Operations After a Non-Latched Following Error Fault

The clearing of a non-latched following error depends on the amplifier's mode of operation.
Issuing a new trajectory command over the CAN bus or the ASCII interface will clear the fault
and return the amplifier to normal operating condition.

If the amplifier is receiving position commands from the digital or differential inputs, then the
amplifier must be disabled and then re-enabled using the amplifier’s enable input or though
software commands. After re-enabling, the amplifier will operate normally.

12.5.11.4 Amplifier Response to a Latched Following Error Fault

When a latched following error fault occurs, the amplifier disables the output PWM stage without
first attempting to apply a deceleration rate.

12.5.11.5 Resuming Operations After a Latched Following Error Fault
A latched following error fault can be cleared using the steps used to clear other latched faults:
e Power-cycle the amplifier

e Cycle (disable and then enable) an enable input that is configured as
Enable with Clear Faults or Enable with Reset

e Access the CME 2 Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus
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12.6 Motor Characterization

This feature is only available for use with linear motors.

If motor specification cannot be obtained from the motor manufacturer due to obscolnece or
lack of good support, then the motor ratings label can be used.

Motor ratings label

Make sure motor is mounted firmly and verify accuracy and
completeness of motor data.

Failure to heed this warning can cause equipment damage, injury,
or death.

DANGER
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13 STEPPER TUNING
13.1 Stepper Motor Support

CME supports Copley’s stepper amplifier family. Stepper amplifiers can run in stepper mode or
servo mode.

This chapter describes controls that can be used to fine-tune a stepper amplifier in stepper
mode: Encoder Correction and Detent Compensation Gain. It also describes the screen used in
stepper mode to set Position Limits.

When a stepper amplifier is used in servo mode, it operates as a true, closed loop, servo amplifier
controlling a stepper motor. After putting the stepper amplifier into servo mode, set it up and
tune it just as you would a servo amplifier.

13.2 Position Limits (Stepper Amplifier)

Perform the following steps to set position limits for a stepper amplifier connected to an encoder
with Encoder Correction enabled (not operating in Servo mode).

. L. i Pos Limits .
Click the Pos Limits button L J on the Main screen.
Q Position Limits E = @

Trajectory Values

Commanded Position Velocity & Acceleration Commanded Current
» Limiter

Max Velocity: 0| rpm Max Accel.: 0 rps?

Clear Limits
Set Default Limits

Max Decel.: 0 rps?
Abort Decel. : 0/ rps?
Jerk: 0| rps?

Abort Jerk: 0 rps?

Close
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Parameter | Description

Max Velocity | Maximum trajectory velocity. Max value may depend upon the back EMF and
the Max feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load
inertia and peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit
value.

Max Decel Maximum trajectory deceleration. Max value may depend upon the load

inertia and peak current. Min:0 (disables limit). Default: 0.5 x velocity loop
Accel. Limit value.

Abort Decel Deceleration rate used by the trajectory generator when motion is aborted.
Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Jerk Rate of change of acceleration. The value of jerk set during the calculate
procedure produces an S-Curve whose maximum slope is equal to the
trajectory profile slope. This value will produce a maximum acceleration that
is not more than the initial default value of acceleration. Small values will
produce less jerking but will take longer to complete move. Large values will
produce more jerking and a more trapezoidal profile but will complete the
move faster.

Abort Jerk The value of Jerk used when a move is aborted.

Note that setting limits to zero disables the trajectory generator so that the command input
is not limited by the generator. Velocity is only limited by the Velocity Limit set in the Velocity
Loop.

13.3 Encoder Correction

For a stepper motor with an encoder, encoder correction may be used to compensate for lost
microsteps. Normally, in an open loop micro stepping mode with an encoder, the total number
of micro steps per revolution is set to the number of encoder counts per revolution. However, a
following error can accumulate when micro steps are lost.

In encoder correction mode, when a commanded position is not equal to the actual position,
indicated by encoder counts, the following error is multiplied by the Encoder Corrections
proportional gain (ECp), and micro steps are added to the open loop micro stepping loop.

If the error is large or the gain is high, micro steps are added at a higher rate, up to the Max
step rate limit. If the ECp gain is too high, the loop will become unstable and corrections will not
reduce the position error. The position error will not be reduced if the Max step rate is outside
of the motors stepping ability. If steps are lost during a move, encoder corrections are made
during the move, but will tend to accumulate during the trajectory profile and become resolved
by the end of the move.
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1. Click to open the Encoder Correction

Enc Comrection

screen.

@ Encoder Correct...

ECp: ol

Max Step Rate:

0 rpm

Close

2. Set the Encoder Correction parameters:

Parameter

Description

ECp

Proportional gain used to compensate for lost microsteps.
Default: 0.

Max Step Rate

Maximum velocity allowed while using ECp to correct
position errors. Excessive velocity can result in more lost
microsteps. Default: 0.

Test Encoder Correction
While holding position, introduce a position error by rotating the motor shaft by hand.
NOTE: Reduce the holding current slightly if unable to rotate shaft.

The ECp will act on the error and the motor will settle into position slower than a
servo motor but in a reasonable amount of time.

13.4 Detent Compensation Gain

Stepper motors are subject to torque detent that can cause undesired velocity fluctuation
between full steps of motion. The Detent gain feature can compensate for this detent.
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Detent
1. Click Detent 2k ‘to open the stepper amplifier Advanced Tuning screen.

@ Stepnet Advanced Tuning — X
Ready
Detent
Velodity: o : rom Gain: 0] &
[[] Auto Scale Lock
Trace Time:| 25 ms ~ Start Stop
Close

Setting Description
Velocity Tuning velocity. Default: 0.
Trace Time Length of trace interval to be shown on screen. Default: 25 ms.
Gain (Detent Gain) | The Stepper Detent Gain value. Default: 0.
Auto Scale Lock When selected, prevents trace display from rescaling during tuning.

2. Click Start to begin the tuning.

3. Adjust Velocity from 0 until the mechanical system begins to resonate. (Using a 1.8
degree step motor with 200 full steps, this will typically occur at a velocity of 40-70
rpm.)

4. Adjust Gain until the resonance increases, and then back it down until the resonance is
minimized.

5. Click Stop to stop the tuning.

Click Close to close the window.

7. On the CME Main screen, click Save to Flash .

119 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Homing

14 HOMING
14.1 Overview

The Homing screen allows homing to be configured and tested. Changes made to this screen
get saved to amplifier RAM. On amplifiers configured for Absolute encoders, calibration can be

performed.

Home
Click the Home button on the Main screen to open the Home screen
Home X
Software Limits
Positive: 0 | counts Deceleration Rate: 0 |rps?
Negative: 0 | counts
Disable
Method: Hardstop v
Direction of Motion
® (O Negative Offset: 1500 | counts
Current Threshold: 5.58 | A
Fast Velocity: 125 | rpm Current Delay Time: 250 | ms
Slow Velocity: 25 | rpm 4000 counts
Accel/Decel: 42 | rps? A
Actual Position: 0 counts
[] Test without home adjustments Homing Adjustment: counts
Home Stop Save Exit
Parameter Description

Software limits: Positive

Software limits: Negative

Position of user-defined travel limits that take effect after homing operation.

Rate

Software limits: Deceleration

Deceleration rate used to stop a motor when approaching a software limit.

Software limits: Disable

Disables the use of software limits by setting both limits to zero.

Method

Homing method. See
Homing Method Descriptions

Direction of Motion

Initial direction of motion for the homing method (Pos or Neg).

Fast Velocity

The velocity used to find a limit or home switch. Also used when moving to
an offset position, or a resolver or Servo Tube index position.

Slow Velocity The velocity used to find a switch edge, incremental or analog encoder index
pulse, or hard stop.
Accel/Decel The acceleration and deceleration rate used during homing.
Offset Execute a move of this distance after the reference is found. Set actual
position to 0 and call the new position home.
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Current Threshold

Current Delay Time

Hard stop home is reached when the amplifier outputs the homing Current
Limit continuously for the time specified in the Delay Time.

Following Warning

Shows the programmed following warning level.

Actual Current

Shows actual current being applied to windings during homing.

Actual Position

Shows the actual position of the axis.

Homing Adjustment

Shows the Home offset measured after homing is performed.

Test without home
adjustments

Selecting this option and pressing the Home Button tests the adjusted home
position without making any changes to the saved home position. The
resulting homing offset is reported in the Homing Adjustment text field.

Home

Starts the homing sequence using the settings shown on the screen.

Stop

Stops the homing sequence.

Calibrate

Starts the Calibration routine for absolute encoders. See Absolute Encoder
Calibration

Save

i

Saves the homing parameters to amplifier flash.

Exit

d

Discards unsaved homing parameters, then closes the screen. The rules for
discarding unsaved values are as follows:

e If the Save button was never clicked, all of the homing parameters
will be reverted to the values at the time that the screen was opened.

e If the Save button was clicked, then the homing parameters will be

reverted to the values at the time of the last Save event.
Upon closing, any home sequence in progress will be aborted.

14.2 Absolute Encoder Calibration

When absolute encoders are used, the absolute encoder value that corresponds to the zero
position in the machine’s reference frame is saved to flash memory in the drive. This value is
then added to the absolute encoder reading so that all position measurements are in absolute
units in the machine’s coordinate system. Movement of the motor to ‘find’ the machine’s
reference point is not necessary. This process is called calibration because it's done once when
the machine and drive are commissioned together and does not need to be repeated until the
encoder is changed, or adjustment of the machine-zero location is changed.

Note: This feature is only available on the Plus family of drives with a minimum firmware version
of 2.00.

Calibration of an absolute encoder is a two-part process:

1. Mechanical Homing
2. Calibration

14.2.1 Mechanical Homing

Mechanical homing is the process of moving the motor to the position that is machine-zero. This
is the location from which all dimensions are absolute in the machine’s position reference frame.
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Enter the values of the appropriate homing parameters.

Click the Home button lﬂl to run the home sequence.

Repeat if necessary until the motor is positioned at machine zero.

Click the Save button lsail

N o=

14.2.2 Calibration

Calibrating the encoder involves saving the absolute position at machine-zero to the drive’s
flash. This value will be saved as a negative number and added to the absolute encoder positions
thereafter by the firmware to convert them to machine absolute values. This value is stored in
the Home Offset parameter. CME provides a single button-click operation to perform this
calibration.

Click the Calibrate button I':ahbil to initiate the calibration routine.

CME will perform the following sequence:
e Set the calibration bit of the Homing Configuration register.
¢ Initiate the homing sequence.

The drive will then perform the following sequence:

o Run the home sequence.
L Save the Home Offset in flash.
Change the home method to Absolute Encoder Immediate Home.

The Homing Adjustment field on the Home screen will show the offset value saved in flash. Once
the calibration is complete, the Calibrate button will be disabled until another home sequence is
run by clicking the Home button. To remove the calibration, change the Home Method from
Absolute Encoder Immediate Home to some other method, and run the home sequence.
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15 CONTROL PANEL

15.1 Control Pa

Click to open the Cont

@ Control Panel

nel Overview

rol Panel ©.

Status Monitor
3 @ sTo: Active: STO-1, STO-2 off Bus\Voltage v v
‘Q/ @ Motor Output: Not Active
o @ Hardware Enabled: Not Enabled Actual Motor Velocity ™ - rpm
i @ Software Enabled: Not Enabled
: A Posltive Limit: NotActive Actual Motor Position Vv - counts
€ Negative Limit: Not Active
1 0 Software Limits: Not Active e icablad
' Motor Phase: oK .
€ Motion Abort Input: Not Active
{) CVM Control Program: Not Running Move
Home: Not Referenced Velocity 0| rpm
Network Status: Limit warning . §
Gain Scheduling: Not Active Aecsleation Jijffvse
Deceleration 0| rps?
Fault: Under Voltage
Control (] Enable Jog Move NEC love P

Enable

Disable

15.2 Status Ind

The Status area includes status indicator lights (described below) and a message box. Any red

Set Zero Position

Clear Faults Reset

icators and Messages

lights indicate that motion will be inhibited.

Indicator

States/Description

STO

State of the safety circuit. Enabled or HI/LO disabled. On amplifiers with
safety circuit.

Motor Output

State of the PWM output stage. Red if the output stage is inactive
(disabled)

Hardware Enabled

State of the hardware enable input(s). Red if one or more enable inputs
are inactive.

Software Enabled

State of the software enable. Red if the amplifier is disabled by software.

Positive Limit

State of the positive limit switch input. Red indicates an activated positive
limit switch.

Negative Limit

State of the negative limit switch input. Red indicates an activated negative
limit switch.

Software Limits

State of the software limits. Red indicates an activated software limit.

Motor Phase

Indicates a motor phasing error. Red indicates a motor phasing error
exists.

Motion Abort Input

State of the programmed Motion Abort Input. Red indicates the input is
active.
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CVM Control | Status of the CVM Control Program.
Program
Home Indicates whether the axis has successfully been referenced (homed).

Network Status

Status of the network communication. Yellow indicates warning limit
reached. Red indicates bus error detected.

Gain Scheduling

Indicates whether Gain Scheduling is active.

Indicates that a fault is active. Check the status message box for a

description of the most recent fault: Fault: Under Yolkage
Check the Error Log for a full history of faults and warnings.

Indicates that a warning is active. Check the status message box for a

description of the most recent: Warning: Paos Outside of Tracking Window
Check the Error Log for a full history of faults and warnings.

Message Box

Displays status descriptions.

15.3 Control Panel Monitor

The Control Panel Monitor displays real-time values of selected variables.

Monitor

Commanded Velocity

Actual Motor Velocity

Actual Motor Position

Mode: Disabled

-

- I

Monitor Variables

Actual Current

Following Error Passive Load Position

Actual Motor Velocity

Commanded Current Limited Position

Actual Motor Position

Commanded Velocity Analog Command

Actual Load Velocity

Commanded Position Bus Voltage

Actual Load Position

Profile Velocity Amplifier Temperature

Velocity Error

Profile Acceleration Motor Phase Angle

Mode: Displays the amplifier's operating mode in RAM. In camming mode it also displays the
active cam table number

15.4 Control Functions

The Control area of the screen provides functions related to overall amplifier control. The screen
options vary with model and configuration.
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Control
| Enable J [ Set Zero Position ]
{ Disable ‘ [ Clear Faults ‘ l Reset
Control Description
Enable Click to software enable the amplifier.
Disable Click to software disable the amplifier. This will also stop any CVM

programs that are running.

Set Zero Position Click to set the amplifier’s actual position counter to zero.
Clear Faults Click to clear all amplifier faults.

Reset Click to reset the amplifier.

Risk of unexpected or uncontrolled motion.

Using the CME, Set Zero Position function while the amplifier is
operating under external control could cause unexpected or

WARNING unc-ontrolled motion. - - -
Failure to heed this warning can cause equipment

damage.

15.5 Jog Mode
Jog mode provides a simple means for moving/jogging the motor.

Mave

Velodity 100|| rpm
Acceleration 500 | rps?
Deceleration 500 | rps?
/| Enable Jog | Move NEG | | Move POS |

1. To put the amplifier in jog mode, select Enable Jog.

2. Set up a jog move by setting the following mode-specific parameters:

Mode Parameter | Description

Current | Current Current applied to the motor. Limited by current loop
Continuous Current.

Warning: Unloaded motors may, depending on
torque setting, ramp up in speed very quickly.
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3.

Velocity | Jog Speed Velocity of the jog move. Limited by velocity loop Vel.
Limit.

Position | Velocity Velocity of the jog move. Limited by velocity loop Vel.
Limit.

Acceleration | Acceleration limit of the jog move.

Deceleration | Deceleration limit of the jog move.

Command the move:

Mode Steps

Current | Hold Pos to apply positive current to the motor or hold down Neg
to apply negative current to the motor.

Release the button to command zero current.

Velocity | Hold Jog Pos to command a forward velocity or hold down Jog
Neg to command a negative velocity.

Release the button to command zero velocity.

Position | Hold Move Pos to generate a forward move profile or hold Move
Neg to generate a negative move profile.

Release the button to stop movement.

NOTE: Position mode jog is accomplished by continuously updating
the commanded position. If a following error develops with
Following Error Fault disabled, motion will not stop on button
release. Instead, it stops when actual position = commanded
position.
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16 SCOPE
16.1 Overview

The Scope can be used to tune the amplifier, monitor performance, and perform diagnostics.
Function Generator and Profile Generator can drive the motor without external control. Auto Set
Up feature sets typical initial values for scope parameters.

@2 Scope = O X
File
‘ Trace Status: Ready
10 700 04
8 600 F0.3
6 5004 ro.2
£
& 4 5400 04 £
@ o o
g & | e T VO 9P | L
£ 2 5300 -y ¥ i ] el ApbdppdrmrefYf ¥ 00 %
>
o 2004 ““_H M W‘)J H—n..', ML," M r-0.1
-2 100 r-0.2
-4 [} T T T T T T T T T -0.3
0.00 0.05 0.10 0.15 0.20 0.25 0.30 035 0.40 045 0.50
Time (seconds)
Function Generator Profile Settings Gains Trajectory Limits Position Params Velocity Params Measurement
Move: Type: Ch 1| Profile Velocity Triguex e
g izlat:vtee (@))';r(a:p Ch 2| Disabled [[] AutoSetup
solu urve -
/] Single Trace
Ch 3| Actual Current i
- - = [] Auto Scale Lock
Distance: 4000 | counts Ch 4| Terminal Voltage Servo Approx. (Q)
; Trace Time: | 500 ms v
[[]Reverse and Repeat Ch 5| Disabled
Sample Rate: 188 ps
Ch 6| Disabled 5 3
Start
L.j Record Stop Trace Clear Close

16.2 Menu, Display and Controls

16.2.1File Menu

2 Scope
File

The File menu contains the options to save/restore scope settings. This feature is useful for
saving custom settings used for tests that are run frequently.

127 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Scope

File Menu

Save Settings

Saves current scope settings to a file

Restore Settings

Restores settings from a file

16.2.2 Display

To access the Trace Display menu, Right-click in the trace display area

Trace Status: ﬁeady

(L T U —— - - —r—r—r 30 160
0293 &E¢ Line Style P fine 222 1A
015 5 10 120

Preferences P plus >
010 4 ‘ ] Fo = 100
—_ s

T 0o0ns 53- @ connected plus -_102' 20 o<

Nt - -

- — T T m o

§000 27 A V. -203 60 @

- o -

2 ~
0.005 3 1-WM—.308 - 2
= — ,/’—’—‘M S
o - M G B ey 405 R
NIRRT SN SN SRS GRS _ . — <54 S S S S—— - 50 0
0m 2 Y o i e FE0 20
025 -3 T T T T T T T T T T 70 -40

000000 000025 000050 000075 000100 000125 000150 000175 000200 000225 000250 000275

Time (seconds)

Menu Parameter Description
Line Style line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.
connected plus Data points are plotted as plus signs and are connected with a line.
Preferences anti-aliasing When anti-aliasing is selected, the Scope removes screen-related
jaggedness in the displayed trace. Use of this feature may slow down
the refreshing of traces on slow computers.
grid When selected a grid is displayed on the scope screen.
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16.2.3 Trace Display Zoom

1. Hold the left mouse button down while dragging a box around the area of interest.
Trace Status: Ready

025 7 TrrvTRTYY
020 6
015 5 ‘T
010 4
7 £
I q
Z005 £34
[ £
5000 8 2
o o
-0.05 = 1
-0.10 0-
015 -1
-0.20 -2 T T T T T T T

0000 0002 0004 0006 0008 0010 0012 0014 C
Time (seconds)

2. Release the button to let the display zoom in on the selected area.
Trace Status: Ready |

015 5 10 120
010 4 ro 100
005 3 r-10= 80

o
=1
=

Velocity (rpm)
N
L
T
)
o

@
o

0113 Buinio)jo 4
() aBeyop,

[ urrent A)

005 2 14 304 40
2
]
010 0 -40% 20
015 -1 50 0
0m 2 T T T T T T 60 20

0.001 0.002 0.003 0.004 0.005 0.006 0.007 0.008
Time (seconds)

3. To restore the normal zoom level immediately, left-click anywhere on the trace.
(Normal zoom level is also restored when the next trigger event occurs.)

16.2.4 Controls

[ Record ] Lsmp Trace ] [ Clear ] [ Close

Action Description

= | Save a trace. See Scope Trace Files

Begins recording a trace
Stop Trace Stops recording a trace

Clears the trace from the screen and trace data from buffer
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AutoSetup
| Single Trace
Auto Scale Lock

Trace Time: [1.255 =

sample Rate: 500 ps

Function Description
When selected, the scope will be set up based on the setting for either the Function

Auto Setup or Profile Generator (whichever is active).
. When selected only one trace will be collected and displayed, otherwise a new
Single Trace - S
trace will be started as soon as the current trace is displayed.

When displaying the trace data, the scope will automatically scale the vertical axis
Auto Scale Lock for optimal viewing. When Auto Scale Lock is selected, the y-axis scale will be
locked at is current setting.

Trace Time This is the total amount of time the trace is recorded.

The rate at which each sample is collected. When tracing multiple channels, all

Sample Rate channels are collected at approximately the same time.

16.3 Function Generator

The Function generators can provide inputs to the different control loops for tuning and
diagnostics purposes without using an external control source.

Function Generator 'prof‘de‘

Apply To:  |Velodty o
Function: | Square Wave v
Amplitude: 200 | mm/s
Frequency: 5 Hz

Start Stop
| start |

The Start button starts the function or profile generator. The Stop button stops the generator
and aborts any profiles in progress.

Parameter Description
Apply To Control loop to which the Excitation will be applied: Current (available in all modes),
Velocity (available in velocity or position mode), or Position (available in position mode
only).
Function Function that will be applied to the control loop selected in the Apply To list box. The
choices vary with the control loop selected:
Selected Control Functions Available
Loop
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Current Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse, and Impulse
Velocity Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse
Position Sine Wave, Square Wave
Amplitude Amplitude of the command. Units vary depending on the value chosen in the
Apply To field.
Frequency (Sine Wave and Square Wave only.) Frequency of input command cycle.
Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input
pulse.

16.4 Profile Generator

| Function Generator | Profile ’

Move: Type:

) Relative () Trap

(") Absolute @ S Curve
Distance: 2000 counts

|| Reverse and Repeat

| start | | stop |
Parameter Description
Move Relative: Moves axis a specified distance from the starting position.
Absolute: Moves axis to a specific position.
Type Trap or S-Curve.
Distance Distance for Relative move.
Position Target position for Absolute move.

Reverse and Repeat | (Relative move only.) When selected, will continuously generate forward and
reverse moves of the distance specified until Stop is pressed.

16.5 Trace Channel Variables

Settings | Gains ITrajectc:urv;-I Limits I Position Params | Velod

&)

Actual Current

lisabled
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Click the Channel button to open the Trace Variable selection screen

Channel 1 Trace Variables @
Category Trace Variable
Disabled
Current Commanded Velocity
imied Veocty
Position Actual Mator Velocity
Acceleration elocity Error
Voltage Actual Load Velocity
Miscellaneous Unfiltered Motor Velodty
Digital Inputs Velocity Loop P Gain
Digital Outputs elodity Loop I Gain
Event Status Faults
Event Status Warnings
Event Status Misc,
Raw Encoder Signals
[ oK ] [ Cancel

Category Trace Variable

Disabled <Channel disabled, no associated variable>

Current Commanded Current, Actual Current, Limited Current, I2T Amplifier Accumulator,
I2T Motor Accumulator.

Velocity Profile Velocity, Commanded Velocity, Limited Velocity, Actual Motor Velocity, Actual
Load Velocity, Unfiltered Motor Velocity, Velocity Error

Position Commanded Position, Limited Position, Actual Load Position, Actual Motor Position,

Following Error, Passive Load Position

Acceleration

Profile Acceleration

Voltage

Analog Command, Bus Voltage, Analog sin Input, Analog cos Input, Terminal Voltage
Stepper, Terminal Voltage Servo

Miscellaneous

Motor Phase Angle, Amplifier Temperature, Hall States

Digital Inputs

Digital input line states

Digital Outputs

Digital output line states

Event Status | Short Circuit, Amp Over Temperature, Over Voltage, Under Voltage, Motor Over

Faults Temperature, Feedback Error, Motor Phasing Error, Following Error, Command Input
Fault, Amplifier Fault (a latched fault is active).

Event Status | Current Limited, Voltage Limited, Positive Limit Switch, Negative Limit Switch,

Warnings Following Warning, Velocity Limited, Acceleration Limited, Positive Software Limit,
Negative Software Limit, Pos Outside of Tracking Window, Vel Outside of Tracking
Window.

Event Status | Amp Disabled by Hardware, Amp Disabled by Software, Attempting to Stop Motor,

Misc. Motor Brake Active, PWM Outputs Disabled, Position Has Wrapped, Home Switch
Active, In Motion, Phase Not Initialized.

Raw Encoder | Primary Encoder A, Primary Encoder B, Primary Encoder X, Primary Encoder S,

Signals Secondary Encoder A, Secondary Encoder B, Secondary Encoder X, Secondary
Encoder S
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16.6Trigger Setup

Click the Trigger Setup button [MJ to open the Trigger Settings screen.

Trigger Settings X

Trigger Type: Above Level v

Trigger On: Channel 1 v

Position: Left v

Level: 100|| counts

Event Status Bit:

OK Cancel

Setting Description
Trigger Type Type Condition

Immediate Trigger

Trigger as soon as a trace is started (when the Record
button is pressed).

Rising Edge Trigger when the selected channel's input changes from
below to above the trigger level.

Falling Edge Trigger when the selected channel's input changes from
above to below the trigger level

Above Level Trigger as soon as the selected channel's input is greater
than or equal to the trigger level.

Below Level Trigger as soon as the selected channel's input is less than

or equal to the trigger level.

Function Generator

Trigger on the start of the next function generator cycle.

Input Level High/Lo

Trigger when specified input is high or low

Output
Active/Inactive

Trigger when specified output is active/inactive

Event Status Rising
Edge/Falling Edge

Trigger on the rising or falling edge of an event status bit.

Raw Encoder Signal
Level H/Lo

Triggers when the raw encoder signal is Hi/Lo

Trigger On

Selects which channel will be used as the trigger source.

Position

Selects placement of the trigger event on the screen. (Value is not configurable for
Immediate or Function Generator trigger types.).

e Left for optimal viewing of events following the trigger.
¢ Middle for optimal viewing of events preceding and following the trigger.
¢ Right for optimal viewing of events preceding the trigger.

Level

Sets the trigger level, in units appropriate to the channel selected.

Event Status Bit

With an event status trigger type selected, choose the status bit that will trigger
the trace. For descriptions of the event status word.
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16.7 Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three parameters
during an interval defined by adjustable cursors. The Cursor Data area displays a parameter’s
values at the left and right cursor locations, and the difference between the two values (Delta).
The Analysis area displays the minimum, maximum, average, and root mean square of the
parameters during the cursor period.

Cursors
@ Scope — O X
File
Trace Status: Ready
| | 1
10 700 04
1 o |
g8 6004 Fo.3
6 500 ro.z
Ea 53400 . Fo.1 g
e g
% 2 2300 ok i e e e
=3 \
0 2004 w il 0.1
st )\ T — | S—————— N ' P ——
-2 100 4 r-0.2
-4 o T T T T T T T T T 0.3
0.00 0.05 0.10 0.15 0.20 0.25 0.30 0.35 0.40 0.45 0.50
Time (seconds)
Function Generator  profile Settings Gains Trap i~ wembarams  Velocity Params Measurement
CursorData
Left Right Delta Min Max Avg rms  Units
AoplyTa:; [feocty x4 Time: 0.0692 0.1562  0.087 s
Function: | Square Wave v CH1 v 108,75 0 108,75 0 662,08 331.66 384.96 rpm
H4 2.4 1.2 1.2 -1.9 7 2.61 3.57 V
Amplitude: 150 | rpm SHio 5
CH4 v 2.4 1.2 1.2 -1.9 7 2.61 3.57 V
Frequency: 5| Hz
Start Stop
d Record Stop Trace Clear Close

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis fields show
calculations based on data from the entire trace cycle.

1. To display cursors and activate the Cursor Data fields, set Show Cursors
[V Show Cursors
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2. To move a cursor, click on the cursor and hold the left button while dragging the
cursor to the desired location. Release the left button to place the cursor in the new

location.

3. To select a parameter to measure and analyze within the cursors, choose a channel in
one of the three channel lists on the Measurement tab:

16.8 Control Loop Parameters

The Oscilloscope provides convenient access to all the control loop parameters that might be
used in tuning and diagnosing an amplifier. The user can adjust these parameters and see the
results immediately on the scope. Control loop parameters are accessed through a set of tabs,

shown below.

Settings | Gains |Trauj»av.:l:c:|r1,-I Limits | Position Params | Velocity Params | Measurement|

Position
Pp: 1000
Aff: 0
VT 163384

Velocity Current
Vp: a3 Cp: ns|
Vi 43| * Ci: 223 *

Note that the parameters represented on these tabs can also be accessed through the screens
used to configure the control loops and the digital position input. Changing a value in the Scope
tool automatically updates the value on the other screens where it appears, and vice versa.

Control loop parameter tab descriptions follow.

16.8.1 Gains Tab

Modes Gains Description For More Information
Pp Position loop proportional gain.
Position mode only | Aff Acceleration feed forward. Position Loop Gains
Vff Velocity feed forward.
Position or velocity | VP Velocity loop proportional gain. . .
- - - - Velocity Loop Gains
mode only Vi Velocity loop integral gain.
Cp Current loop proportional gain. Current Loop
] ] ] GainsError! Reference
All modes Ci Current loop integral gain. source not found.
ECp Encoder Correction Gain (Stepper only) | Encoder Correction
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16.8.2 Trajectory Limits Tab

Available in position mode.

’_S}_ggngs I Gains | Trajectory Limits | Position Params | Velocity Params | Measurement |

Maximum Velodty: 750 rpm
Maximum Acceleration: 250 | rps?
Maximum Deceleration: 250 | rps?
Maximum Jerk: 10000 | rps3

For more information see Position Loop Setup and Tuning.

16.8.3 Position Loop Parameters

Available in position mode.

| Settings | Gains | Trajectory Limits | Position Params | velocity Params | Measurement |

,_P el T 1 —————————————
vl ’ Actual Position: 120000 counts
Window: 4096 counts
Set Zero Position
Time: 10 \ms
Following Error: 16384 | counts

[ ] Disable Following Error Fault

Set Zero Position sets the amplifier's actual position count to zero. For more information, see
Position Loop Setup and Tuning.

16.8.4 Velocity Loop Parameters

Available in position and velocity modes.

‘ Settings | Gains l Trajectory Limits ] Position Params I Velocity Params Measurementi

-Velocity Tracking
Window: 146 | rpm Accel Limit: 500 rps2
Time: 100 | ms Decel Limit: 500 rps2

For information see Velocity Loop Setup and Tuning.Initial current loop proportional gain (Cp)
and current loop integral gain (Ci) values can be calculated with Calculate.
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_ ™
Click I Loop G to open the Current Loop screen:

@ Current Loop

Commanded

Current +

Peak Current Limit: 1.24

I2T Time Limit: 1000

Continuous Current Limit: 1.24

> Input | | Cument I
; | Fiters [ | Limiter \
+
E
E o Commanded
— Voltage
L

“T

A

ms

A

Actual Current

Cp: 1

Ci: 0

Drive Output
(®) Maximize Smoothness
Current Loop Offset: 0A
(O Maximize Speed
Cur nA [[] Enable Bus Clamping
Auto Tune Bandwidth
Close
Parameter Description

Peak Current Limit

Used to limit the peak phase current to the motor. Max value depends
upon the amplifier model; Min value > continuous limit.

I2T Time Limit

Sets I2T Time Limit in ms. See I2T Limit Algorithm.

Continuous Current Limit

Used to limit the Phase Current. Max Value is < Peak Current and
depends upon the amplifier model. Min value: 0

Current Loop Offset

Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Error! Reference source not found.

Cp

Current loop proportional gain. Range 0 - 32,767.

Ci

Current loop integral gain. Range 0 - 32,767.

Current Ramp (mA/s)

Used only when in current mode. Default value is 0 which disables the
ramp rate limit.

Drive Output

Maximize Smoothness: Amplifier uses circular vector limiting to
produce smooth operation even into the voltage limits.

Maximize Speed: Allows for slightly more of the bus voltage to be used
when in the voltage limit. This may produce a small disturbance at top
speed.

Enable Bus Clamping

Checking the option disables space vector modulation and may reduce
120 Hz AC line ripple when holding position near zero current. If
unchecked may allow for higher speeds.

Auto Tune

See Current Loop Auto Tune.Error! Reference source not found.
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Bandwidth Measure bandwidth using the Cp and Ci values now in the amplifier.

16.8.5 Current Loop Manual Tune

NOTE:
* During tuning, observe any warnings or faults that appear in the status bar of
the scope.
» Some users prefer the Auto Tune feature. See Current Loop Auto Tune.

B
11. Click the Scope Tool L

Apply To: | Current v

12.Choose Current from the Function Generator Apply To: drop list.
. v/| AutoSetu .
13. On the Settings tab, make sure Auto Setup 3 is selected. Auto Setup
automatically sets the following parameters:
Function Generator Tab
Parameter Description
Function Square Wave.
Amplitude 10% of continuous current value.
Frequency 100 Hz.
Settings Tab
Channel 1 Commanded current (green).
Channel 2 Actual current (white).
Amplitude: 0.47)| A
14. Verify that the Amplitude value D U is not excessive for the
motor.

15.  Click Start 52t |

16. On the Gains tab, adjust current loop proportional gain (Cp) and the current loop

integral gain (CI) to obtain a desired wave form.

138

= Set current loop integral gain (Ci) to zero.

= Raise or lower Cp to obtain desired step response. (Typically, little or no
overshoot with a 100 Hz, low-current square wave.) If the Cp value is too
large, ringing may occur. If the Cp value is too low, bandwidth decreases.
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Current
A
Cp: 4000 >
Cit 200
v

17. Adjust current loop integral gain (Ci) until desired settling time is obtained.

Note: The image below shows a good example of a good current loop tuning, in which
the wave forms for commanded and the actual current are very similar, without any
ringing or overshoot.

Trace Status: Reading trace data from amplifier

05

! " [

2017 ‘ l

$ 0.0

E
©.0.11
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05 T T T T T T T T T T T T

0.000 0.002 0.004 0.006 0.008 0.010 0.012 0.014 0.016 0.018 0.020 0.022 0.024 0.026
Time (seconds)

18. Press Stop I&LI to stop the function generator.

I),.:.:U‘
19. On the Main screen, click Save to Flash Mto avoid losing the changes.

20. On the main screen, select |M and click on Bandwidth to measure the
bandwidth. Verify that the bandwidth measured is sufficient for the application.
Typical bandwidth value is 1.2kHz £ 200 Hz.

16.8.6 Current Loop Auto Tune
The current loop Auto Tune algorithm applies a square-wave command to the current loop
and adjusts current loop proportional gain (Cp) and current loop integral gain (Ci) until a
desirable waveform is obtained.
Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

IL
7. Click I Loop ij to open the Current Loop screen:
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@ Current Loop

Commanded

Peak Current Limit:

13T Time Limit:

urrent Ramp:

Curent  +/"

=

Continuous Current Limit:

Current Loop Offset:

Ball-

Curent
Limiter

+/ Voltage
—bl Cp+Ci

|

Commanded

Actual Current

124 A

1000 | ms

124 /A

oA

0 |majs

Cp: 1
Ci: o
Drive Output
(@ Maximize Smoothness
(O Maximize Speed
[] Enable Bus Clamping

Auto Tune Bandwidth

Close.

8. Verify that the amplifier is hardware enabled.

) Auto Ti
9. Click Auto Tune to open the screen and start the Current Loop Auto

Tune.

Q Auto Tune

Auto Tune Current:

0 G

1A

Status: Auto Tune in progress.

Close

10. To Change the Auto Tune Current, click Stop. Enter the new current in the Auto
Tune Current field, and then click Start.

11. Observe the Auto Tune process and results.

A typical example is given below:
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Set Cp and Ci to zero and adjust Cp and Ci for optimal values.

@ Auto Tune

X

25

P

2.0
1.5 [
31.0- /
£ 05
Fool/
30.0 f
051 |
BERE N
54/

-2.0 T T T
0.0000 0.0005 0.0010 0.0015

Auto Tune Current: 2[A
Ci: 0

Cp: | 2538

T T T
0.0020 0.0025 0.0030
Time (seconds)

0.0035 0.0040 0.0045

Status: Auto Tune in progress.

Start Close

0.0050

Use a frequency sweep to determine the small signal, current loop bandwidth.

Q Auto Tune

1.25
1.00
075
_ 050
L 025+
e

§ 0.00
gozs1 VY
0509 1| | |

0754 4f | 1o

-1.00 4

T T T

-1.25 T T T T
0000 0005 0010 0015 0020

Auto Tune Current: 1A

Cp: 2125 Ci 212

T T T T T
0025 0030 0035 0040 0045 0050 0.055
Time (seconds)

0.060

Status: Measuring Bandwidth

Start

Close

0.065

are displayed.

@ Auto Tune Results

Auto Tune Measured Values:

Cp: 1532
Ci: 325
Bandwidth: 1400 Hz

X

Cancel

A set of Cp and Ci alternatives, and the bandwidth measured using the high Cp and Ci values

12.Click OK to keep the new Cp and Ci values in RAM that auto tune measured. Click
Cancel to restore the original Cp and Ci values.

13.

Notes on the Current Mode and Current Loop
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16.8.7
16.8.8Current Loop Diagram

16.8.9As shown below, the “front end” of the current loop is a limiting stage. The
limiting stage accepts a current command, applies limits, and passes a limited
current command to the summing junction. The summing junction takes the
commanded current, subtracts the actual current (represented by the
feedback signal), and produces an error signal. This error signal is then
processed using the integral and proportional gains to produce a command.
This command is then applied to the amplifier's power stage.

Current Loop
PWM
—l|' Current Integral Gain (Ci) | + | Command
. - + :
Current Command—| Current Limiter |Limited Current =®_.‘ Current Proportional Gain (Cp) }22)_ . _»
+

Current Offset —1 f\_ el

Limits: Feedback (Actual Current)

® Peak Current

e Continuous Current
e Peak Current Limit Time

Current Loop Inputs

The amplifier’s analog or PWM inputs.

A CANopen network via the amplifier's CAN interface.

A Copley Virtual Motion (CVM) control program.

The amplifier’s internal function generator.

In velocity or position modes, the current command is generated by the velocity loop.
Offset

The current loop offset is intended for use in applications where there is a constant force applied
to, or required of, the servomotor and the system must control this force. Typical applications
would be a vertical axis holding against gravity, or web tensioning. This offset value is summed
with the current command before the limiting stage.

Limits
The current command is limited based on the following parameters:
Limiter 21.Description

. Peak current | 22.Maximum current that can be generated by the amplifier for a short
Limit duration of time. This value cannot exceed the peak current rating
of the amplifier.

. Continuous | 23.Maximum current that can be constantly generated by the amplifier.
Current Limit

e I2T Time Limit 24.Maximum amount of time that the peak current can be applied to
the motor before it must be reduced to the continuous limit or
generate a fault.

For more details, see I2T Time Limit Algorithm.

Note: Although the current limits set by the user may exceed the amplifier's
internal limits, the amplifier operates using both sets of limits in parallel, and
therefore will not exceed its own internal limits regardless of the values
programmed.
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. Ramp 25.Rate of change in current command. Used to limit jog moves
initiated from the Control Panel Jog function in current mode, and in
advanced Indexer Program functions.

26.
27. Current Loop Gains
28.

Gain 29.Description

Cp - | 30.The current error (the difference between the actual and the limited

Current commanded current) is multiplied by this value. The primary effect of this

loop gain is to increase bandwidth (or decrease the step-response time) as the

proportional gain is increased.

Ci - | 31.The integral of the current error is multiplied by this value. Integral gain

Current reduces the current error to zero over time. It controls the DC accuracy of

loop the loop, or the flatness of the top of a square wave signal. The error

integral integral is the accumulated sum of the current error value over time.

32. Current Loop Output
33. The output of the current loop is a command that sets the duty cycle of the PWM

output stage of the amplifier.

Velocity Loop Setup and Tuning

34.

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi)

values can be calculated with Calculate.

35.

Locop ‘

v
Click the V Loop button l on the Main screen (contents vary with model

and configuration):
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@ Velocity Loop 5 X

Commanded

Veloci Velocity & Accel. Input ]
Limiter Filter

. C
+ g
> P Gains _ﬂ Output Current
et g shitt Fiters

Vp
+ d f

* Actual Velocity

Vel. Limit: 1500 | rpm Accel, Limit: 500 | rps? Vp: 7339|
5 [[] Low Gains Shift

Decel, Limit: 500 | rPs* Vi: 1631

Fast Stop Ramp: 500 | rps2 ViDrain: 0

[[] Disable Gains

Trackin
2 Vcff: 0

Window: 300 | rpm
Time: 100 | ms

Close

[ J
« P 36.Description
a
r
da
m
et
e
r
« V 37.Top speed limit. Max value may depend upon the back EMF & the Encoder value.
el Min value: 0.
o
ci
ty
Li
mit

« A 38.Maximum acceleration rate. Max value may depend upon load, inertia, & peak
C current. Min value: 1. (Does not apply in position mode.)
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« D 39.Maximum deceleration rate. Max value may depend upon load, inertia, & peak
e current. Min value: 1. (Does not apply in position mode.)

OW  40.See Position and Velocity Tracking Windows

41.Velocity loop proportional gain. Range: 0 to 32,767.

i 42.Velocity loop integral gain. Range: 0 to 32,767.

. F 43.Deceleration rate used by the velocity loop when the amplifier is hardware
a disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit value.
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Sto

Ra
mp

. .Increases the resolution of the units used to express Vp and Vi, providing more
L 441 th lution of the unit dt Vp and Vi idi
o precise tuning. For more information, see Velocity Gains Shift.

Gai
ns
Shi
ft

« H 45.Decreases the resolution of the units used to express Vp and Vi, providing more
i precise tuning. For more information, see Velocity Gains Shift.

Gai
ns
Shi
ft

« Vi 46.Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain
Dr value, the faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.
ain
(int
egr
al
ble
ed)

« V  47.Velocity loop command feed forward. The input command to the velocity loop
cf (after limiting) is scaled by this value and added to the output of the velocity loop.
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49. Manually Tune the Velocity Loop

50. NOTE: During tuning, observe any warnings that appear to the left of the trace.
L

Click the Scope Too

Apply To: V

Choose Velocity ' from the Function Generator Apply To: drop list.

AutoSetup

51. On the Settings tab, make sure Auto Setup is selected.

Auto Setup automatically sets the following parameters:

. Function

Generator Tab

Function  52.Square Wave
Amplitude 53.10% of maximum velocity value

Frequency 54.5Hz

Settings
Tab

Channel 1 55.Limited velocity (green)

Channel 2 56.Actual Motor Velocity (white)

Amplitude: 200 | rpm

57. Verify that the amplitude value is not excessive for the

motor.

58. Click Start 5=t |

59. On the Gains tab, adjust velocity loop proportional gain (Vp):
Set velocity loop integral gain (Vi) to zero.

Raise or lower proportional gain (Vp) to obtain desired step response. (Typically, little or no
overshoot on a 5 Hz small, slow-speed square wave.)

60.
Velodty

A

Vp: 74 -

Vi 30| ®

v
61.
62.
63.

64. Adjust velocity loop integral gain (Vi) until desired settling time is obtained.

65. Note: The image below shows a good example of a good velocity loop tuning, in
which the wave forms for commanded and the actual velocity are very similar.
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Trace Status: Reading trace data from amplifier

Velocity (rpm)

0.00 0.05 0.10 0.15 0.20 0.25 0.30 035 0.40 0.45 0.50
Time (seconds)

66.

67. Click Stop ISL‘ to stop the function generator.

68. On the Main screen, click Save to Flash L. to avoid losing the changes.
69. Notes on the Velocity Mode and Velocity Loop

Velocity Loop Diagram

= As shown below, the velocity loop limiting stage accepts a velocity command, applies
limits, and passes a limited velocity command to the input filter. The filter then passes a
velocity command to the summing junction. The summing junction subtracts the actual
velocity, represented by the feedback signal, and produces an error signal. (The velocity
loop feedback signal is always from the motor feedback device even when an additional
encoder is attached to the load.) The error signal is then processed using the integral and
proportional gains to produce a current command. Programmable digital filters are
provided on both the input and output command signals.

Velocity Loop
_>1 Velocity Integral Gain (Vi |
Velocity Limited y 9 V) S N
. . - + ;

Command ™ Velocity Limiter |» gjter Velocity L 7 Z Velocity Proportional Gain (Vp) }_:@‘_’ Filter | .

Limits: |

« Velocity

Feedback (Derived Velocity)

e Acceleration*

e Deceleration*

« Emergency Stop Deceleration*
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

= Inputs
= In velocity mode, the velocity command comes from one of the
following:

» The amplifier’s analog or PWM inputs.

= A CANopen network via the amplifier’'s CAN interface.

= A Copley Virtual Motion (CVM) control program.

= The amplifier’s internal function generator.

= In position mode, the velocity command is generated by the position
loop.

=  Velocity Loop Limits

The velocity command is limited based on the following set of parameters designed
to protect the motor and/or the mechanical system.
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Limiter

70.Description

Velocity Limit 71.Sets the maximum velocity command input to the velocity loop.

Limit

Acceleration | 72.Limits the maximum acceleration rate of the commanded velocity

input to the velocity loop.

This limit is used in velocity mode only. In position mode, the trajectory
generator handles acceleration limiting.

Limit

Deceleration | 73.Limits the maximum deceleration rate of the commanded velocity

input to the velocity loop.

This limit is used in velocity mode only. In position mode, the trajectory
generator handles deceleration limiting.

Fast stop Ramp 74.Specifies the deceleration rate used by the velocity loop when the

amplifier is hardware disabled. (Fast stop ramp is not used when
amplifier is software disabled.) If the brake output is active, the
fast stop ramp is used to decelerate the motor before applying the
brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the
trajectory generator handles controlled stopping of the motor. There is one
exception: if a non-latched following error occurs in position mode, then the
amplifier drops into velocity mode and the Fast Stop Ramp is used.

75.
76.
77.

Diagram: Effects of Limits on Velocity Command

The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity
; -\ - - — -\

Vel Limit- — — 4 -

I I —

I
Accel Limit == f=-— |=+— Decel Limit —=

Velocity Loop Gains

78. The velocity loop uses these gains:
Gain 79.Description
Vp - 80.The velocity error (the difference between the actual and the limited
Velocity commanded velocity) is multiplied by this gain. The primary effect of this
149 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019




Scope

loop gain is to increase bandwidth (or decrease the step-response time) as the
proportional gain is increased.

Vi - 81.The integral of the velocity error is multiplied by this value. Integral gain
Velocity reduces the velocity error to zero over time. It controls the DC accuracy of
loop the loop, or the flatness of the top of a square wave signal. The error
integral integral is the accumulated sum of the velocity error value over time.

82. Velocity Gains Shift

83. The Velocity Gains Shift feature adjusts the resolution of the units used to
express Vp and Vi, providing more precise tuning. If the non-scaled value of Vp or
Vi is 64 or less, the Low Gains Shift option is available to increase the gains
adjustment resolution. (Such low values are likely to be called for when tuning a
linear motor with an encoder resolution finer than a micrometer.) If the non-scaled
value of Vp or Vi is 24001 or higher, the High Gains Shift option is available to
decrease the gains adjustment resolution.

Velocity Loop Filters
See Standard Filter Types.
84. Velocity Loop Outputs

85. The output of the velocity loop is a current command used as the input to the
current loop.

86. Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. Velocity error is the difference between
commanded and actual velocity.

87. When the position or velocity error exceeds the programmed tracking window
value, a status word bit is set. The bit is not reset until the error remains within the
tracking window for the programmed tracking time.

Velocity Tracking lllustration
= The following diagram illustrates the use of tracking window and time settings in
velocity mode.
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Actual Velocity
Limited Velocity \

* Tracking Window

J/ | Tracking |

a—

Time
/ |

Tracking Window
Output

Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and
acceleration feed forward (Aff) values can be calculated with Calculate.

[PLoop‘

Click the P Loop button on the Main screen.
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Pa
ra

ter
Aff

VFff

Pp
Ga
ins
Multi
plier

Fol
lo

152

.} Position Loop EI = @
Trajectory Values | Position Loop Values
Profile Acceleration
- Aff
Profile Velocity
RV
+‘ Commanded
FN 7 Welocity
[ | . Gains
i Multipfier
A
Pp
Limited Posiion ~ +
| PiDrain — | P
Pd
I} Actual Position
Pp: 1000 Pi: 0 Aff: a Gainz Multiplier: 1
Pi Dirain: vf: 16384
100% VIf = 16384
pd: 0
Enable PID
Following Error Tracking Position Wrap
Fault: 4000 | counts Window: 1000 | counts
Warning: 2000 | counts Time: 10 | ms
Disable Fault
Close

88.Description

89.Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits

90.Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
Trajectory Limits

91.Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits
92.Position loop output is multiplied by this value before going to the velocity loop. In

dual encoder systems, the multiplier’s initial value is calculated based on the ratio
of motor encoder turns to position encoder turns.

93.The level (in encoder counts) at which the following error produces a fault, which
stops the servo loop. We recommend raising the fault level before tuning the loop.
See Following Error Faults
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wi
ng
Error

Fault

Fol 94.The level (in counts) at which the following error produces a warning (without
lo stopping the loop). See Following Error Warnings

wi
ng

Error
Warn

ing

Di 95.Stops following error from faulting. See Following Error Faults
Sa

ble

Fault

Tr 96.Width of tracking window in counts. See Position and Velocity Tracking Windows

ac
kin

Wind

Tr 97.Position must remain in the tracking window for this amount of time to be
considered tracking. See Position and Velocity Tracking Windows

Pi  98.Position loop integral gain
Pd 99.Position loop derivative gain

Pi  100. Position loop integral drain
Drain

En 101. Enables the PID parameters
abl

PID

. Cl
ic

the
Pos
itio

Wr
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Pos
itio
Wr
ap.
Parai
Motor
Wrap

Load
Wrap

102.
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Click
on
the
Traj
ecto
ry
Val
ues
tab.

@ Position

Trajectory

Comn

Clez

Set De:

Pa 103. Description
ra

me

ter

Ma 104. Maximum trajectory velocity. Max value may depend upon the back EMF and
X the Max feedback count. Min:0. Default: 0.25 x motor velocity limit.

Veloc
ity
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105. Maximum trajectory acceleration. Max value may depend upon the load inertia
and peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

106. Maximum trajectory deceleration. Max value may depend upon the load inertia
and peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit
value.

107. Deceleration rate used by the trajectory generator when motion is aborted.
Min:0. Default: 0.5 x velocity loop Accel. Limit value.

108. Rate of change of acceleration. The value of jerk set during the calculate
procedure produces an S-Curve whose maximum slope is equal to the trajectory
profile slope. This value will produce a maximum acceleration that is not more
than the initial default value of acceleration. Small values will produce less jerking
but will take longer to complete move. Large values will produce more jerking and
a more trapezoidal profile but will complete the move faster.
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109.
110.
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112. Manually Tune the Position Loop

113. NOTE: During tuning, observe warnings that appear to the left of the trace.
. L.d
114. Click the Scope Tool =/,

atordi Profile

115. Select the Profile tab =

116. On the Settings tab, make sure Auto Setup ¥/ Auto Setup

automatically sets the following parameters:

is selected. Auto Setup

Profile Tab

Move Relative

Type Trap

Distance 2000 counts

Reverse and Not selected

repeat

Settings Tab

Channel 1 Profile velocity (green)
Channel 2 Following error (white)

117. If the Auto Setup default profile distance is not appropriate, enter an appropriate
. Distance: 2000 counts
short distance .

118. Click Start l_ﬂ_l The Profile Generator executes a short move.
NOTES:

» The profile may not reach constant velocity during a short move.

» If a following error occurs, open the Control Panel and click Clear Faults.

119. Set up a trapezoidal profile by setting the trajectory limits and distance.
120. See table
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| Settings | Gains | Trajectory Limits | Position Params | Velodity Params | Measurement

Maximum Velocity: 1500 | rpm
Maximum Acceleration: 500 | rps?
Maximum Deceleration: 500 | rps?

121. and

| Function Generator | Profile |

Move: Type:
@ Relative @ Trap
") Absolute ) S Curve

Distance: 2000 | counts

122.
123.

. Trajectory
Limits Tab

. Maximum
Velocity

- Maximum 124. Set values typical of those expected to be used in the application.
Acceleration

. Maximum

Deceleration

. Profile Tab

. Distance 125. Set the move distance to produce a complete trajectory profile.
Be sure that this distance does not exceed mechanical limits of the

system.
. Move 126. Relative
. Type 127. Trap

128.
129. Adjust position proportional gain (Pp) to minimize following error:

130. On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward
(Aff) to zero.

On the Profile tab, click Start. On the Gains tab, adjust position loop proportional
gain (Pp) until best result is obtained.
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Click Start after each adjustment to test on a new profile move.

131.

132.
133.

134.
135.
136.

Position

Pp: 5000]
Aff: =
vff: | 16384

NOTE:
Too much position loop proportional gain (Pp) might cause oscillation.

If a following error occurs, open the Control Panel and click Clear Faults.

Adjust velocity feed forward (Vff):

137.

Velocity feed forward (Vff) reduces following error in the constant velocity

portion of the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides
best results.

Click in the Vff field and adjust the value.
Click Start after each adjustment to test on a new profile move.

= Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile
acceleration and deceleration.

Click in the Aff field and adjust the value.

Click Start after each adjustment to test on a new profile move.

NOTE:

1) If, after tuning the position loop, the motor makes a low frequency
audible noise while enabled but not moving, the velocity loop gains (Vp and
Vi) may be lowered to reduce the noise. If the gain values are set too low, the
response to instantaneous rates of change might be reduced (i.e., slow
correction to disturbances or transients).

2) If the amplifier is set up to run in position mode under analog input
command, and the analog command signal produces too much noise at the
motor after tuning, the Analog Command Filter or the Velocity Loop Command
Filter may be used to reduce the noise further.

Tune to multiple sets of profiles representing typical moves that might be executed

in the application. Starting with Step 6, repeat the process as needed.

Note: The image below shows a good example of a good position loop tuning.

161
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138.
139.

16.9 Scope Trace Files

The Oscilloscope can save trace data to disk that can be opened later with the Trace Viewer.
When the save trace data to disk operation is performed, CME 2 saves the data in three different
files:
e .sco: This is a CME 2 format which contains scope settings and trace data
e .csv: This is a standard comma-separated value file format that can be imported into
spreadsheet software like Microsoft Excel.
e .txt: This is a tab-separated value file similar to the .csv file. This is intended to be
imported by software that can only read tab-separated values.
The format of the .csv and the .txt files are identical except for the separator:
Column 1: time
Column 2: Trace Channel 1 data
Column 3: Trace Channel 2 data (if used)
Column n: Trace Channel n data (if used)
The trace data is in amplifier units, not user units (see Parameter Dictionary for units).

16.10 Trace Viewer

The Trace Viewer screen displays the contents of .sco files. All of the trace display features
(zooming, line style, etc.) as well as the measurement functions are available in this screen.

1. On the Main screen, choose Tools>View Scope Files to open the window.
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2. Click Open File. When prompted, select the name of the file you wish to open. Then, click
Open to display the file in the Trace Viewer window.

@2 Trace Viewer (Test.sco) - a X
i 9 1000 0.30
8 Q00 0.25
7 200 020
] 7001 [0.15
5 600 0.10
4 £ 500 0.05
e s g
§3§400 f AAAA, “ ' i A A A AR AR A \ 'i‘..' -D.Oug
£ = =
»2 % 300 i 005"
1 2001 g [-0.10
f A AR
” o | ) s gt r RE 020
2 -100 025
3 200 T T T T T T T T T -0.30
0.00 0.05 0.10 0.15 020 025 030 035 0.40 0.45 050
Time
Settings  Measurement
~Function Generator Scope Trigger
Ch 1: Profile Velocity Type: Immediate Trigger
WYTQ: ronie veioaty
Ch 2: Disabled Apoly To: N
Excitation: Square Wave 02
Ch 3: Actual Current
Amplitude: 150 rpm Ch 4: Terminal Voltage Servo Approx. (Q) Position:  N/A
Period: 5 Hz Ch 5: Disabled Level: A
Ch 6: Disabled
Trace Time: | 500 ms
Close
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17 FILTERS
17.1 Filter Settings

The Filter Settings tab opens a window that shows what filters have been selected.

@ Filter Configuration - X
Filter Settings! Analog VLoop ILloop InputShaping
Type Family Poles Frequency
Analog Reference Disabled
v Loop Input Disabled
V Loop Output 1 Low Pass Butterworth 2 200
V Loop Output 2 Disabled
V Loop Output 3 Disabled
ILoop Input 1 Disabled
ILoop Input 2 Disabled

Input Shaping Disabled 0.1

Close

17.2 Filter Configuration Windows

Along with the location of a cut-off frequency on the filter curve, there are several filter
configuration parameters available depending on the initial choice of: Standard Filter
Types and Standard Filter Families.

Filter configuration choices may include:
e Number of Poles (the location of a cut-off frequency on the filter curve)
e Cut Off Frequency
e Frequency 2 (If two poles are chosen)
e Pass Band Ripple
e Stop Band Ripple

17.3 Setting Parameters

To change or view filter configurations follow these steps:

X . Configure Filters .
1. Choose the Configure Filters button from the main screen to open the
Filter Configuration screen.

2. To view present filter settings, choose the Filter Settings tab. Choose other tabs to
configure Analog, V Loop, I Loop or Input Shaping settings.

@3 Filter Configuration

EAnalog VLioop Iloop InputShaping
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17.4 Input Shaping

Input shaping is a method by which unwanted command induced vibrations are kept to a
minimum by damping them with superimposed impulses. This produces a command that will
drive the system with limited residual vibration.

To set the input shaping parameters, first measure the mechanical frequency; see
Measuring Mechanical Vibration.

Below is a diagram of the input shaping process.

Step Command Input Output Command
Shapin
A Ping A _Ii
Time - T , Time
0 0 Tl

Below is a sensitivity curve. When F = Fm, there is zero vibration.

25 —

20 —

15 —

Percentage Vibration

0.6

Frequency (F/Fm)

17.4.1 Analog

The Analog tab opens a window that shows analog filter choices and a representative
curve. Modify the settings as needed and press Apply.
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@ Filter Configuration - X
Filter Settings Analog VLoop Iloop InputShaping
Analog Reference Input > Analog Reference Selected Loop Input
Filter
Type: Apply
Family: Butterworth v
Default
O 1pole @ 2Pole
Cut Off Frequency (Fc) 200 [Hz 4g
Frequency 2 (F2) 0| Hz < -40dB
: decade
Pass Band Ripple (Rp) 0l|db
Stop Band Ripple (Rs) 0l|db
t
Fc
Close

17.4.2 Velocity Loop
The V Loop tab opens a window that shows Velocity Loop filter choices and a
representative curve. Modify the settings as needed and press Apply. Selecting Default
will supply a 200 Hz Low Pass filter to the first velocity loop output filter.

D Filter Configuration - X
Filter Settings Analog VL00p Iloop InputShaping
C
Veloci Velocity & Accel. Input Velocity
Limiter Filter Controller
C
Output Output Output Curmrent
Filter 1 Filter 2 Filter 3
(O Input Filter
Type: Low Pass v Apply
O)!
Family: Butterworth v
(O Output Filter 2 Default
1pole 2Pole
(O Output Filter 3 O1pd O)
Cut Off Frequency (Fc) 200 Hz g4g
Frequency 2 (F2) 0 |Hz 248 -40dB
decade
Pass Band Ripple (Rp) 0!db
Stop Band Ripple (Rs) 0ldb
FIC
Close
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17.4.3 Current Loop

The I Loop tab opens a window that shows Current Loop filter choices and a
representative curve. Modify the settings as needed and press Apply.

@ Filter Configuration - X

Filter Settings Analog VLloop ILoop  InputShaping

. Commanded

| Current Command || mnput I Input l_>[ Current | Current Vot
= Filter 1 | Fiter2 | [ Limiter | Controller

Type: A
@ Input 1 e -t pply
Family: Butterworth v
Olnput 2 Default
@® 1pole O 2Pole
Cut Off Frequency (Fc) 0| Hz

dB
-3d8

oy 2 (F2) =i
' Al 20d8
ipple (Rp) oldb decade
|
d Ripple (Rs) oldb {

Fc

Close

17.5 Standard Filter Types

17.5.1 Low Pass Filter
Frequencies below the selectable cut-off are allowed to pass.

Example:

dB

+* =3dB
-40dB
decade

Fc

17.5.2 High Pass Filter
Frequencies above the selectable cut-off are allowed to pass.
Example:
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dB
3dB

40d8
decade

Fe

17.5.3 Notch Filter

Notch filters allow a bandstop in a range between two selectable frequencies. It may be
Butterworth (no ripple), Chebyshev (selectable passband ripple), or elliptical (ripple on both
passband and bandstop).

Example:
di l

&*

_f_

Fp

F.1 F.2

17.5.4 Band Pass Filter
Band pass filters allow a range of frequencies, between two selectable cut-offs, to pass. It may
be Butterworth, Chebyshev, or Elliptical.

di L

Rp

17.5.5 Custom Biquad Filter

The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the
denominator. The numerator affects the filter’s two zeros and the denominator affects the filter’s
two poles. Many filter classes and types can be expressed in the Bi-Quad form by entering the
coefficients. The coefficients can be calculated using any commercially available math software
package and entered as floating-point numbers. However, due to the fixed-point representation,
the numbers may be rounded.

Example:
-1 -z
t:lIJ + h1z +h 2

H =
4]

- -
1+az+az
1 z

17.6 Standard Filter Families

17.6.1 Butterworth Filter
A Butterworth filter has two poles for faster roll-off at the cut-off frequency.
Example:
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dB
3 -3dB

-A40dB
decade

Fc

17.6.2 Chebychev Filter
A Chebyshev filter has a faster roll-off than a Butterworth filter, but, as a result of the fast roll-
off, ripple is introduced into the passband frequency.

Example:
dB

&%

v
T
Rp

17.6.3 Elliptic Filter
Similar to a Chebyshev filter but ripple is introduced into both the passband and the stopband.
It has a faster roll-off than a Chebyshev filter.

Example:
by 4
T
Rp

17.7 Input Shaping Window
The Input Shaping tab opens a window that shows Input Shaping choices and a representative
Time and Amplitude table. Modify the settings as needed and press Apply.

Type as well as Frequency and Damping Rate may be adjusted. Overcurrent is adjustable when
a Negative Zero Vibration or a Negative Zero Vibration and Derivative filter is chosen. If Custom
is chosen as the Type, Time and Amplitude may be set manually.
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@ Filter Configuration - X

Filter Settings Analog VLloop Iloop InputShaping

: | |
———P»| Trajectory Generator (Smnng —| Positionloop —————— P
Time Amplitude
Type:  iZero Vibration P e
Frequency: 0.1 Hz
Damping Ratio: 0 0
Over Currenting Ratio: |1
Apply Default

Close

Input Shaping Types

Type Description

Zero Vibration Single step inputs are replaced with two step inputs of smaller magnitude.
One of which is delayed by one-half the period of vibration. Sensitive to
some modeling errors.

Zero Vibration and | A zero derivative (of the vibration) constraint is added to Zero Vibration
Derivative impulse shaping, thereby reducing modeling errors.
Negative Zero Vibration Faster than positive input shaping (Zero Vibration, and Zero Vibration and

Derivative), but may magnify high frequency vibrations.

Negative Zero Vibration | A zero derivative (of the vibration) constraint is added to Negative Zero
and Derivative Vibration impulse shaping.

Custom Time and Amplitude can be set manually.

17.8 Measuring Mechanical Vibration
There are several ways to measure mechanical vibration. Two choices are offered below.

17.8.1 Using an Accelerometer with CME
Begin with a Copley drive operational and controlled by CME .

1. Connect the accelerometer analog output to Copley drive’s Analog + and - on the signal input
as in the diagram below.
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Accelerometer Copley Drive
{Analog Devices ADXL105)

Vdd oV

Com GND
Al AIN +

Com AIN -

A
2. On CME, click the Scope Tool E
3. Select the Measurement tab, choose a channel, select Voltage, then Analog Command.
4. Perform a move.

5. After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.

17.8.2 Using CME to Monitor Following Error

Monitor the following error using CME ‘s scope option.
Begin with a Copley drive operational and controlled by CME .

i
1. On CME, click the Scope Tool Q

2. Select the Measurement tab, choose a channel, select Position, then Following
Error.

3. Perform a move.

4. After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.
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18 FREQUENCY ANALYSIS
18.1 Overview

The Frequency Analysis screen expands on the functionality of CME by providing a tool to
measure the frequency response of a system while running a sine sweep. This further enhances
the ability to tune and troubleshoot systems, particularly when there is a mechanical resonance
present. The frequency analysis tool will measure and plot the current/velocity loop frequency

response on a semi-log graph.

Click

to open the Frequency Analysis screen.

172

@ Frequency Analysis ¥
File View
@ % PV 1
Plot1 x
z a0
0 25
-2 o
- 25
-
T B F-50 &
= o
o
ER:E F-75 %
S =y
5 =
2104 F-10048
129 r-125
=149 r-180
=16 7 r-178
-8 T T T T T T 1T T T T T T T T 1 T -200
10 100 1000 2000
Frequency (Hz)
W Magnitude Phase Shift
Sine Sweep Log  Measurement Plot Settings
Freq = 4936 H=z, Hag = -1.3¢ dB, Phase = -54.84 deg ~
Mode: |Closed Loop Current ~ Freq = 1052 Hz, Mag = -5.12 dB, Phase = -92.45 deg
Freq = 1182 Hz, Mag = -5.73 dB, Phase = -100.40 deg
amplitude: 0.25| A Freq = 1328 Hz, Mag = -6.72 dB, Phase = -108.64 deg
Freq = 14%2 Hz, Mag = -7.52 dB, Phase = -118.28 deg
Start Freguency: 10| Hz Freq = 1676 Hz, Mag = -5.59 dB, Phase = -127.91 deg
Freq = 1853 Hz, Mag = -9.63 dB, Phase = -137.74 deg
End Frequency: 3000 | Hz Fregq = 2115 Hz, Mag = -10.77 4B, Phase = -145.6% deg
Freq = 2376 Hz, Mag = -11.85 4B, Phase = -1&6l.44 deg
Number of Samples: 50 Freq = 2670 Hz,  Mag = -13.30 dB,  Phase = -172.92 deg
F = 3000 Hz M = -17.84 4B Fh = -182.03 d
Current Loop Offset: o A T.:Eq o ! a0 e ' ase I =
Sine swesp complets
Start v
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18.2 User Interface

18.2.1 Graph

The frequency response data is plotted on a semi-log graph when the sign sweep completes.
Each time a sine sweep is run, the data is plotted on a graph in a new tab. The tabs are
named with the plot number (Plot 1, Plot 2, etc.). For multi-axis drives, the axis letter is
appended to the tab name (e.g. Plot 1A, Plot 2B, etc.). The magnitude scale is displayed on
the left Y axis and the phase shift scale is displayed on the right Y axis.

Plot1 x |Plot2 x |Plot3 x

"~

hdagnitude {db)

(Bapluys aseyy

r-100

F-120

=140

=160

W Maanitude

Phase shift

L T T T T T =180

400

1000 2000
Frequency (Hz)

18.2.2 Graph Options Menu

To display the plot options menu, right-click anywhere on the graph.

LineStyle *» @ line
Preferences | plus
connected plus
100
Menu Menu Items Description
Line Style line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.
connected plus Data points are plotted as plus signs and relate to a line.
Preferences anti-aliasing When anti-aliasing is selected, the Scope removes screen-related
jaggedness in the displayed trace. Use of this feature may slow
down the refreshing of traces on slow computers.
grid When selected a grid is displayed on the scope screen.
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18.2.3 Sine Sweep Controls

Sine Sweep

Mode: | Closed Loop Current b
Amplitude: . 0.»’ A
Start Frequency: 10 Hz
End Frequency: i 7300(7). Hz
Number of Samples: 50

Start 7 Stop
Mode

Description: The loop to which the excitation will be applied, and the response will be
measured. The options are Closed Loop Current, Closed Loop Velocity,
Open Loop Velocity, Open Loop Velocity Plant, Open Loop Velocity
Controller and Open Loop Position

Units: None
Default: Closed Loop Current

Frequency Analysis: Closed Loop Current

I : (P Gty Eyte)
[
\ )
| Offset | \ s —_— :
i )
..................................... L S—————"
Input / Output
Il I
Input Trace: Commanded Current (TracelD 7)
Qutput Trace: Actual Current (TracelD 14) i
Desired State = | Test function
Fgen Inj = 0 = No injection
Analyzer
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Frequency Analysis: Closed Loop Velocity

..ﬂ

i

Output

Input Trace: Commanded Velocity (TracelD 24)
Output Trace: Actual Velocity (Traceid 23)
Desired State = V Test function

Fgen Inj = 0 = No injection

Analyzer

Frequency Analysis: Open Loop Velocity

[P -

Limited
Veiodty

Vel & Accel Cmd ol

Filter Lo

0

Blocks in deshed [nes are enabind

when P10 Renction s sctve.

+

[ wn': —-bt‘::" - Current
1 3
V-Loop Output: Commanded Current u2

1.
)l"""‘

Sine

Commanded Velocity

Input Trace: Injected Commanded Current (TraceID 72)
Output Trace: V-Loop Commanded Current (TracelD 73)
Desired State = V Commanded

Fgen Inj = 1 = Input of Current Loop
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Output

e

Input

=

Analyzer
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Frequency Analysis: Open Loop Velocity Plant

[P

Blocks in deshed [nes are enabind
when #10 & I active.

.......

Limited
Veiocity
Vel & Accel Cmd 4+ Veiocity erree T
Filter

.......

PR OO W W W W W W W W W W W
-
'
'
'
'
M
.
.
.
'

Input Trace: Injected Commanded Current (TracelD 72) Units of Amps

QOutput Trace: Actual Velocity (TracelD 23) Units of Encoder Counts/ Seconds
Desired State = V Commanded -
Fgen Inj = 1 = Input of Current Loop

Analyzer
Frequency Analysis: Open Loop Velocity Controller

Blocks i deshed [nes are enabind
when #10 s actve.

Vel & Accel

i S
!

Input Trace: Velocity error (ID 26)

Output Trace: Actual velocity (ID 23)
Desired State = V Commanded -
Fgen Inj = 1 = Input of Current Loop
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Frequency Analysis: Open Loop Position

Analyzer

~

~

Input Trace: Injected Commanded Velocity (TracelD 72)

'
'
'
'
)
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
'
!
'
'
'
'
!
»
@
-
o N A L o

~

QOutput Trace: P-Loop Commanded Velocity (TracelD 32)
Desired State = P Trajectory Generator

Fgen Inj = 2 = Input of Velocity Loop

Trajectory Generator: Position =0

Amplitude

Description:
Units:
Default:

Start Frequency

Description:
Range:
Units:
Default:

End Frequency
Description:
Range:

Units:
Default:

177

The amplitude of the sine wave.

A (current), rpm (velocity, rotary motor), mm/s (velocity, linear motor).
Current: 10% of the current loop continuous current.

Velocity: 5% of the velocity loop velocity limit.

The first frequency of the sine sweep.
0.1 to 9999 Hz

Hz

Current: 10 Hz,

Velocity: 5 Hz

The last frequency of the sine sweep.
0.2 to 10000 Hz

Hz

Current: 3000 Hz

Velocity: 250 Hz

Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Frequency Analysis

Number of Samples

Description: The number of sine wave frequencies to run during the sine sweep. The
frequencies are calculated so that there are an equal number of
frequencies per decade.

Range: 2 to 100

Units: None

Default: 50
Start

Description: Starts the sine sweep.

Units: N/A
Default: N/A
Stop

Description: Cancels the sine sweep in progress.
Units: N/A
Default: N/A

18.2.4 Log Text Window

The log text window shows the progress of the sine sweep. For each frequency, the measured
frequency response (magnitude and phase shift) is displayed. These are the values that get
plotted in the graph.

Log Measurement Plot Settings

Freq = 93¢ Hz, Mag = -4.52 dB, Phase = -30.39 deg A
Freq = 1052 Hz, Mag = -4.54 dB, Phase = -32.54 deg
Freq = 1182 Hz, Mag = -4.44 dB, Phase = -35.27 deg
Freq = 1328 Hz, Mag = -4.28 4B, Phase = -39.09 deg
Freq = 1492 Hz, Mag = -4.12 dB, Phase = -43.91 deg
Freq = 1676 Hz, Mag = -4.09 dB, Phase = -48.71 deg
Freq = 1883 Hz, Mag = -4.15 dB, Phase = -52.40 deg
Freq = 2115 Hz, Mag = -3.99 dB, Phase = -55.31 deg
Freq = 237¢ Hz, Mag = -3.50 dB, Phase = -59.4¢ deg
Freq = 2670 Hz, Mag = -2.79 4B, Phase = -65.64 deg
Freq = 3000 Hz, Mag = -1.70 dB, Phase = -74.27 deg
Sine sweep complete
v
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18.2.5 Measurement

The Measurement tab contains tools to analyze the data displayed on the graph.

Cursors

Select MIshewausors 4 display the cursors on the graph.

Plot1 x

1 0

2 &

Magnitude (db)
LI TR - T T S T
A S S S S ST
o
2
(Bapl g aseyd

=11 T T T T LI B T T T LI B T T -180

10 100 1000 3000
Frequency (Hz)

To move the cursors, left-click a cursor and drag it to the left or right. As the cursor is moved
along the plot, the values for Frequency, Magnitude, and Phase Shift are updated in the
Measurement tab.

Log Measurement Pplot Settings

Left Right Delta Show Cursors
Frequency: 64.3 465 400.7 [] Show -3dB Line
Magnitude: -0.27 -2.88 2.61 [ Show 0 dB Line
[] Show -180 deg Line
Phase Shift:
18.2.5.1 Show -3db Line

point on the magnitude plot is used to determine the bandwidth of the system.
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Plot1 x
1 a0
0 Fzo
—"" e
-1 Fo
-2 F-zo
B e e N Bt e e e P o o e S . " s & 40
- 2
£ .2 Fe0 &
i 5
ERCE Feo 2
£ 2
g -6 -mug
7 120
5 140
.o 180
10 180
-1 — T T 1200
10 100 1000 2000
Frequency (Hz)
18.2.5.2 Show -180 degree Line

Select ¥hen:-180lne 4 display a horizontal dashed line where the phase shift is -180 degrees.
This line is useful for determining the phase and gain margins of your system.

Flot1 x
] 400
[ [2e0
-5 200
-10 1 250
-15 1 [-200
-20 A 150 o

g g

264 F400 9

.

330 &0 §

.35 1 to =

= =1
40 4 50
.45 F-100
.50 F-150
.55 | F-200
-6 [-260
65 T T T T T T T T T T T T T T T -200

5 10 00 200
Frequency (Hz)
18.2.5.3 Manually measuring gain margin

Assuming the phase starts at 180 deg and goes to 0 deg (a phase shift of 180 deg), measure
the gain margin from 0 db at this phase inversion and determine how many decibels of gain
margin exist. A critically damped loop may have approximately 15 db of gain margin.

18.2.5.4 Manually measuring phase margin
Assuming the phase starts at 180 deg and goes to 0 deg, (a phase shift of 180 deg), measure

the phase shift at the 0 db gain from the initial phase to the new phase to determine the
phase margin. A critically damped loop may have approximately 75 db of phase margin.
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18.2.6 Plot Settings

Log Measurement Plot Settings

Plot 1 Settings

Mode: Closed Loop Current
Amplitude: 0.12 A

Start Frequency: 10.0 Hz

End Frequency: 3000.0 Hz

Number of Samples: 50

18.2.7File Menu

2 Frequency Analysis

File View
File Menu Items Description
Save Current Plot Saves the data from the sine sweep of the plot currently displayed in a csv

format that can be imported to other software such as spreadsheets or
mathematical analysis programs.

18.2.8 Filter Screen

Click to open the Filter Configuration screen.

18.2.9 Status Bar

The left and middle text fields of the Status Bar show various faults and warnings while the
Frequency Analysis screen is open.

18.2.9.1 Faults/Warnings Status

The left text field of the status bar shows the faults and warnings. Faults will be displayed
with a red background and warnings will be displayed with a yellow background. Only two
warnings are monitored during frequency analysis: Current Limited Warning and Voltage
Limited Warning. All faults are monitored during frequency analysis.

Latched Fault: Motor Over Temp [ [

| Warning: Current Limited | |
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18.2.9.2 Motion Inhibited Status

The middle text field of the status bar shows the conditions that will prevent motion. The
conditions that are not faults, but will prevent motion are:

Positive and negative software limits

Positive and negative limit switches

Drive is disabled by hardware (enable input not active).

Phase not initialized (only applies when feedback is set up for phase initialization).

Positive Limit Switch Active [
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19 DATA, FIRMWARE, AND LOGS
19.1 Amplifier RAM and Flash Memory

19.1.1 Amplifier RAM
e Volatile. Contents erased when amplifier is reset or powered off.
e Initial contents read from flash on power-up. Contents then updated in real time to reflect
certain operational conditions and changes entered with CME software. At any time, the
user can use CME to restore data from flash into amplifier RAM.

19.1.2 Flash
e Non-volatile. Contents retained when the amplifier is reset or powered off.
¢ Moadified only by using a Save to Flash tool or by closing certain screens (Motor, Setup,
Homing, or CAN Configuration), whose contents are automatically saved to flash upon
closing of the screen.

Parameters reside in RAM only, Flash only, or both RAM and Flash. The table below illustrates
the typical parameter locations. Refer to the Parameter Dictionary for information about specific
parameters.

Data Resides In Data

Flash only This category includes all Motor/Feedback screen data and Setup screen
(motor/feedback data only). This data is saved to flash when the user
confirms the values and closes the screens without cancelling.

Amplifier RAM only Includes operating status data such as actual position, actual current, and
amplifier temperature. Such data is never stored in flash. It is destroyed
from amplifier RAM with each power-down or amplifier reset.

Flash and amplifier RAM | Includes all other data not represented in the two categories above. When
changing these parameters in CME, the value is saved to amplifier RAM only.
To save these values to flash, the Save To Flash operation must be performed
or data will be lost on power down or reset.

19.2 Data Management Tools

19.2.1 Amplifier

Operations performed using the amplifier data management tools at the top of the Main screen
(shown below) affect amplifier settings, including motor/feedback data. (CVM Control Program
data is not saved by these operations).
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Action Name Description
;j Save amplifier | Saves both amplifier and motor/feedback data to a disk with a .ccx
data to disk filename extension.

Restores amplifier and motor/feedback data from a .ccx file to the
amplifier's RAM, or flash for the flash only variables. See Parameter

data to flash

] §:f;c;:imadr?spk“ﬁer Dictionary for parameter descriptions.
A To Flash operation should be performed to insure that all data is saved
to flash

_’ Save amplifier | Saves contents of amplifier RAM to amplifier flash memory.

Restore amplifier
data from flash

Restores contents of amplifier flash memory to amplifier RAM.

19.2.2 Motor/Feedback Screen

Operations performed using the Motor screen data management tools only apply to the motor

parameters.
S [V Uiy Motor data
— I . management tools
Action Name Description
;j Save motor data to | Saves only motor data to disk with a .ccm filename extension. Amplifier
disk data that is not represented on the Motor screen is not saved in this file.
o Restore motor data | Restores only motor data from a disk file with a .ccm filename extension
from disk amplifier flash (the motor parameters are flash only).
Saves the contents of the Motor screen from to amplifier flash memory.
_» Save motor data to | Amplifier data that is not represented on the Motor screen is not saved.

flash

Can be used to assure that all changes are saved to flash without closing
the Motor screen.

Restore motor data
from flash

Restores only motor data from amplifier flash memory to the PC.
Amplifier data that is not represented on the Motor screen is not
affected. Can be used before closing the Motor data screen to restore
settings to the previously saved values.

19.3 Multi-Axis Data Tools

The descriptions in this section

19.3.1 Cop

y Axis

only apply to multi-axis drives (XE2, BE2, etc.).

CME allows one axis to be copied to another. This feature allows quick set up of multiple axes,
since only one axis needs to be set up. The Copy Axis operation copies all RAM/Flash and Flash
Only parameters to the other axis.

184
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From the menu on the Main screen, select File=>Copy Axis. This will display the Copy Axis
screen:

@ Copy Axis X

From: To: |AXxisB v

Copy to Flash
0K Cancel

Select the source and destination axes, then click OK. Note that Copy to Flash is selected by
default. If this option is not selected, then the RAM/Flash parameters will only be copied to the
destination axis’ RAM, while still copying the Flash Only data to the destination axis’ Flash.

19.3.2 Save/Restore Single Axis

CME allows a single axis of data to be saved/restored on a multi-axis drive. This feature is useful
when one axis of tuning/setup data is common across many multi-axis drives, but only on one
axis. The file will be saved as a .ccx file. Restoring a .ccx file to a single axis, the file must be
written as a single axis, otherwise an error will be displayed.

From the menu on the Main screen, select File>Save As->Single Axis. This will display the

Save Single Axis screen. Select the axis to be saved, click OK, and then continue with naming
and saving the file.

@ Save Single Axis X

Save Axis: Ax A v

oK Cancel

From the menu on the Main screen, select File>Restore>Single Axis. This will display the
Restore Single Axis screen. Select the axis to restore the file data to, click OK, then browse to
the single axis file.

@ Restore Single Axis X

Restore to Axis: Ax A v

0K Cancel
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19.4 Drive Configuration

The Plus Family of drives have the capability of saving/restoring the entire drive configuration
to a file. The drive configuration consists of all parameters (RAM/Flash and Flash Only) and the
entire contents of the CVM flash, which includes any CVM programs, cam tables, and gain
scheduling tables. The file is saved with a .ccd file extension.

This feature is useful to clone drives in one step rather than separately loading each file (.ccx,

.ccp, .cct, .ccg). Additionally, the file is in XML format which can be read by some EtherCAT
masters as an ESI file for File over EtherCAT (FOE).

19.4.1 Save Drive Configuration

From the menu on the Main screen, select File>Save Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file.

@ Drive Configur.. — X

Saving Drive Configuration to file...

19.4.2 Restore Drive Configuration

From the menu on the Main screen, select File>Restore Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file

@
Restoring Drive Configuration to Flash...

— 23%

All the data read from the file is saved to the drive’s Flash. After all the data is written, the drive
will be reset, so that the Flash data is copied to RAM.

19.5 Copy Drive Data

In product families prior to the Plus Family, the Drive Configuration feature is not available. To
clone one drive to the next, multiple steps are required.

1. Load the .ccx file:

From the Main screen, click Restore -5 Amplifier Data (.ccx).
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@ CME V8.0 Beta 17 (XTL-S unnamed)

File  Amplifier Tools Help

Save Amplifier Data (.ccx)

Restore

Exit

i=r1 | |

Drive Configuration (.ccd)
Amplifier Data (.ccx)

CVM Control Program (.ccp)

CVM Encoder Correction Table (.cce)

Cam Tables (.cct)

Gain Scheduling Table (.ccg)

I

-

P |Loc

OR From the Setup screen, click Load ccx File.

Setup
Settings
Motor Family: Brushless
Motor Type: Rotary
Commutation: Sinusoidal
Hall Type: Digital
Hall Phase Correction: On
Use Halls for Velocity/Position: Off
Use Back EMF for Velocity: Off
Motor Feedback: Primary Incremental
Load Feedback: None

Multi-mode Port:
Operating Mode:

Buffered Primary Feedback
CAN

X

Load ccx File Load ccd File

Cancel

When prompted browse to the folder containing the .ccx file and open it.

On the Main screen, click Save to Flash -" to save the new settings to flash memory.

2. Load the .ccd file:

187

From the Main screen, click Restore

"> Drive Configuration (.ccd).
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OR From the Setup screen, click Load ccd File.

188

@ CME V8.0 Beta 17 (XTL-S unnamed)

File Amplifier Tools

Save Amplifier Data (.ccx)

Restore

Exit

Setup

Settings

Motor Family:

Motor Type:
Commutation:

Hall Type:

Hall Phase Correction:

Use Halls for Velocity/Position:

Use Back EMF for Velocity:
Motor Feedback:
Load Feedback:
Multi-mode Port:
Operating Mode:

Help

Amplifier Data (.ccx)

3}

Brushless
Rotary
Sinusoidal
Digital

Primary Incremental

None

Buffered Primary Feedback
CAN

=11 |

> Drive Configuration (.ccd)
CVM Control Program (.ccp)

Cam Tables (.cct)

Gain Scheduling Table (.ccg)

CVM Encoder Correction Table (.cce)

—

» ILlo

Load ccx File Load ccd File Cancel

When prompted browse to the folder containing the .ccd file and open it.

On the Main screen, click Save to Flash ﬁ to save the new settings to flash memory.

Load a CVM program .ccp file:
From the menu on the Main screen, choose File>Restore->CVM Control Program.
When prompted, navigate to the folder containing the appropriate .ccp file and open it.

This procedure also results in setting the Enable Control Program on Startup option,
which configures the program to auto start when the amplifier is powered up or reset.

Load Cam Table .cct files:
From the menu on the Main screen, choose File>Restore->Cam Tables.
When prompted, navigate to the folder containing the appropriate .cct file and open it.
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5. Load Gains Scheduling Table .ccg files
From the menu on the Main screen, choose File>Restore>Gains Scheduling Tables.

When prompted, navigate to the folder containing the appropriate .ccg file and open it.

TIP: When copying amplifier data to multiple amplifiers in a production environment, consider
locking CME to prevent accidental changes to settings. See Lock/Unlock CME.

19.6 Save MACRO File for Delta Tau Controllers
This feature is available only on Copley MACRO drives such as the XML Xenus MACRO

1. On the CME Main screen, choose File->Save MACRO File to open the MACRO File Save

window: \
MACRO File Save
MACRO node: 0|
[ OK ] [ Cancel J

2. Enter the ID of the MACRO node with the settings you want to save and click OK.

3. When prompted, enter a File Name. If needed, navigate from the default AmpData folder
to another folder where you wish to store the file.

4. Click Save to save the .pmc file in the same folder and close the screen.

19.7 Lock/Unlock CME

The Lock feature of CME is used to lock out most screens to prevent data from being changed.
WHEN CME IS LOCKED:

e User cannot change any amplifier or motor settings.

e User can download amplifier and motor files and Cam Tables, jog the motor, run scope

functions and profiles, and monitor amplifier performance with the scope and control
panel.

1.0n the Main screen choose Tools>CME Lock/Unlock.

2. Set a new password in the Password and Verify Password fields.

CME Lock X
Enter password to lock CME

Password: |

Verify Password:

OK Cancel
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3. Click OK to lock out amplifier setting controls.

@ CME V8.0 Beta 15 (XPL-230-18 Spindle) = O X
File Amplifier Tools Help

oJQX | EI=E R~

=l Copley Neighborhood CAN Network:  Address: 1 State: Pre-operational
- BB Virtual Amplifier

8 - W COM4: Spindle

Input / Qutput

CVM Control Program

CAN Configuration —) D loop =) Vloop =) |loop =—) Motor
ey |

Home Configure Regen Configure Faults

(@ Axis A

Axis B

Axis C Configure Filters

CME Locked

Axis D

Amp Under CAN Control F12 To Disable |

4. To unlock, choose Tools>CME Lock/Unlock.
CME Unlock X
Enter password to unlock CME

Password: |

Unlock for this session only

o | [ |

Enter the password. Click OK

19.8 Firmware Download

The amplifier's flash memory holds the amplifier's firmware. As needed, perform the following
steps to obtain new firmware and download it to amplifier flash memory.

NOTES:

e CME does not support downloading firmware to a node amplifier via a multi-drop gateway
amplifier; a direct connection (serial, CAN, EtherCAT) must be used.

e To check the firmware version currently loaded, click the Amplifier Properties button
or choose Help>About.
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@ Amplifier Properties = [l X
Model Number: XPL-230-18 A
Firmware Version: 3.14
FPGA Version: 3.08
Boot Loader Version: N/A
Hardware Type: 0x1020
PCB Serial Number: 42137668
Manufacturing Date: 4213
Peak Current Limit: 18A
Continuous Current Limit: 6A
2T Time Limit: 1000ms
Maximum Voltage: 400V

v

WARNING: Do not power down or disconnect the amplifier during firmware download.

On the Main screen choose Tools>Download Firmware to open the Download
Firmware window. Browse to where the firmware file is located and click Open to
start the download. The progress will be displayed while downloading.

@Firmware Download l = l =) Ij&]

Writing new FPGA and firmware image.

=

When the progress dialog closes, the firmware download is complete.
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19.9 Error Log

Click the Error Log tool ’ on the Main screen

@ Error Log = X

History Frequency Network Status

Type Description
Fault Under Voltage
Fault Motor Phasing Error

¥ I Clear Log Refresh Close

Tab Contents

Active Type and description of each active fault and warning. The contents of this tab are
automatically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the
log was last cleared. The contents of this tab are not refreshed automatically as new
events occur. The contents are refreshed only when the tab is displayed or when
Refresh is clicked.

Frequency Type, description, and frequency of each fault and warning that has occurred since
the log was last cleared. The contents are refreshed only when the tab is displayed
or when Refresh is clicked.

Network (Under CAN control only.) Status of CANopen network. Lists warnings and errors.
Status

Encoder Reads the encoder status

Status

Saves the contents of the History and Frequency tabs to a text file.

Clear Log Clears all History and Frequency entries in the drive

Refresh Updates the contents of the History or Frequency tabs
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19.10 Amplifier Properties

This screen provides the general information including the hardware type, firmware etc. of the
drive.

@ Amplifier Properties = (] X
'Model Number: XPL-230-18 A
%Firmware Version: 3.14

iFPGA Version: 3.08

iBoot Loader Version: N/A

iHardware Type: 0x1020

iPCB Serial Number: 42137668

|Manufacturing Date: 4213

'Peak Current Limit: 18A

Continuous Current Limit: 6A

‘IZT Time Limit: 1000ms

|Maximum Voltage: 400V

19.11 Communications Log

The communications log displays all communications between CME and the amplifier. The data
is only stored in the PC'’s RAM by CME; it is not part of the amplifier’s data.

On the Main screen, choose Tools>Communications Log
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@ Communications Log

—= U X

14:29:24.714 COM4 Send: Get Amp Desired State in RAM 00 73 (A
14:29:24.736 COM4 Recv: Get Amp Desired State in RAM 00 5b C
14:29:24.743 COM4 Send: Get Camming Configuration 00 53 01 C
14:29:24.745 COM4 Recv: Get Camming Configuration 00 4a 01 C
14:29:25.14 COM4 Send: Get Amp Desired State in RAM 00 73 01
14:29:25.15 COM4 Recv: Get Amp Desired State in RAM 00 5b 01
14:29:25.19 COM4 Send: Get Camming Configuration 00 53 01 Oc
14:29:25.20 COM4 Recv: Get Camming Configuration 00 4a 01 0C
14:29:25.314 CcOM4 Send: Get Amp Desired State in RAM 00 73 C
14:29:25.315 COM4 Recv: Get Amp Desired State in RAM 00 5Sb C
14:29:25.319 COM4 Send: Get Camming Configuration 00 53 01 C
14:29:25.320 COM4 Recv: Get Camming Configuration 00 4a 01 C
14:29:25.617 COM4 Send: Get Amp Desired State in RAM 00 73 C
14:29:25.617 COM4 Recv: Get Amp Desired State in RAM 00 Sb (V¥
< >
Enable Logging

[ ] Enable Event Status Logging

Show "Get Variable" Cmds: I'_j Clear Close

Option

Description

Enable Logging

When selected, logging is enabled and all communications, with the
exception of status messages, are recorded in the log

Enable

Event

Status Logging

When selected, status messages are included in the log. Note that
Show “Get Variable” Cmnds must also be checked to log Event
Status commands.

Show

“Get

Variable” Cmds

When selected, “Get Variable” commands are added to the log.

A

Saves the contents of the Communications Log to a text file.

Clear

Clears the log contents from the PC’s RAM
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20 VIRTUAL AMPLIFIER
20.1 Overview

Virtual amplifiers can be used for creating amplifier and motor data files off line. A new virtual
amplifier can be created based on a virtual amplifier template file (.ccv) or from an existing .ccx
file. CME includes a set of .ccv files for each model that is supported.

@
File Amplifier Tools Help
111

=3 Copley Neighborhood
o °—- W Virtual Amplifier
‘.. (= COMS4: Spindle

Select the Virtual Amplifier node from the Copley Neighborhood. This will display the Open
Virtual Amplifier screen:

Open Virtual Amplifier X

Select Method:

(® Create new virtual amplifier

() Open existing amplifier (ccx) file

() Open Drive Config (ccd) file

OK Cancel

Create new amplifier file

Select Create new amplifier and click OK.

When prompted, select the .ccv that represents the appropriate drive model.
Click Open. The Setup screen will be displayed.

Motor and amplifier values may now be viewed, entered, and adjusted.

Open existing amplifier file

Select Open existing amplifier file and click OK.
When prompted, select the appropriate .ccx file.
Click Open.

e Motor and amplifier values may now be viewed, entered, and adjusted.
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21 GAIN SCHEDULING
21.1 Overview

The Gains Scheduling feature allows you to schedule gain adjustments based on changes to a
key parameter. For instance, Pp, Vp, Vi, and Current Offset (A) could be adjusted based on
changes to commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key
parameter value and the corresponding gain settings. The amplifier uses linear interpolation to
make smooth gain adjustments between the programmed settings.

Gain scheduling involves the basic steps outlined below.

Storage Limits

The maximum number of lines that can be stored in the Gain Scheduling Table is 1000. A typical
Gain Schedule Table will contain far fewer lines. The number of Gain Scheduling Table lines is
also limited by the amount of CVM memory space available in the amplifier. A Gain Scheduling
Table shares that space with CVM programs and Camming Tables. Therefore, the maximum
number of Gain Schedule Table lines will decrease if CVM programs or Camming Tables are
stored in the amplifier.

The Table tab of the Gain Scheduling screen displays the percentage of amplifier memory used:

I—i"1
3¢

CVM memory usage: 1%

21.2 Configure Gain Scheduling

1. From the menu on Main screen, choose Amplifier>Gain Scheduling.

@ Gain Scheduling — X
File Edit

Config Table

Key Parameter:  Use Actual Velocity v

Use Absolute Value of Key Parameter
[] Disable Gain Scheduling Until Axis is Referenced

Select Gains

[] Position Loop Pp [] Position Loop Pi
Velodity Loop Vp [] Position Loop Pd
Velocity Loop Vi [[] Phase Adjust

[[] current Loop Offset

Close
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2. Choose the Key Parameter:

Key Parameter Description
Disable Gain Scheduling. | Disable gain scheduling.
Use Written Parameter. An external controller can write to this parameter using any of

several protocols and corresponding parameter IDs: Copley ASCII
Interface or the Copley Indexer 2 Program (ID 0x128), CANopen and
EtherCAT (Index 0x2371), and MACRO I-variable (0x528).

See the Copley ASCII Interface Programmer’s Guide, the Copley
Indexer 2 Program User Guide, or the Copley CANopen
Programmer’s Guide.

Use Commanded Schedule gain adjustments based on changes to commanded
Velocity. velocity.

Use Actual Velocity. Schedule gain adjustments based on changes to actual velocity.
Use Commanded Schedule gain adjustments based on changes to commanded
Position. position.

Use Actual Position. Schedule gain adjustments based on changes to actual position.

Optionally set controls:

Control Description

Use Absolute Value of | If a velocity or position value is chosen for the Key Parameter and

Key Parameter this option is set, the Key Parameter is interpreted as an absolute
value.

Disable Gain Scheduling | When this option is set, the scheduled gain adjustments do not take
Until Axis is Referenced place until the axis is referenced (homed).

3. Select the gains that you wish to adjust by schedule. The choices are Pp, Vp, Vi and
Current Offset (A). For each gain you select, a column will be enabled in the Gain
Scheduling Table.

4. Continue with Set Up Gain Scheduling Tables.

21.3 Set Up Gain Scheduling Tables
On the Gain Scheduling screen, open the Table tab:

@

File Edit
Config Table

Key Value (0.1 counts/s) P Loop Pp V Loop Vp V Loop Vi Current Offset (A)

P Loop Pi P Loop Pd Phase Adjust

CVM memory usage: 0% l—i\ m
3

Close

197 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Gain Scheduling Gain Scheduling

Action Description
Creates a new table

*2

Deletes the table from amplifier flash and PC RAM

% B 0=

Saves configuration and table to disk

Restores configuration and table to PC only

Saves configuration and table to amplifier flash

Restores configuration and table from amplifier flash to PC. This operation
overwrites all data on the Gains Scheduling screen.

1. On the Gain Scheduling screen, open the Table tab:
)

File Edit

Config Table

Key Value (0.1 counts/s) P LoopPp V Loop Vp V Loop Vi Current Offset (A) P Loop Pi P Loop Pd Phase Adjust

CVM memory usage: 0% |—<\ m
3¢

Close

=R

2. Click the Create New Table button [&‘ and enter the number of lines for the table.
Q New Table X

Enter Number of Lines: 2

OK Cancel

3. Enter the Key Parameter and gain adjustment values.
NOTE:

e All values must be whole numbers (no fractional values).

e All Key Values must be increasing.

4. After all values have been entered, click the Save Table button ﬂ This action saves both
configuration and table data.
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a Gain Scheduling = O X
File Edit
Config Table
Key Value (0.1 counts/s) P LoopPp V Loop Vp V Loop Vi Current Offset (&) P Loop Pi P Loop Pd Phase Adjust
0 0 0
1 81920 1100
2 8192000 1500

CVM memory usage: 1%
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22 REGEN RESISTOR CONFIGURATION

Incorrect values may damage amplifier or external regen
resistor.

For the regen I°T algorithms to work correctly, the values entered in

the following steps must be correct. Damage to the external regen
WARNING (esistor may result from incorrect values entered. Damage to the

amplifier may result if an incorrect resistance value is entered.

Failure to heed this warning can cause equipment damage.

22.1 Configure a Standard Copley Controls Regen Resistor

’ Configure Regen

1. Click Configure Regen to open the Regen Resistor screen.

Regen Resistor X

() XTL-RA-03
() XTL-RA-04

() Custom Resistor

Settings OK Cancel

2. Select the model number XTL-RA-03 or XTL-RA-04 based on your drive and click OK to
save the configuration and close the screen.

Regen Resistor X
(O) None

() XTL-RA-04

(O) Custom Resistor Configure

View Settings OK Cancel

200 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019



Regen Resistor Configuration

22.2 Configure a Custom Regen Resistor

Configure Regen ‘

1. Click Configure Regen to open the Regen Resistor screen.

Regen Resistor X

() XTL-RA-03

XTL-RA-04

() Custom Resistor Configure

View Settings OK Cancel

2. Select Custom Resistor and click Configure to enter the custom resistor data. Read the
information displayed and click OK.

Custom Regen Resistor X

“0“ Regen resistors are subject to potentially high power dissipation depending on

¥ the resistor value and the amount of energy being regenerated from the motor and
load. To ensure safety and reliable operation, it is important to select a regen
resistor that is appropriate for your application.

3. Follow the instructions on step 1 through 5 of the Custom Regen Wizard, then click Finish.

Custom Regen Resistor Configuration X
_ Step 5

Resistance: 30| Q

Contintiolis Power: 25| W Custom regen resistor configuration is
complete.

ver: 25| W 535

HERk FOLE L Press Finish to accept the values entered and
save them to the amplifier's RAM and flash.

Time at Peak Power: 50| ms

To change any of the values press Prev

Finish Cancel
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View Regen Settings

1. Click Configure Regen

Configure Regen

. . . | View Settings
Click View Settings'—
Regen Settings
Resistance: 30 Q
Continuous Power: 25 W
Peak Power: 25 W

Time at Peak Power:

50 ms

X

to open the Regen Resistor screen.

Jto open the Regen Settings screen.
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APPENDIX A

I°T TIME LIMIT ALGORITHM

Overview

The I°T current limit algorithm continuously monitors the energy being delivered to the motor
using the I?°T Accumulator Variable. The value stored in the I°T Accumulator Variable is compared
with the I°T setpoint that is calculated from the user-entered Peak Current Limit, I°T Time Limit,
and Continuous Current Limit. Whenever the energy delivered to the motor exceeds the I°T
setpoint, the algorithm protects the motor by limiting the output current or generates a fault.

Formulas and Algorithm Operation

Calculating the I%T Setpoint Value

The I°T setpoint value has units of Amperes2-seconds (A2S) and is calculated from programmed
motor data. The setpoint is calculated from the Peak Current Limit, the I°T Time Limit, and the
Continuous Current Limit as follows:

I°T setpoint =
(Peak Current Limit? — Continuous Current Limit?) * I?T Time Limit

Algorithm Operation

During amplifier operation, the IT algorithm periodically updates the I?T Accumulator Variable
at a rate related to the output current Sampling Frequency. The value of the I?°T Accumulator
Variable is incrementally increased for output currents greater than the Continuous Current Limit
and is incrementally decreased for output currents less than the Continuous Current Limit. The
I°T Accumulator Variable is not allowed to have a value less than zero and is initialized to zero
upon reset or +24 Vdc logic supply power-cycle.

Accumulator Increment Formula
At each update, a new value for the I°T Accumulator Variable is calculated as follows:

I°T Accumulator Variable n+1 =
I°T Accumulator Variable n
+(Actual Output Current n+12 - Continuous Current Limit?) * Update period

After each sample, the updated value of the I?T Accumulator Variable is compared with the I?T
setpoint. If the I?T Accumulator Variable value is greater than the I°T Setpoint value, then the
amplifier limits the output current to the Continuous Current Limit. When current limiting is
active, the output current will be equal to the Continuous Current Limit if the commanded current
is greater than the Continuous Current Limit. If instead the commanded current is less than or
equal to the Continuous Current Limit, the output current will be equal to the commanded
current.
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Application Example

Operation of the I°T current limit algorithm is best understood through an example. For this
example, a motor with the following characteristics is used:

e Peak Current Limit - 12 A
e I’TTimelLimit-1S
e Continuous Current Limit - 6 A

From this information, the I?T setpoint is:
setpoint = (12 A>-6 A%) * 1 S = 108 A%S

Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ I°T setpoint = 108 A2S)
to a given current command. For this example, DC output currents are shown in order to simplify
the waveforms. The algorithm essentially calculates the RMS value of the output current, and
thus operates the same way regardless of the output current frequency and wave shape.

I°T current limit

16 [ .
44 1 |_commanded| -
12 A Pz R | |_actual

10-/
. x /L
4_
2_
N

Current (A)
[e¢]

Diagram A

At time 0O, plot diagram A shows that the actual output current follows the commanded current.
Note that the current is higher than the continuous current limit setting of 6 A. Under this
condition, the I°T Accumulator Variable begins increasing from its initial value of zero. Initially,
the output current linearly increases from 6 A up to 12 A over the course of 1.2 seconds. During
this same period, the I°T Accumulator Variable increases in a non-linear fashion because of its
dependence on the square of the current.

At about 1.6 seconds, the I?°T Accumulator Variable reaches a value equal to the I°T setpoint. At
this time, the amplifier limits the output current to the continuous current limit even though the
commanded current remains at 12 A. The I?T Accumulator Variable value remains constant
during the next 2 seconds since the difference between the actual output current and the
continuous current limit is zero.
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At approximately 3.5 seconds, the commanded current falls below the continuous current limit
and once again the output current follows the commanded current. Because the actual current
is less than the continuous current, the I?T Accumulator Variable value begins to fall
incrementally.

The I?T Accumulator Variable value continues to fall until at approximately 5.0 seconds when
the commanded current goes above the continuous current limit again. The actual output current
follows the current command until the I?T Accumulator Variable value reaches the I°T setpoint
and current limiting is invoked.

I°T Accumulator
120
@ 100 T g pr e Y
S 2T S i //
------ 2T Setpoint —

3 60 P

£ 40 2T Accumulator

@ /

= 20 /

0 /
0 1 2 3 4 5 6 7

Time (S)
Diagram B

I°T Scope Trace Variables
Two Scope Tool trace variables are available for monitoring whether the I?T accumulator is
accumulating or discharging.
e The I°T Amplifier Accumulator variable evaluates the accumulator against the factory set
current limits of the amplifier.
e The I?T Motor Accumulator variable evaluates the accumulator against the user-
programmed current loop values.
The value shown Diagram B has been normalized so that 100% equals the I°T setpoint.

When either trace variable line reaches 100%, current limiting will be invoked.
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APPENDIX B

HOMING METHODS

Overview
There are several homing methods. Each method establishes the:
¢ Home reference (limit or home switch transition or encoder index pulse)

e Direction of motion and, where appropriate, the relationship of the index pulse to limit or
home switches.

Homing Diagram Legend

As highlighted in the example below, each homing method diagram shows the starting position
on a mechanical stage. The arrow line indicates direction of motion, and the circled H indicates
the home position. Solid line stems on the index pulse line indicate index pulse locations. Longer
dashed lines overlay these stems as a visual aid. Finally, the relevant limit switch is represented,
showing the active and inactive zones and transition.

Mechanical Stage Limits

\J/ < Axis \J/
[
L
Starting position —> I : _)
/@4— <— Direction of motion

Home position —_—
®<—| <— Starting position

Index pulse location

Index Pulse | | |

Positive Limit
Switch inactive T Switch active

Switch transition

Note that in the homing method descriptions, negative motion is leftward and positive motion is
rightward.

Homing Method Descriptions

Set current position as home
The current position is the home position.

Next Index

Direction of Motion: Positive
Home is the first index pulse found in the positive direction. Direction of motion is positive. If a
positive limit switch is activated before the index pulse, an error is generated.
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—
g
—

@

Index Pulse | |

Direction of Motion: Negative
Home is the first index pulse found in negative direction. Direction of motion is negative. If a
negative limit switch is activated before the index pulse, an error is generated.

[ i |

Index Pulse | |

Limit Switch

Direction of Motion: Positive

Home is the transition of the positive limit switch. Initial direction of motion is positive if the
positive limit switch is inactive.

| H
—

Positive Limit :,—
Switch

Direction of Motion: Negative

Home is the transition of negative limit switch. Initial direction of motion is negative if the
negative limit switch is inactive.

A |

B

Negative Limit
Switch
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Limit Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the positive limit switch transition. Initial
direction of motion is positive if the positive limit switch is inactive (shown here as low).

| —

@

®—

Positive Limit : :
Switch : I

Index Pulse |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the negative limit switch transition. Initial
direction of motion is negative if the negative limit switch is inactive (shown here as low).

— |

Negative Limit
Switch

Index Pulse |

Hardstop

Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard stop is
reached when the amplifier outputs the homing Current Limit continuously for the amount of
time specified in the Delay Time.

If a positive limit switch is activated before the hard stop, an error is generated.

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached when
the amplifier outputs the homing Current Limit continuously for the amount of time specified in
the Delay Time. If a negative limit switch is activated before the hard stop, an error is generated.
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Hardstop Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.

Hardstop Out to Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive hard stop. Initial direction of
motion is positive. The hard stop is reached when the amplifier outputs the homing Current Limit
continuously for the amount of time specified in the Delay Time. If a positive limit switch is
activated before the hard stop, an error is generated.

[ =
———

Index Pulse l

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative hard stop. Initial direction of
motion is negative. The hard stop is reached when the amplifier outputs the homing Current
Limit continuously for the amount of time specified in the Delay Time. If a negative limit switch
is activated before the hard stop, an error is generated.

= |

Index Pulse | |

Hardstop Out to Index Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.

Home Switch

Direction of Motion: Positive
Home is the home switch transition. Initial direction of motion is positive if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.
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Home Switch

Direction of Motion: Negative
Home is the home switch transition. Initial direction of motion is negative if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.

[ 1

Home Switch |

Home Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the home switch transition. Initial direction
of motion is positive if the home switch is inactive. If a limit switch is activated before the home
switch transition, an error is generated.

[

L1
 E—

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the home switch transition.
Initial direction of motion is negative if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[

L1
 E— |

Home Switch |

Index Pulse
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Home Switch In to Index

Direction of Motion: Positive

Home is the first index pulse to the positive side of the home switch transition. Initial direction
of motion is positive if the home switch is inactive. If a limit switch is activated before the home
switch transition, an error is generated.

[

=L 1]
 I—

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the negative side of the home switch transition. Initial direction
of motion is negative if the home switch is inactive. If a limit switch is activated before the home
switch transition, an error is generated.

[ 1= 1

Home Switch : |

Index Pulse

Lower Home

Direction of Motion: Positive

Home is the negative edge of a momentary home switch. Initial direction of motion is positive if
the home switch is inactive. Motion will reverse if a positive limit switch is activated before the
home switch; then, if a negative limit switch is activated before the home switch, an error is

generated.
[ CE'):/ =

Coon
Home Switch 1 /
Positive Limit 5
Switch / [
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Direction of Motion: Negative

Home is the negative edge of a momentary home switch. Initial direction of motion is negative.
If the initial motion leads away from the home switch, the axis reverses on encountering the
negative limit switch; then, if a positive limit switch is activated before the home switch, an error

is generated.
[ g %:/ f | ]
¢ o5

| @
Home Switch l_/ /_‘

Negative Limit '
Switch _| // //

Upper Home

Direction of Motion: Positive

Home is the positive edge of a momentary home switch. Initial direction of motion is positive. If
the initial motion leads away from the home switch, the axis reverses on encountering the
positive limit switch; then, if a negative limit switch is activated before the home switch, an error

is generated.
| 2l =
~® =

Eilorams

Home Switch ,_/ :
Positive Limit :
Switch // // l

Direction of Motion: Negative

Home is the positive edge of momentary home switch. Initial direction of motion is negative if
the home switch is inactive. If the initial motion leads away from the home switch, the axis
reverses on encountering the negative limit switch; then, if a positive limit switch is activated
before the home switch, an error is generated.
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S

Home Switch
Negative Limit '
Switch _| // //

Lower Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion
leads away from the home switch, the axis reverses on encountering the positive limit switch;
then, if a negative limit switch is activated before the home switch, an error is generated.

[ = al
e ™

@
Home Switch [_/ /_\

Positive Limit 5 / i
Switch : 7/
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is negative. If the initial motion leads away from the home
switch, the axis reverses on encountering the negative limit switch; then, if a negative limit
switch is activated before the home switch, an error is generated.
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@ |
5 B
Home Switch : : :
s i e
Negative Limit : :
Switch  — : )
R 7/

Index Pulse I

Lower Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the negative edge of a momentary home
switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion
leads away from the home switch, the axis reverses on encountering the positive limit switch;
then, if a negative limit switch is activated before the home switch, an error is generated.

[ gD#/ é ]

— A

Home Switch
Positive L.imit Ly
Switch ]
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative edge of a momentary home
switch. Initial direction of motion is negative. If the initial motion leads away from the home
switch, the axis reverses on encountering the negative limit switch; then, if a negative limit

switch is activated before the home switch, an error is generated.
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Home Switch : 5 / /L|
Negative Limit — '
Switch _| / /
!/
Index Pulse

Upper Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the positive edge of a momentary home
switch. Initial direction of motion is positive. If the initial motion leads away from the home
switch, the axis reverses on encountering the positive limit switch; then, if a negative limit switch
is activated before the home switch, an error is generated.

I/I/ !_|
7 L :

Home Switch 7 F
Positive L.imit / 5 |
Switch [/ '
Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the positive edge of a momentary home
switch. Initial direction of motion is negative if the home switch is inactive. If the initial position
is right of the home position, the axis reverses on encountering the home switch.
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Home Switch ’_/ /_‘

Negative Limit :
Switch ]

/[
7/

Index Pulse

Upper Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive edge of momentary home
switch. Initial direction of motion is positive. If initial motion leads away from the home switch,
the axis reverses on encountering the positive limit switch; then, if a negative limit switch is
activated before the home switch, an error is generated.

[ /’I/E ]

Home Switch # r

Positive L.imit e |
Switch ] [
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the positive edge of a momentary home
switch. Initial direction of motion is negative if the home switch is inactive. If initial motion leads
away from the home switch, the axis reverses on encountering the negative limit; then, if a
negative limit switch is activated before the home switch, an error is generated.
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Home Switch ﬂ / __|
Negative Limit : :
Switch —] / :
' ] [
Index Pulse | |
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APPENDIX C

ASCII COMMANDS/SERIAL CONTROL

Copley ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI,
PLC, PC, etc.) for setup and direct serial control of the amplifier. The control application
can issue amplifier commands from the set of ASCII format commands that make up
the Copley Controls ASCII Interface.

For more information, see the Copley ASCII Interface Programmer’s Guide.

CME ASCII Command Line Interface Tool

As described below, the CME ASCII Command Line Interface tool provides a simple way
to enter Copley ASCII commands.

Use the ASCII Command Line Interface to Enter Commands
1. From the Main screen, choose Tools>ASCII Command Line to open the tool.

€2 ASCIl Command Line = X
Command: |
Response: ‘
| < > |
Close

Enter an ASCII Command in the Command field.

3. Press the Enter key to send the command to the amplifier. Observe the Response field.
If a value is returned, it is preceded by the letter “v.” In the following example, the get
command was used to retrieve the amplifier RAM value of variable 0x32 (actual position).

€2 ASCIl Command Line — X

Command: |g r0x32|

Response: |v 93162
< >

Close

An error code would be preceded by the letter “e.”
TIP: To view an error definition, hold the mouse pointer over the error number.
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For more information, see the Copley ASCII Interface Programmer’s Guide and the
Copley Amplifier Parameter Dictionary.

Single-Axis Serial Connection
For RS-232 serial bus control of a single axis, set the CAN node address of that axis to
zero (0). Note that if the CAN node address is switched to zero after power-up, the
amplifier must be reset or power cycled to make the new address setting take effect.

Serial Coblev Amplifi
PC, PLC,or HMI | COM port . SER-CK "Serial Cable Kit' | opley Amphtier
9pin D-sub with ASCII
for ASCIl Control for \ =5 o
RS-232
ADDRESS MUST BE SET
TO ZERO BEFORE

POWER-UP OR RESET.

Multi-Drop Serial Connection
A serially connected amplifier can be used as a multi-drop gateway for access to other
amplifiers linked in a series of CAN bus connections. Set the CAN node address of the
serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in
the chain a unique CAN node address value between 1 and 127. For more information
on CAN node address assignment, see Network Configuration. Use 120 Ohms
termination on the first and last amplifier.

TERMINATION MUST BE 120 Ohm
USED ON FIRST AND LAST Terminator
NODE

Serial : < o
PC, PLC, or HMI . SER-CK "Serial Cable Kit" Copley Amplifier CAN

’ ! COM port 9pin D-sub . . @ CAN Port
for ASCII Control for RS-232 with ASCII RS-232 ADDR -

CAN Network Cable UTP CAT.5E Gigabit Ethernet

CAN CAN Port CAN CAN Port CAN CAN Port
ADDR ADDR ADDR
1 T

ADDRESSES MUST BE 120 Ohm
SET BEFORE POWER-UP Terminator
OR RESET.
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APPENDIX D

CoPLEY USB 1O RJ11

Recommended Device

Copley Controls recommends using Copley SER-USB-RJ11.

Factory Settings

The factory settings for this device works well. To confirm that drivers are installed, and default
settings are correct, use Windows Device Manager.

1 Open the Device Manager dialog from the Windows Control Panel and expand the Ports

(COM &LPT) node:
i} Audio inputs and outputs

@ Batteries
% Biometric devices
9 Bluetooth
@ Cameras
3 Computer
= Disk drives
B Display adapters
i Firmware
@ Human Interface Devices
*= IDE ATA/ATAPI controllers
= Keyboards
@ Mice and other pointing devices
[ Monitors
¥ Network adapters
v @ Ports (COM & LPT)
ﬁ Intel(R) Active Management Technology - SOL (COM3)
E Prolific USB-to-Serial Comm Port (COM4)
™ Print queues
D Processors
B9 Security devices
!* Software components
B Software devices
iy Sound, video and game controllers
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2 Select the COM port that is used by the USB to Serial Adapter.

are installed and the device is working properly.
Prolific USB-to-Serial Comm Port (COM4) Properties X

General Port Settings Driver Details Events Power Management

Prolific USB-to-Serial Comm Port (COM4)

S 2
Device type: Ports (COM & LPT)
Manufacturer: Prolific
Location: Port_#0002.Hub_#0001

Device status

rl'his device is working propery.

caro

Confirm the drivers

3 Select the Port Settings tab, then click the Advanced button. Do not change the Baud
rate or any port settings. This will be done by CME through Windows.
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Prolific USB-to-Serial Comm Port (COM4) Properties X

General Port Settings Driver Details Events Power Management

Bits per second: 9600 Y I

Data bits: |8 |
Parity: |None ~|

Stop bits: |1 |
Flow control: [None ~|

Advanced... | Restore Defaults |

Advanced Settings for COM4

¥ Use FIFO buffers (requires 16550 compatible UART)

i

K
Select lower settings to correct connection problems.
Cancel
Select higher settings for faster performance.
Defaults
Receive Buffer: Low (1) J High (14)  (14)
1 . ' '

Transmit Buffer: Low (1) J High (16)  (16)

COM Port Number: |COM4 v I

USB Selective Suspend Idle Timer (secs): I 10
[~ Disable DTR/RTS INIT signal (Ex: disable Serial Mouse/Modem detection)

[~ Change DTR/RTS INIT Level Shift (from TTL=HIGH/RS232=LOW to TTL=LOW/RS232=HIGH)
[~ Disable Device USB Serial Number in Windows Registry (uncheck to Enable)

Driver Buffer Size: | 4096 (0 to 4096 bytes)
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APPENDIX E

Faults, Warnings & Status

Bit Event Name Description Fault Corrective actions
Output to motor or heck cabl q for sh
i Check cable and motor or regen for short
0 Fault Short Circuit regen measureq I g
greater than twice output to ground or output to output.
peak
. Amp over temp Increase air flow, add heatsink kit, or reduce
1 Fault Drive over temp - .
drive protection. duty cycle.
DC bus above drive | Check DC bus for pump up when stopping,
2 Fault Over voltage rating. Output add capacitance, or reduce deceleration
shutdOWn rate
Check DC bus for drooping or collapsing,
DC bus below .
3 Fault Under voltage - improve power source, or reduce
minimum i
acceleration.
Motor temp Motor temperature | check motor temperature confirm sensor
4 Fault sensor sensor open or L
closed circuit.
Probl th Check Encoder Status for more details,
5 Fault Feedback error roblem with check voltage levels, Confirm Encoder power
feedback circuits
regulated.
Problem with Check Halls states vs Encoder count. Test
6 Fault Phasing error commutation or encoder for no drift. Do not hot swap. Check
phasing manual phasing.
Current folds back Reduce duty cycle, remove friction, Check
7 Warning Current limited to protect the drive | motor Arms vs drive Ic Apk ratings. (1Arms =
or motor 1.414Apk).
. Momentary voltage limit is okay however, if
. I PWM output hits Y . .g . y‘ .
8 Warning Voltage limited output speed is limited and waning is
95% duty cycle .
constant then increase dc bus or slow down.
Positive limit switch | If hold position at limit is selected, then
9 Fault Pos limit switch is active move motor will servo in position otherwise no
aborts current in direction of limit
Negative limit If hold position at limit is selected, then
10 Fault Neg limit switch switch is active motor will servo in position otherwise no
move aborts current in direction of limit
Check IN1 for correct levels. Typically, IN1
HW Enable input (SW input 0) is active low enable and
11 Status . . Hardware Enable put ( . put 0) .
inactive stop settings are configured for controlled
stop.
SW Enable Check that master can move drive to op-
12 Status ) . Software Enable state. If Copley mode is "Disabled" change to
inactive
another mode.
Normal event when hardware disabled or
. ) Trajectory aborted master commands. Trajectory will abort
13 Warnin Stoppin .
g Pping attempting to stop when fault occurs so check faults for root
cause.
223 Curtiss-Wright | Rev 02 | PN16-01197 | 04/2019




CME User Guide

Brake FET is turned

14 Status Brake activated on Check that brake is holding
Drive PWM output
15 Fault PWM disabled H-bridge stage is Check for HW and SW enable or no faults
OFF
Soft limits apply after homing. Move will
. Positive Software stop using soft limit deceleration rate and
16 Status Pos soft limit . - -
limit hold on soft limit. Check soft limit
deceleration rate.
Soft limits apply after homing. Move will
- Negative Software stop using soft limit deceleration rate and
17 Status Neg soft limit limit hold on soft limit. Check soft limit
deceleration rate.
Following error limit Some limit is preventing move. Check
18 Fault Tracking error mechanical system and current limits.

exceeded

Reduce duty cycle.

19 Warning

Tracking warning

Following error
above warning limit

Danger of following error. Some limit is
affecting move. Check mechanical system
and current limits. Reduce duty cycle.

Drive is presently

20 Status Resetting ) Wait for reset to complete
being reset
If wrap is set to some value count will start
. at 0 again at that value. Otherwise, if wrap is
i Position has I, .
21 Status Position wrap wraoped not set, the Position variable wraps at full
PP scale range. This type of counting is called
position wrapping or modulo count.
. . .| Rest or power cycle the drive. Make sure
22 Fault Drive Fault Power-up diagnostic P . ¥ .
power cabling and grounding is correct.
. e elocity limited to Increase the velocity limit to 10% greater
23 Warning Velocity limit v ty fimi ¢ v Ity fimi °8

configured value

than rated or required speed.

24 Warning

Acceleration limit

Acceleration limits
command

Velocity mode only. If command exceeds
limit the summing junction will only get
limit.

25 Warning

Tracking
Window.

Following error is in
tracking window

If Position Loop Error is outside of Position
Tracking Error Limit, then position is not
tracking, or move has not settled.

Home switch

Home switch input

An input configured as home switch will

26 Status . . capture position when activated. Normally
active active .
for purposes of homing.
Set if the trajectory generator is running a
. Moving or not profile, or the Position Tracking Error Limit is
27 Status In motion . . .
settled outside the tracking window. Clear when
settled into position.
. . . . Set if the absolute velocity error exceeds the
28 Status Velocity window | Velocity not tracking i

velocity window value.

29 Warning

Phase not
initialized

Algorithmic (No
Halls) commutation
run after enable

After enable algorithmic phasing will wiggle
the motor to find phase. Confirm phase
initialized and good before commanding
move.
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Master (CANopen or ECAT) not connected or
not sending message in time configured by
Master command master. Turn off guard time if CANopen
signal not present. master not connected. If PWM command
source check for command or allow 100%
command.

30 Fault Command Input

31 Fault Not defined.
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